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Chapter 1
Introducing FileMaker Pro 

FileMaker® Pro is the leading workgroup database software for quickly 
creating and sharing solutions adapted to your business needs. Powerful 
features, broad platform support, and an easy-to-use interface make 
FileMaker Pro indispensable for anyone who needs to track and manage 
people, projects, and information. 

About this guide
This User’s Guide contains an introduction to FileMaker Pro features and 
provides step-by-step instructions on the most common FileMaker Pro tasks. 
You may need to refer to FileMaker Pro Help for detailed information on more 
advanced product features.

To send your feedback on this guide, see  
www.filemaker.com/company/documentation_feedback.html.

Using FileMaker Pro documentation
The FileMaker Pro documentation provides a learning path to productivity, 
installation instructions, online Help, and more. 

The following manuals are included:

1 FileMaker Pro User’s Guide (this manual): contains key concepts and 
basic procedures

1 Installation and New Features Guide for FileMaker Pro and 
FileMaker Pro Advanced: contains installation instructions and a list of the 
new features in the current version

1 FileMaker Pro Tutorial: contains step-by-step lessons that teach you how 
to create and use FileMaker Pro databases

1 FileMaker Instant Web Publishing Guide: describes how to make 
FileMaker Pro databases accessible to web browser users over an intranet 
or the internet
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1 FileMaker ODBC and JDBC Guide: describes how to share FileMaker 
data with other applications using ODBC and JDBC

Where to find PDF documentation
To access PDFs of FileMaker documentation:

1 in FileMaker Pro, choose Help menu > Product Documentation

1 click the Learn More button in the FileMaker Quick Start Screen 

1 see www.filemaker.com/documentation for additional documentation

Most PDF manuals are located in the folder where you installed 
FileMaker Pro. If you installed FileMaker Pro in the default folder location, the 
PDF manuals are located here:

1 Windows: C:\Program Files\FileMaker\FileMaker Pro\English 
Extras\Electronic Documentation

1 Mac OS: Macintosh HD/Applications/FileMaker Pro/English Extras/
Electronic Documentation

To view the PDF files, you need a PDF reader. In Mac OS X, you can use either 
the built-in Preview application or Adobe® Reader®. Windows users need 
Adobe Reader. If you do not have Adobe Reader, you can download it from the 
Adobe website at www.adobe.com.

All of the PDF files use the tagged Portable Document format (PDF). Tagged 
PDF files work with assistive technology such as the screen readers JAWS and 
Window-Eyes for Windows. For more information about tagged PDF files, see 
the Adobe website at www.adobe.com. 

Online Help 
FileMaker Pro Help provides comprehensive step-by-step instructions on 
FileMaker Pro features. You can open Help from the Help menu in 
FileMaker Pro. 

There are three ways to access Help:

1 Browse the Help table of contents to locate topics by subject.
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1 Search for particular topics by entering keywords.

1 Get information about the currently displayed dialog box by pressing F1 
(Windows) or 2-? (Mac OS).

Templates, examples, and more information 
FileMaker Pro includes database template files (Starter Solutions) that you can 
use to quickly get started. Starter Solutions take advantage of the best new 
FileMaker Pro features, to help you create the most effective database solution 
for your needs. When you start creating databases, check the list of templates 
to see if one is available that suits your needs.

The English Extras folder contains references and examples to help you with 
specific features such as XML support. 

You can find more information, tips, and database ideas on the FileMaker 
website at www.filemaker.com.
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Suggested reading
Here are some suggestions for using the documentation to help you learn how 
to do specific tasks in FileMaker Pro.

Note  If your database was developed using FileMaker Pro Advanced, you may 
see customized menus or tooltips for layout objects. For an overview of these 
features, see Help.

Type of user Suggested reading 

Data entry person Chapter 2, “Using databases,” in this guide

Small business owner or 
educator who creates a 
basic database to start, then 
improves it over time

Chapter 3, “Creating databases,” in this guide. As features are 
added to the database, refer to Help 

Database administrator 1 All chapters in this guide

1 Help, for information on advanced topics

1 FileMaker Instant Web Publishing Guide

1 FileMaker ODBC and JDBC Guide

New FileMaker Pro user 1 Installation and New Features Guide for FileMaker Pro 
and FileMaker Pro Advanced

1 FileMaker Pro Tutorial

1 All chapters in this guide

User upgrading from a 
previous version

1 Installation and New Features Guide for FileMaker Pro 
and FileMaker Pro Advanced

1 Chapter 7, “Converting databases from FileMaker Pro 6 
and earlier,” in this guide



FileMaker Pro overview  |  13

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 13  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
FileMaker Pro overview
Here is an overview of the capabilities of FileMaker Pro. 

Creating simple or complex databases
With FileMaker Pro you can create simple databases consisting of just one 
database table, such as an address list, or you can create a complex database 
with relationships and multiple database tables. For example, you can create a 
complex database that relates two tables based on a single common value, such 
as a serial number or an ID number.

 

You can organize your databases as a single table in a single file, as multiple 
tables in a single file, or as multiple tables in multiple files.

FileMaker Pro provides database templates (Starter Solutions) designed for 
business, education, and personal purposes. The templates can be quickly 
customized to suit your needs.

For more information about creating databases, see chapter 3, “Creating 
databases.”

An address list database 
consisting of one table

A database consisting of multiple tables, 
with a portal to display records from a 
related table
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Using layouts to display, enter, and print data
FileMaker Pro layouts determine how information is organized for viewing, 
printing, reporting, finding, and entering data. Layouts do not store your data—
they just display it.

Database files can have many different layouts, which display data in a variety 
of ways. Within one database file, you can design separate layouts for entering 
data, reporting summaries, printing mailing labels, publishing a database on 
the web, and so on. You can change a layout’s design without affecting the data 
or other layouts in the file. When you change the data in a field, the changes are 
reflected in the same field on all the layouts in the database.

In a layout, you choose, arrange, and modify fields and field labels, create 
reports, add buttons to initiate scripts, add graphics and text, and specify 
printing options. 

Not all information needs to be stored in your FileMaker Pro database. For 
example, you can add a web viewer to display a web page on a layout. There 
are some restrictions for displaying web content in FileMaker Pro. 

There are six types of layouts and one view that you can create with the New 
Layout/Report assistant. Use these different layout types for various purposes, 
like displaying a data entry screen or printing a totaled sales report or 
formatting data as mailing labels. You can customize each layout further by 
using the design tools that are available in Layout mode.
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For more information about creating layouts, see “Creating layouts and 
reports” on page 98.

Finding, sorting, and replacing data
Features for finding, sorting, and replacing data allow you to manipulate your 
data in many ways.

You can find records that meet criteria you specify, such as records entered on 
a certain date or addresses in a particular city. You can open another window 
in order to perform different searches on the same data.

You can rearrange records in order to view or print them in a different 
sequence. You can sort fields alphabetically, numerically, by date, or by a 
custom sort order.

Steve Williams
789 Ninth Avenue
New York, NY 10001

The same data can be arranged differently with multiple layouts

Juanita Alvarez 555-1234
Michelle Cannon 555-1234
Andre Common 555-1234
Marie Durand 555-1234
Jean Durand 555-1234
William Johnson 555-1234
John Lee 555-1234
Patrick Murphy 555-1234
Le Nguyen 555-1234
Kentaro Ogawa 555-1234
Mary Smith 555-1234
John Smith 555-1234
Sophie Tang 555-1234
Steve Williams 555-1234
Betty Wilson 555-1234

Phone List

Dear Sophie,

Thank you for reserving a cruise with us. 
We value your business and appreciate the 
opportunity to serve you.

If you have any questions about your 
reservations, please call us—we want you 
to be satisfied with your cruise.

Sincerely,
John Lee
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You can search for and replace data across multiple fields, similar to the way 
you find and replace data in word processing applications.

For more information about finding, sorting, and replacing data, see “Finding 
records” on page 40, “Sorting records” on page 58, and “Finding and replacing 
data” on page 56.

Protecting databases with accounts and privilege sets
You can restrict what users see and do in a database file by defining accounts 
and privilege sets. Accounts authenticate users who are attempting to open a 
protected file. Each account specifies an account name and (usually) a 
password. Any user that cannot specify valid account information won’t be 
able to open a protected file. A privilege set specifies a level of access to a 
database file. Each account is assigned a privilege set, which determines the 
level of access when someone opens a file using that account.

Extended privileges determine the data sharing options that are permitted by a 
privilege set, such as whether a privilege set permits users to open a shared file 
or view a database in a web browser.

For more information about accounts and privilege sets, see chapter 6, 
“Protecting databases with accounts and privilege sets.”
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Creating scripts to automate tasks
Scripts can do simple tasks like setting print orientation or complex tasks like 
preparing a customized mailing to clients.

For example, you could define a script that creates a thank you letter to clients 
in your database who have made a purchase in the last week. The script 
composes a letter customized to each client. The script then switches to 
Preview mode and pauses so that you can see what the letter looks like before 
it prints. The whole task is started by clicking a button on a layout.

You use the Manage Scripts (formerly ScriptMaker) feature in FileMaker Pro 
to build scripts by selecting from a list of FileMaker Pro script steps, specifying 
options, and arranging the steps in the correct order to perform the task. 
FileMaker Pro makes it easy to manage and maintain scripts, even for complex 
databases. You can simultaneously view, edit, and manage scripts from 
different databases. For more information about scripts, see “Automating tasks 
with scripts” on page 68.

Sharing and exchanging data
A benefit of storing data in FileMaker Pro is sharing your data with others. You 
can share your data with other FileMaker Pro users on a network, use the web 
publishing capabilities to share data over the web, or import or export data 
from another file. In addition, you can use ODBC (Open Database 
Connectivity) and JDBC (Java Database Connectivity) to share FileMaker Pro 
files with ODBC- and JDBC-compliant applications, or you can access data 
from external data sources. 

If your computer is connected to a network, you and other Windows and 
Mac OS FileMaker Pro users can use the same FileMaker Pro database file 
simultaneously. FileMaker Pro Network Sharing supports the sharing of files 
with up to nine concurrent users. 

Note  If you need to share files with more than nine concurrent users on a network, 
FileMaker recommends the use of FileMaker Server.

You can quickly and easily publish FileMaker Pro layouts as web pages, which 
allows anyone with a web browser on your intranet (or the internet) to access 
your FileMaker Pro databases.
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With FileMaker Pro accounts and privilege sets, you can make your web 
databases secure. 

For more information about sharing and exchanging data, see chapter 5, 
“Sharing and exchanging data.”

Saving and sending data in other formats
FileMaker Pro lets you save data in different file formats, such as Microsoft 
Excel worksheets and Adobe PDF files, so you can give the files to users who 
do not have FileMaker Pro. You can automatically email the files after saving 
them. For more information, see “Saving and sending data in other formats” on 
page 163.
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Chapter 2
Using databases

This chapter explains the basics of how to:

1 open, close, and save files

1 create records in a database

1 add and edit data in fields

1 find records using different criteria

1 omit records from the found set

1 find and replace data

1 sort data

1 print data, scripts, table and field information, and the relationships graph

1 use scripts

Note  See Help for detailed, comprehensive information and step-by-step 
procedures about using FileMaker Pro.

About database fields and records
A database is a collection of information, or data, that you can organize, 
update, sort, search through, and print as needed. Unlike an electronic 
spreadsheet, which is used to tabulate and calculate data stored in the cells of 
a rectangular table, a database is a collection of knowledge tied together by a 
schema that describes the organization of database tables, their fields, and the 
relationships between the fields and tables.



20  |  Using databases

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 20  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
Certain tasks are better suited to each of these important business productivity 
tools. Spreadsheets are best used for tasks such as maintaining a business 
ledger, where data needs to be recorded and calculated, but not presented or 
analyzed in multiple formats. Databases are best for tasks such as inventory 
control, where you need to track consumption and losses and generate reports 
on inventory status over time. An inventory database can sort and report on 
inventory information in many ways, allowing you to analyze data by item 
type, by sales figures, by monthly consumption, and so on.

Your own address book or filing cabinet is an example of a simple database. 
With the address book and filing cabinet, you store similar pieces of information 
organized for easy retrieval. With a filing cabinet, you must choose a way to sort 
your data, for example, alphabetically by last name or by region. By storing 
contacts and addresses in FileMaker Pro, you can organize your information in 
many ways. You can sort your information by country, city, last name, or even 
sort by all three of these fields.

B C

Michelle Cannon
123 4th St. SW
Edmonton
(717) 555-0011

CAN N4V 1LN

Records

Fields

Your address book is like a database
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An invoicing system is an example of a more complex database, with multiple 
related tables, multiple layouts, and calculated fields.

You can also view a subset of your data, for example, only invoices for a 
particular month. A database doesn’t just hold information—you use a 
database to organize and analyze information so that you understand its 
significance.

Fields are the basis of a database table. Fields are used to store, calculate, and 
display the data you enter into a record. Each piece of information in a 
record—like name, ID number, and telephone number—is stored in a field.

A database table contains one or more records. Each record contains fields that 
hold similar information about one subject or activity. For example, the fields 
on a record in the Clients table contain address information for one client.

A database can consist of one file with one table, which might hold the names, 
addresses, and telephone and fax numbers of all your clients. 

A database can also consist of several files, each of which can contain one or 
more tables that, together, contain all the information about related topics 
(sometimes called a database system). Using the relational capabilities of 
FileMaker Pro, you can join information between files and tables to create a 
relational database. 
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For example, one table can show you which clients bought a particular item 
and a related table can show how much they paid.

To enter data in a database table, you make a new record and enter values into 
the fields that belong to that record. Values can be typed into a field, imported 
from another application, or entered in a number of other ways.

FileMaker Pro also allows you to access and view data that is stored in non-
FileMaker Pro files. For example, if you have access to data stored in a SQL 
database, you can display information from the external database and work 
with that data in your FileMaker Pro file.

Opening files
To open a file if FileMaker Pro isn’t running
Choose one of the following methods:

1 Double-click the FileMaker Pro file. 

1 Drag the file onto the FileMaker Pro application icon.

Invoices table

002Client ID

Andre CommonClient Name

818-555-1234Phone

Prod
ID Product
ET3

Price
Travel bag $29

ET4 Travel book $32

12345Invoice ID

ET3Prod ID

Travel bagProduct

$29.00Price

002Client ID

Andre CommonName

818-555-1234Phone

Products tableClients table

34Stock
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1 Double-click the FileMaker Pro application icon. 

1 If you see the FileMaker Quick Start Screen, click Open File on the left 
(if it is not already selected), select Recent Files, Favorite Files (local), 
Favorite Files (remote), or click Browse Files to locate and select the file 
you want to open, then click Open.

1 If you see the Open New or Existing dialog box, locate and select the 
file you want to open, then click Open.

To open a file if FileMaker Pro is already running
1. Choose File menu > Open.

1 If you see the FileMaker Quick Start Screen, click Open File on the left 
(if it is not already selected), select Recent Files, Favorite Files (local), or 
click Browse Files to locate and select the file you want to open, then 
click Open.

1 If you see the Open File dialog box, locate and select the file you want 
to open, then click Open.

2. If you’re asked for an account name and password, type them in the 
Password dialog box, then click OK.

To open a file that is being shared over a network
1. Choose File menu > Open Remote.

2. In the Open Remote File dialog box, select View for a list of hosts.

3. To see the available files from a host, select the host. In the Available Files 
list, select the file you want to open.

Or, for Address, type the network path (for example,  
fmnet:/hostIPaddress/fileName).

Choose To display

Favorite Hosts Hosts you previously added as favorites

Local Hosts FileMaker Pro hosts on your TCP/IP subnet

Hosts Listed by LDAP FileMaker Pro hosts available through the specified LDAP server
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4. Click Open.

Depending on how FileMaker Network Sharing is configured on the host, 
you might be required to enter an account name, password, and domain 
name (Windows only).

Keep these points in mind:

1 If you have Show recently opened files selected in the General preferences, 
files you have recently accessed appear in the File menu’s Open Recent list 
and in the Recent Files list in the FileMaker Quick Start Screen. See Help 
for information about adding local or remote files to the Favorite Files (local) 
or Favorite Files (remote) list in the FileMaker Quick Start Screen.

1 To open and share a file, see “Enabling file sharing and hosting files” on 
page 157.

1 You can open FileMaker Pro files created in Windows on a computer 
running the Mac OS, and vice versa. If you intend to move files across 
platforms, it’s best to include the .fp7 extension in the filename. If you add 
or remove filename extensions, you must redefine the FileMaker data 
sources for related files and for files with external scripts.

1 You can set a default account name and password for a file in the Open/
Close tab of the File Options dialog box. When you do so, users 
automatically log in using a specific account and password (if specified) 
when they open a database. For more information, see Help.
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Opening multiple windows per file
You can open more than one window per file. This allows you to view the same 
layout in separate windows, or simultaneously view different layouts in the 
same file. You can perform find or sort operations independently in the 
different windows.

To open an additional window, choose Window menu > New Window. Another 
window appears. Initially, the window displays the same layout, sort order, and 
found set as the previously active window.

To view a different layout in the new window, choose a layout from the Layout 
pop-up menu in the layout bar, or choose View menu > Go to Layout. For 
information on finding records, see “Finding records” on page 40. For 
information on sorting records, see “Sorting records” on page 58. For more 
information about opening multiple windows, see Help.

The original 
database window, 
in which you can 
search the records

A second window, 
in which you can 
perform a different 
search on the 
same found set
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Closing windows and files
You can close FileMaker Pro windows and files as you would in most 
Windows and Mac OS applications. 

To close a window, do one of the following:

1 Windows: Double-click the document icon in the upper left corner of the 
document window.

1 Windows: Click the close box in the upper right corner of the document 
window.

1 Mac OS: Click the red close button in the upper left corner of the document 
window.

1 Choose File menu > Close.

To close a file, use the procedures above to close all the open windows for a file.

Note  Even if you close a file, it may remain open as a hidden file if the window of 
any other file is displaying data from that file. (For example, another window may 
be displaying related data from the file you attempted to close.) FileMaker Pro will 
close the file when you close all the dependent windows. 

Saving files 
By default, FileMaker Pro automatically saves changes to your data as you 
work, so there is no Save command. If you want more control over when record 
data is saved, you can clear the Save record changes automatically option 
individually for each layout. For more information, see FileMaker Pro Help.

You can save a copy of your file as a backup or save a clone of your file with 
no data. To save a copy of your file in a non-FileMaker format, see “Saving and 
sending data in other formats” on page 163.

Some minor changes to files are not always saved with the file. For details, see 
the next section, “When FileMaker Pro saves a file.”

Important  Always save a copy of a file before you make extensive changes. You 
can’t restore data after you delete a field from the Manage Database dialog box or 
remove records using the Delete Record or Delete All commands.
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To save a copy of your file:

1. Make the file you want to save the active file, and choose File menu > Save 
a Copy As.

2. Navigate to where you want to save the copy on your hard disk.

3. For File name (Windows) or Save As (Mac OS), type a filename.

4. For Save as type, choose FileMaker Files (Windows only).

5. For Save a (Windows) or Type (Mac OS), choose one of the following 
options:

6. Click Save.

When FileMaker Pro saves a file
FileMaker Pro saves a file whenever you perform an action such as modifying 
data. The following actions do not cause the file to be saved:

1 Displaying a different record or layout (unless that record or layout has 
been modified)

1 Sorting records or modifying a sort order

1 Performing find operations such as Find, Show All Records, Omit Record, 
or modifying a find request

1 Changing the position and size of windows or hiding/showing the status 
toolbar

Choose To

Copy of current file Duplicate the entire file, including the tables, field definitions, 
layouts, scripts, page setup options, and data. Duplicating a file is 
useful before you make extensive changes to the file. 

Compacted copy 
(smaller)

Compact the entire file into less disk space by reclaiming unused 
space in the file. Saving a compacted copy is useful if you edit many 
records frequently.

Clone (no records) Save a file’s tables, field definitions, layouts, scripts, and page setup 
options, without the data. Make a clone when you want a template 
of the file schemas. 
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1 Changing layout object default settings

1 Changing ruler display settings

If you perform any of the above actions without also performing an action that 
does cause a save (such as modifying data), the change won’t be saved when 
you close the file. FileMaker Pro considers the above actions to be minor 
changes, and they are not saved with the file unless the file is also modified in 
a more significant way.

For example, if you open a file, perform a find, then close the file, FileMaker 
Pro does not save the found set with the file. However, if you open a file, add a 
new record, perform a find, then close the file, FileMaker Pro will save the 
found set as well as the new record with the file.

For more information about saving files, see Help.

About modes
You work with data in FileMaker Pro in Browse, Find, Layout, or Preview 
mode. You can choose a mode from the View menu or from the mode pop-up 
menu at the bottom of the document window. 

Use this mode To

Browse mode Work with the data in a file. You can add, view, change, sort, omit 
(hide), and delete records. Browse mode is where you’ll do most of 
your work, such as data entry. 

Find mode Search for particular records that match a set of criteria. You can then 
work with this subset of your records, called the found set. After you 
find a group of records, FileMaker Pro returns to Browse mode so you 
can begin working with them. 

Mode pop-up menu
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Using the status toolbar
The status toolbar provides quick access to many FileMaker Pro menu 
commands. In all modes, it includes navigation tools, customizable buttons, 
and a layout bar for working with layouts. In Layout mode, it includes layout 
tools. Move the pointer over a button to see its description. You can also switch 
modes by clicking buttons in the status toolbar. The buttons in the status toolbar 
vary depending on which mode you’re in. 

For more information, see Help.

Viewing records 
FileMaker Pro provides three views of each layout: form, list, and table. When 
you change views, you temporarily change the way records display or print.

Layout mode Determine how information is presented on your screen or in printed 
reports, labels, and forms. Design layouts for specific tasks, like data 
entry or printing invoices or envelopes. Select and arrange fields and 
other objects to modify an existing layout or create new layouts.

Preview mode See how data in forms or reports will look before you print. Preview 
mode is especially useful for viewing layouts with multiple columns 
(like mailing labels) and reports with summaries.

To view records Do this in Browse mode or Find mode

Individually Choose View menu > View as Form, or click Form View in 
the layout bar.

In a list Choose View menu > View as List, or click List View in the 
layout bar.

In a spreadsheet-like table Choose View menu > View as Table, or click Table View 
in the layout bar.

Use this mode To

Status 
toolbar Layout bar

Formatting bar
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The following illustration shows the same layout in three views. 

Form View

One record

List View

Table View

One recordField labels

One record
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Viewing records in table format
While viewing records in table format, you can make one or more of the 
following changes to columns and records:  

To Do this

Reorder columns Click a column heading and drag it to a new location. 

Resize a column Move the pointer to the edge of the column heading. When the pointer 
changes to a double arrow ( ), drag it to the desired size.

Set a precise 
column width

Select one or more columns, then right-click (Windows) or Control-
click (Mac OS). Choose Set Column Width from the shortcut menu. In 
the dialog box, type a width, choose units from the list, then click OK.

Sort records 1 Click a column heading.

1 Select one or more columns, right-click (Windows) or Control-click 
(Mac OS), then choose a sort order from the shortcut menu. If you 
select multiple columns, the order of the columns (left to right) 
determines the sort order. 

Note   You must have Sort data when selecting column selected in the 
Table View Properties dialog box. (In Layout mode, select this option by 
right-clicking (Windows) or Control-clicking (Mac OS), then choosing 
Layout Setup from the shortcut menu. In the Layout Setup dialog box, click 
the Views tab, then click Properties.)

Display more 
fields or hide 
fields

Click Modify in the layout bar.
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Selecting the active record
In Browse mode, a table has one active (selected) record at a time for each 
window. For more information about working with multiple windows, see 
“Opening multiple windows per file” on page 25. 

In this view The active record is

Form View The record that you’re displaying. 

List View or 
Table View

The record that’s marked with a solid bar along the left side. To 
work with another record, click in the record to make it active. 

Column headings. Each column displays one field 
from the current layout. If you’ve added a tab control, 
fields from all panels are displayed.
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To select a related record in a portal, select the portal row (click inside the row 
but outside any fields in the row).

For information about related records and portals, see chapter 4, “Working 
with related tables and files.”

Current record 
in List View

Click inside the portal row to select 
a related record

Portal
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Moving through records
To move from one record to another, use the book in the status toolbar. 

You can also use a mouse scroll wheel to move through records. For more 
information about viewing records, see Help.

To move Do this

To the next record in the 
current table 

Click the right page of the book or choose Records menu > 
Go to Record > Next.

To the previous record in 
the current table 

Click the left page of the book or choose Records menu > 
Go to Record > Previous.

Quickly to a specific 
record

1 Click the current record number, type the record number 
you want, then press Enter (Windows) or Return (Mac 
OS).

1 Press Esc, type the record number, then press Enter or 
Return.

1 Choose Records menu > Go to Record > Go To..., then type 
the number of the record.

Quickly through records Drag the slider right or left to move forward or backward.

Through records in List 
View or Table View

Use the scroll bar on the right side of the window.

To a record with a unique 
value that you know

See “Finding records” on page 40.

Slider

Current record 
number 

Number of records 
in the tableBook 
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Adding and duplicating records
When you add or duplicate records, FileMaker Pro stores new records at the 
end of the current table. In Browse mode, you see the new record after the 
current record, or after the last record in the found set (the set of records made 
active by a find request).

1 If records are sorted, the new record appears in the correct position in the 
sort order when you commit the record.

1 If records are unsorted, the new record appears after the last record in the 
found set. For more information, see “Sorting records” on page 58.

Note  If a file is locked or write-protected, or if you don’t have access privileges to 
create records, FileMaker Pro will not add or duplicate records.

If the field is defined to automatically enter field values, you see those values 
entered in the new record. See “Defining automatic data entry” on page 92.

To enter or change values in the new record, see “Entering and changing data 
in fields” on page 38.

To Do this in Browse mode

Add a new blank record In Browse mode, click New Record in the status toolbar. You 
see a blank record with one field selected. 

Quickly add a record with 
the same or similar data as 
an existing record

Select the record to duplicate. Then, choose Records menu > 
Duplicate Record. (See “Selecting the active record” on 
page 32.) 

Add or duplicate related 
records

See the next section.
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Adding and duplicating related records
If you’re working with records in related tables, you can add records to a 
related table when you enter data in a record in the current table. 

Note  You can only add related records from the current table if the relationship is 
defined to allow the creation of related records. If a related table is in a write-
protected file, or if you don’t have access privileges to create records, FileMaker 
Pro will not add or duplicate records. For more information, see “Creating 
relationships” on page 145.  

For more information about adding and duplicating records, see Help.

To Do this in Browse mode

Create a record in the 
current table

Click New Record in the status toolbar.

Add a record to a related 
table

1 If the related field is in a portal, type data into the field in the 
last (empty) row of the portal, then press Enter. 

1 If the related field isn’t in a portal, type data into the field, 
then press Enter.

Duplicate a record that is 
displaying related data

Be sure no records in a portal are selected, then choose 
Records menu > Duplicate Record.

Duplicate a related record 
in a portal

Select the record in the portal, then choose Records menu > 
Duplicate Record.

Portal with related 
records from Line 

Items table

Type in the last row of the portal to add a 
related record to the Line Items table



Deleting records  |  37

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 37  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
Deleting records
When you delete a record, you permanently discard the data in all the fields in 
that record. 

Important  You can’t retrieve deleted data, and you can’t undo the action of 
deleting records. Before you delete records, consider making a backup copy of 
your file.

If you’re working in a relational database and the option to delete related 
records is selected in the Edit Relationship dialog box, FileMaker Pro deletes 
related records when you delete a record. 

To delete Do this in Browse mode

One record Select the record to delete. In the status toolbar, click Delete Record, 
then click Delete.

A related record Select a portal row in the current table by clicking inside the row but 
outside any fields in the row. In the status toolbar, click 
Delete Record, then click Delete.

Note   To delete related records, Allow deletion of portal records must 
be selected in the Portal Setup dialog box.

A group of records Make sure the found set contains only the records you want to 
delete. (See “Finding records” on page 40.) Choose Records menu > 
Delete Found Records, then click Delete.

All records in a 
database

Click Show All in the status toolbar, or choose Records menu > Show 
All Records. Then choose Records menu > Delete All Records.



38  |  Using databases

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 38  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
Entering data
Note  If a file is locked or write-protected, or if you don’t have privileges to edit 
certain records or fields, you may not be able to modify data. 

Selecting a field

Entering and changing data in fields
You can enter or import data up to the character limit for the field type. You can 
view and print only the data that fits within the field boundaries.

Note  For information about how FileMaker Pro uses system formats to display 
and sort dates, times, and numbers, see Help.

To Do this in Browse or Find mode

Select a field Click in the field.

Select the contents of a field Select the field, then choose Edit menu > Select All.

Move to the next field in 
the tab order

Press Tab.

Note   To set the Return or Enter key(s) to move to the next field, 
in Layout mode, select the fields, then choose Format menu > 
Field/Control > Behavior.
Buttons and tab controls can be included in the tab order. 
Fields on tab panels that are not in front are skipped.

Move to the previous field 
in the tab order

Press Shift-Tab (or Shift-Return or Shift-Enter, if enabled).

Move to items in a value list Press the arrow keys.

To Click in the field in Browse mode, then

Enter data in a text field Type the text (up to 1 billion characters). 

Note   In a field set up to auto-complete, you see suggestions based 
on what you type.

Enter data in a number 
field

Type the values (from 10400 to 10-400).
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Enter data in a date field Type one date on one line in the field. Type the day, month, and 
year as numbers (for example, 3/3/2010), separated by a 
nonnumeric character like – (minus) or / (forward slash). 

Note   You cannot use a : (colon) as a date separator.
Important   If you enter dates with two-digit years, FileMaker Pro 
converts them to four-digit year dates using a conversion method 
described in Help. To avoid misinterpretations during conversion, 
always enter dates with four-digit years.

Enter the current date in a 
date, number, or text field

Choose Insert menu > Current Date.

Select the date using the drop-down calendar, if available.

Enter data in a time field Type the time of day (or time duration) as:

1 hours

1 hours and minutes

1 hours, minutes, and seconds

1 hours, minutes, seconds, and fractional seconds

Separate hours, minutes, and seconds by a nonnumeric 
character like : (colon). 

Separate fractional seconds by a . (period).

Type the time of day in 24- or 12-hour format, with or without 
AM or PM. (AM is assumed for a time less than 12:00.)

Enter the current time in a 
time, number, or text field

Choose Insert menu > Current Time.

Enter data in a timestamp 
field

Type the date and time (for example, 10/15/2010 3:15:05 PM). 
Type the day, month, and four-digit year as numbers, separated 
by a nonnumeric character like – (minus) or / (forward slash).

Note   You cannot use a : (colon) as a date separator.
Then type the time of day as:

1 hours and minutes 

1 hours, minutes, and seconds

1 hours, minutes, seconds, and fractional seconds

1 Type AM or PM if the time is not in 24-hour format

Separate hours, minutes, and seconds by a nonnumeric 
character like : (colon). 

To Click in the field in Browse mode, then
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Finding records 
To find records, work in Find mode. You type criteria (the value or values to 
find) into fields in a find request, which looks like a blank record. When you 
perform a find, FileMaker Pro searches through all the records in a table, 
comparing the criteria you specify with the data in the table. Records with data 
matching the criteria become the found set, which is the subset of records being 
browsed. Records that don’t match are omitted. You can constrain (narrow) or 
extend (broaden) the found set.

You can work with just the records in the found set. For example, you can view, 
edit, calculate summaries for, sort, print, delete, export, or replace data in these 
records. You can also open a new window in order to perform different find 
requests on the same data.

You can’t perform a find in summary fields, container fields, or fields defined 
with the global storage option.

Enter the current date and 
time in a timestamp field

Choose Insert menu > Current Time.

Select the date using the drop-down calendar, if available.

Insert a tab character in a 
field

Click where you want to insert the tab. Press Ctrl+Tab 
(Windows) or Option-Tab (Mac OS).

Delete data from a field Select the data, then press Backspace or Delete.

Add data to a  
container field

For information, see Help.

Insert a file in a container 
field

For information, see Help.

Add data to value lists 
(fields formatted as radio 
or option buttons, 
checkboxes, lists, or 
menus)

For information, see “Setting up checkbox sets and other 
controls on a layout” on page 118. 

Edit, format, or check the 
spelling of text in a field 
or edit dictionaries

For information, see Help. 

To Click in the field in Browse mode, then
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Making a find request
To make a find request:

1. Switch to Find mode by clicking Find in the status toolbar.

2. From the Layout pop-up menu, select a layout that includes the fields that 
contain the data you want to search.

If necessary, you can change layouts and enter criteria on more than one 
layout.

3. In the find request, select a text, number, date, time, timestamp, or 
calculation field to use for finding, and then type a value in the field. 

You can use the Insert Operators list in the layout bar to help you enter 
criteria. You can click Omit to exclude records matching a specific set of 
criteria.

4. Click Perform Find.

Your find request returns a found set of records. The light green area of the 
pie chart in the status toolbar indicates the portion of the total records 
displayed.

Choose a 
layout with 

fields you 
want to 

search on

Type find criteria in fields
Click to see 
operators

An icon indicates you 
can search on the field
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You can do one or more of the following during or after performing a find 
request:

Performing quick finds based on data in one field
You can perform quick finds based on field data without having to go to Find 
mode. You can perform a find based on an entire field or a selection of text 
within a field. For more information, see Help.

1. In Browse mode, select the text in a field you want to use for the find.

2. Right-click (Windows) or Control-click (Mac OS) the selected text. From 
the shortcut menu, choose Find Matching Records.

To Do this

Cancel a find operation before 
it is finished and leave the 
previous found set unchanged

Press Esc (Windows) or 2-period (Mac OS).

Change or refine criteria after 
performing a find request

See “Viewing, repeating, or changing the last find” on 
page 55.

Narrow an existing found set See “Constraining (narrowing) a found set” on page 51.

Broaden an existing found set See “Extending (broadening) a found set” on page 52.

Show all records again In Browse mode, choose Records menu > 
Show All Records.

In Find mode, choose Requests menu > Show All Records.

You don’t need to choose Show All Records before 
performing finds. FileMaker Pro always searches all 
records in the tables you specify unless you have narrowed 
the existing found set.

Open another window in order 
to perform different find 
requests on the same data

Choose Window menu > New Window.
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Finding text and characters
Search for text in text fields, or in calculation fields that return a text result.

Unless you search for phrases and exact matches, the field can contain other 
values in addition to the one(s) you specify, and the values can be in any order. 
For example, typing hotel in a field named Accommodation finds records 
for Hotel, Discount Hotel, and Hotel, Luxury. 

To find Type this in the field Examples

Words that start with specific 
Roman characters (works with 
fields that use any language 
except Japanese)

The characters Chris Smith finds Chris 
Smith, Smith Chris, Chris 
Smithson, and Smith Christenson

Words that start with Japanese 
Hiragana, Katakana, or Kanji 
characters

The characters between 
= and *

= 小田 * finds 小田 , 小田山 , 
and 小田川

A phrase or sequence of 
characters that match when 
they are the first characters in a 
word (match phrase from 
word start)

The literal text 
(characters), including 
spaces and punctuation, 
between double 
quotation marks (")

"Marten and Jones 
Interiors" finds Marten 
and Jones Interiors but not 
Jones and Marten Interiors

", Ltd." finds all 
companies with ", Ltd." in the 
name, but not those without the 
comma

“Spring” finds Springville 
but not ColdSpring or HotSpring

Words with one or more 
unknown or variable 
characters (any one character)

One wildcard character 
(@) for each unknown 
character

Gr@y finds Gray and Grey 

@on finds Don and Ron but not 
Bron

Invalid characters in a text 
field

? Invalid characters display as 
blank characters

Note   To find the ? character, 
search for “?”

Digits in a text field (any one 
digit)

A # character for each 
digit

# finds 3 but not 30

## finds 30 but not 3 or 300

#3 finds 53 and 43 but not 3
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Words with zero or more 
unknown or variable text 
characters in a row (zero or 
more characters)

 * for all unknown 
characters

Jo*n finds Jon and John

J*r finds Jr. and Junior

*phan* finds Phan and 
Stephanie

Operators or other non-
alphanumeric characters, such 
as punctuation or spaces 

The literal text 
(characters), including 
spaces and punctuation, 
between double 
quotation marks (")

"@" finds @ (or an email 
address, for example)

"," finds records containing a 
comma

"   " finds three spaces in a 
row

A character with special 
meaning, such as the find 
operators recognized by 
FileMaker Pro:@, *, #, ?, !, =, 
<, >, " (escape next character)

\ followed by the special 
character

\"Joey\" finds "Joey"

joey\@abc.net finds the 
email address joey@abc.net

Words with accented 
characters

The literal text 
(characters), including 
spaces and punctuation, 
between the double 
quotation marks (")

"òpera" finds òpera but not 
opera

(òpera without quotes finds 
both òpera and opera)

Partial phrases, a sequence of 
words or characters (match 
phrase from anywhere)

Characters, punctuation, 
and spaces between 
double quotation marks 
(" "); use * to find this 
text in the middle of a 
longer text string

*"son & Phillips" finds 
Johnson & Phillips and 
Paulson & Phillips

Exact matches of the text you 
specify (match entire field)

== (two equal signs) for 
a field content match

==John finds John but not 
John Smith

==John Smith finds John 
Smith but not Smith, John or 
John Smithers

To find Type this in the field Examples
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Exact matches of whole words 
you specify (match whole 
word)

= =Market finds Market, 
Market Services, and Ongoing 
Market Research but not 
Marketing or Supermarket

=Chris =Smith finds 
Chris Smith or Smith Chris but 
not Chris or Christopher 
Smithson

Words that contain Japanese 
Hiragana, Katakana, and 
Kanji characters (Japanese-
indexed fields only)

The characters 京都 finds 京都 , 東京都 , and 
京都府

Kana characters in a Japanese-
indexed field without 
differentiating between 
Hiragana/Katakana, Voiced/
Semi-Voiced/Unvoiced Kana, 
Small/Regular Kana, and 
Kana Voiced/Unvoiced 
Iteration Marks

~ (tilde) and the 
character, to do a relaxed 
search

~は finds は , ば , ぱ , ハ , バ , 
and パ

Ranges of information See “Finding ranges of 
information” on 
page 48.

Case-sensitive text Change the default 
language for indexing 
the field to Unicode.

Note   This procedure 
will change the order in 
which records sort. For 
more information, see 
Help.

fred finds fred but not Fred

To find Type this in the field Examples
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Finding numbers, dates, times, and timestamps
Numbers, dates, times, and timestamps should be entered in the corresponding 
field types (or calculation fields returning the corresponding field type) to 
ensure correct behavior when finding them. See “About choosing a field type” 
on page 82. 

Important  To avoid confusion when working with dates, always use four-digit 
years. For more information, see the Help topic “Conversion of dates with two-
digit years.”

To find Type this in the field Examples

A number in a number field 
or in a calculation field that 
produces a numeric result

The number .50 finds .5, .50, and $.50

A Boolean number in a 
number field or in a 
calculation field that 
produces a Boolean result

1 to find True values

0 to find False values

1 finds 1

0 finds 0

A date in a date field or in a 
calculation field that 
produces a date result

The date as digits, separated 
by a valid date separator 
character (such as a slash or 
hyphen)

3/3/2010 finds 3/3/2010, 
March 3, 2010, and 3-3-2010

Today’s date in a date field 
or in a calculation field that 
produces a date result

// // finds April 4, 2010 (when 
the current date is 4/4/2010)

A time in a time field or in a 
calculation field that 
produces a time result

The time as digits, separated 
by colons

12:53:09 finds 12:53:09

A timestamp in a timestamp 
field or in a calculation field 
that produces a timestamp 
result

The date as digits, separated 
by a valid date separator 
character, then the time as 
digits, separated by colons

3/3/2010 12:53:09 
PM finds 3/3/2010 12:53:09 PM

Invalid dates, times, 
timestamps, or calculated 
date or time results 

? ? finds:

Next Tuesday or 2/33/2010 in a 
date field, or midnight in a 
time field
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Invalid data (fields 
containing no numbers) in a 
number field or calculation 
field that produces a 
numeric result

? ? finds:

twelve but not 12 or twelve30

Dates on a day of the week 
in a date or timestamp field

The day of the week

Note   Full or short day names 
(for example, Friday or 
Fri) are acceptable in day of 
week searches.

Tuesday finds all dates that 
occur on a Tuesday

=Thu finds all dates that 
occur on a Thursday

Any valid value for a date or 
time component in a date, 
time, or timestamp field

* or leave component 
unspecified, while specifying 
the other components you 
want to find

3/3/* finds the 3rd day of 
March in any year

*:15 finds times that are 15 
minutes after any hour

1/1/* 7 PM finds 
timestamps in the 7 o’clock 
hour on January 1st in any 
year

Note   When the year is 
unspecified, the current year is 
assumed. 3/3 finds the 3rd 
day of March in the current 
year

Ranges of information See the next section, 
“Finding ranges of 
information.”

To find Type this in the field Examples
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Finding ranges of information

To find values that are
Use this 
operator Examples

Less than a specified value < <40 
<9/7/2010 
<M

Less than or equal to a specified value <= 
or ≤ (Mac OS)

<=95129 
≤05:00:00 
<=M

Greater than a specified value > >95129 
>9/7/2010 
>M

Greater than or equal to a specified value >= 
or ≥ (Mac OS)

>=100 
>=9/7/2010 
≥8:00 
≥M

Within the range you specify. A range is 
different based on the data type: 

1 Numbers: least to greatest 

1 Dates and times: earliest to latest

1 Text: first to last word, based on the 
index order of words (not the sort 
order)

.. or ... (two or 
three periods)

12:30...17:30 
1/1/2010..6/6/
2010 
A...M

To find dates Type this in the field

In June 2010 6/2010

From July 2010 through October 2011 7/2010...10/2011

That occur on a Friday =Friday

From the 10th through the 16th of October or 
November 2010  
(if the date format is MM/DD/YYYY)

{10..11}/{10..16}/2010
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Finding data in related fields
You can enter find criteria in related fields that are displayed in a portal or 
directly on a layout. 

When you perform a find in a related field, FileMaker Pro displays all the 
records that have a related record matching the criteria you enter. For example, 
suppose you have an invoice file that displays line items as related records in a 
portal. To find all invoices listing a computer, type Computer in the Item 
field in the portal. For information about related fields, see chapter 4, “Working 
with related tables and files.”

That occur on March 1st between 1868 and 1912 
in the Japanese Emperor Year era of Meiji

m*/3/1

That occur on December 31st between 1930 and 
1940 in the Japanese Emperor Year era of Showa

S{5..15}+12+31

To find times Type this in the field

In the 3 o’clock hour, not including 4:00 PM 3 PM

Between 8:00 AM and 8:59:59 PM 8 AM..8 PM

In the morning AM

Any of the times 4:30, 5:30, 6:30 PM {4..6}:30 PM

To find timestamps Type this in the field

In the 3 o’clock hour today // 3 PM

In the 7 o’clock hour in May 2010 5/2010 7 PM

That occur on a Monday in 2010 =Mon 2010

From the 10th through the 16th of November 
2010 and from 3:00 PM to less than 6:00 PM 
(if the date format is MM/DD/YYYY)

11/{10..16}/2010 {3..5} PM

To find dates Type this in the field
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For information about omitting related records, see “Finding records except 
those matching criteria” on page 53.

E154Invoice ID

AlvarezName

Item ID Item
I100 Computer
I202 Desk
I153 Lamp
I229 Bookcase
I448 Chair

Find request

E153Invoice ID

TangName

Item ID Item
I202 Desk
I443 Long table
I153 Lamp
I288 Round table
I100 Computer

Invoice ID

Name

Item ID Item
Computer

E152Invoice ID

DurandName

Item ID Item
I384 Swivel chair
I554 Panels
I288 Round table
I100 Computer
I448 Chair

Records in table
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Finding empty or non-empty fields

Finding duplicate values
You can find all records for which one or more fields contain duplicate values. 
For example, you might want to find all records that aren’t unique, then 
examine them to decide which records to use or delete.

To find all duplicate records, in Find mode, type ! in the field.

Finding records that match multiple criteria
You can narrow or broaden your search by using more than one criterion.

Logical AND search
To narrow your search, enter criteria in as many fields as needed to make your 
request specific, then click Perform Find.

Constraining (narrowing) a found set
You can narrow find results incrementally, looking for more specific detail as 
you search your database.

For example, after searching for all of the employees who work in Sales, you can 
narrow the search to find all of the employees in Sales named Alvarez:

1. Perform a find to find all of the employees who work in Sales.

FileMaker Pro displays the found set in Browse mode.

2. Click Find and type the criteria to narrow the search (type Alvarez in the 
Last Name field).

To find fields that are Type this in the field

Not empty (fields that have data) *

Empty =
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3. Choose Requests menu > Constrain Found Set.

The found set now consists of employees in Sales named Alvarez.

Note  To quickly constrain the found set in Browse mode, use the shortcut menu. 
Click in the field (or select a partial value in the field), then right-click (Windows) 
or Control-click (Mac OS), and choose Constrain Found Set.

Logical OR search 
To widen your search, enter criteria in the first request. Click New Request. 
Enter the second (set of) criteria. Continue adding requests for each (set of) 
criteria, then click Perform Find.

You can navigate among multiple requests using Go to Request on the Requests 
menu or clicking the book in Find mode.

Examples:

1 To include customers in New York and customers in Paris in the found set, 
type New York in the City field in the first request, then type Paris in 
the City field in the second request. 

1 To include companies with more than 100 employees and companies with 
more than $100 million in assets, type >100 in Number of Employees in 
the first request, then type >100,000,000 in Capitalization in the second 
request.

1 To include 6th grade students who are in Algebra and 7th grade students 
who are in Geometry, type 6 in Level and Algebra in Course in the first 
request, then type 7 in Level and Geometry in Course in the second 
request. 

Extending (broadening) a found set
You can broaden a found set to expand your search to include additional 
applicable records without starting over.

For example, after searching for customers in New York, you can broaden the 
search to also find customers in Hong Kong:

1. Perform a find to find customers in New York.

FileMaker Pro displays the found set in Browse mode.
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2. Click Find and type the criteria to broaden the search (type Hong Kong in 
the City field).

3. Choose Requests menu > Extend Found Set.

The found set now consists of customers in New York and Hong Kong.

Note  To quickly extend the found set in Browse mode, use the shortcut menu. 
Click in the field (or select a partial value in the field), then right-click (Windows) 
or Control-click (Mac OS), and choose Extend Found Set.

Records that match one set of criteria but not another
To narrow your search by excluding records that meet specified criteria (for 
example, to find vendors in New York state that are not in New York City), see 
“Finding some records while omitting others” on page 54.

Finding records except those matching criteria
You can exclude (omit) records while performing a find. In other words, you 
can find information in your database that “does not equal” your specified 
criteria. For example, you can find all invoices except those created in the past 
30 days. 

Finding records that don’t match criteria 
For example, to find all sales records except those for the city of London:

1. In Find mode, type criteria for the records to omit. 

2. Click Omit in the layout bar.
 

3. Click Perform Find.

Click Omit to exclude 
records that match 
the request
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Finding some records while omitting others
For example, to find vendors in the state of New York, except those in New 
York City:

1. In Find mode, type the criteria for the records to find (type New York in 
the State field).

2. Click New Request.

3. Type criteria for the records to exclude (type New York in the City field). 

4. Click Omit.

5. Click Perform Find.

Keep these points in mind:

1 You can have Omit criteria in more than one request.

1 FileMaker Pro works through the requests in the order you create them. For 
example, in a Clients database with clients in the US and France:

1 If the first request finds all clients in Paris and the second request omits 
all clients in the US, the found set contains all clients in Paris, France 
but none in Paris, Texas or anywhere else in the US.

1 If the order of the requests is reversed (the first request omits all clients 
in the US and the second request finds all clients in Paris), the found set 
includes all clients in Paris, France and in Paris, Texas, but no records 
for clients elsewhere in the US.

1 To omit a related record from a portal row (or set of related records), you 
must change the relationship or the value in at least one of the match fields 
so that the record is no longer related. For information about related fields, 
see chapter 4, “Working with related tables and files.”

1 You can open another window in order to perform different find requests on 
the same data. See “Opening multiple windows per file” on page 25.

1 To omit records from a found set after performing a find, see “Hiding 
records from a found set and viewing hidden records” on page 55. 
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Saving find requests
When you have a complex find request that you want to use regularly, you can 
save the request and retrieve it when you need it later. You can save and retrieve 
find requests without having to go to Find mode. FileMaker Pro automatically 
saves the last five finds you have performed so you can access them again. 
Once a find is saved, the saved find is also available to any network clients that 
share the account. For more information about saving find requests. see Help.

Deleting and reverting requests
To delete a request, go to the request you want to delete, then click Delete 
Request.

To restore a request to the way it was when you last committed it, choose 
Requests menu > Revert Request. Requests are committed, for example, when 
you click out of all fields, go to a different layout or request, or perform a find. 

Viewing, repeating, or changing the last find
To view the most recent find criteria, choose Records menu > Modify Last Find. 
Then, to return to the found set, switch to Browse mode. To repeat the find, 
click Find. Or you can modify the find criteria, then click Perform Find.

Hiding records from a found set and viewing hidden records
All records that are not in the found set are omitted, or hidden. You can omit 
additional records from the found set without doing a new find. 

Important  Omitted records are temporarily excluded from the found set. They still 
exist in the database.  

To Do this

Omit a specific record Display or select the record to omit, then click Omit in the 
layout bar.

Omit a series of records Display or select the first record in a number of consecutive 
records to omit, then choose Records menu > Omit Multiple. In 
the Omit Multiple dialog box, type the number of records to 
omit, then click Omit.
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Finding and replacing data
As in a word processing application, you can find and replace data across 
multiple fields (including related fields) in a record or in a find request, across 
a found set of records or find requests, or across text objects in a layout. You 
can search for data in any type of field except container fields and fields that are 
not modifiable.

If you have added a tab control to a layout, when you find and replace data in 
Browse and Find modes, FileMaker Pro only finds and replaces data in the tab 
panel that is in front. In Layout mode, FileMaker Pro finds and replaces data in 
all tab panels.

1. In Browse, Find, or Layout mode, choose Edit menu > Find/Replace >  
Find/Replace.

2. In the Find what box, type the data you want to search for. In the Replace 
with box, type the replacement data.

You can’t replace data in fields that are formatted as pop-up menus, radio 
buttons, or checkboxes. These fields will be counted and reported as 
skipped at the end of a Replace all operation.

View the omitted set Click Show All in the status toolbar.

Bring back all the records 
in the file

Choose Records menu (Browse mode) or Requests menu 
(Find mode) > Show All Records.

To Do this
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3. Set the search options you want to use.

4. Click one of the buttons to perform the type of find/replace operation you 
want.

Select To

An option from the 
Direction list

Choose the search direction: Forward, Backward, or All.

Match case Search for only those occurrences in which the capitalization 
matches the data you specified in the Find what box.

Note   In files that contain Japanese data, a find with the Match 
case option cleared does not simultaneously find both the half-
width and full-width version of the same character. To 
comprehensively find and replace both characters, make sure you 
perform separate finds for both the half-width and full-width 
character.

Match whole words only Search for only those occurrences that are whole words or are 
bounded by spaces and/or punctuation characters.

An option in Search 
across

In Browse mode, search across all records in the current layout 
or just in the current record.

In Find mode, search across all find requests in the current 
layout or just in the current find request.

Note   In Layout mode, FileMaker Pro searches just in the current 
layout.

An option in Search 
within

In Browse and Find modes, search within all fields in the 
current layout or just in the current field.

Click To

Find Next Search for and select the next occurrence of the Find what data.

Replace & Find If there is selected data that matches the Find what data: Replace the Find 
what data with the Replace with data, search for and select the next 
occurrence.

If there is no selected data that matches the Find what data: Search for and 
select the first occurrence of the Find what data.
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For more information about finding and replacing data, see Help.

Sorting records
FileMaker Pro stores records in the order they were added to the file. Sorting 
temporarily rearranges records, so you can view, update, or print them in a 
different sequence.

You choose the fields whose contents you want to sort by. The first sort field 
arranges the records based on the field’s contents. The second sort field 
arranges records when two or more records have the same value in the first sort 
field, and so on. You can sort records in ascending order, descending order, or 
in a custom order.

The records remain sorted until you perform a find, add new records, or sort 
the records again. When you add a new record to a sorted found set, the new 
record appears in the correct position in the sort order when you commit the 
record.

To sort the records in the current found set:

1. In Browse mode, click Sort in the status toolbar.

2. In the Sort Records dialog box, choose fields for sorting, in the order you 
want them sorted by, and sort options.

To choose a sort field visible on the current layout, no matter what table it 
is in, choose Current Layout (LayoutName) from the table list, then double-
click a field in the list.

To choose a sort field that is in the current layout’s table, whether or not it 
is on the current layout, choose Current Table (TableName) from the table 
list, then double-click a field in the list.

For information about sort options, see Help.

Replace Replace the Find what data with the Replace with data.

Replace All Replace all occurrences of the Find what data with the Replace with data.

At the end of the Replace All operation, you see a summary of the number 
of occurrences found and replaced.

Click To
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3. Click Sort. 

To cancel before sorting is finished, press Esc (Windows) or 2-period 
(Mac OS).

Note  You can sort records on one field without opening the Sort dialog box by 
using the field’s shortcut menu. 

For information about how FileMaker Pro uses system formats to sort and 
display dates, times, and numbers, see Help.

Previewing and printing databases
With FileMaker Pro, you can print:

1 all the records in the database, a subset of the records, or only the current 
record

1 a blank record to create a paper form

1 definitions of scripts, fields, tables, and relationships to see the structure of 
your database

1 data saved as a PDF file

FileMaker Pro prints records using the current layout. You can create layouts 
to print the same data in different ways. For example, you can print records one 
by one, in a columnar list, or in a complex sorted report with totals, headers, 
and footers. You can also create layouts for mailing labels or envelopes.

The New Layout/Report assistant (in Layout mode) makes it easy to create 
such layouts and reports. See “Creating layouts and reports” on page 98.
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You can control page margins, remove blank space, and keep specified objects 
from printing.

Previewing data on a layout 
When you switch to Preview mode, you see the layout as it appears on the 
printed page. You can’t enter or edit information in fields in Preview mode.

In Preview mode, you see: 

1 how many records fit on a printed page

1 how the pagination settings you choose affect page breaks

1 subsummary parts with calculated summary fields

1 variable information supplied by FileMaker Pro, like page numbers, the 
current date, and so on

1 the page margins you define

Print Phone List

Go to Layout [Phone List]
Sort [Sort Order: Last name (Ascending) ]

[Restore sort order, No Dialog]
Enter Preview Mode

[Pause]
Print

[no dialog]
Enter Browse Mode

Name Phone
Juanita Alvarez 408-555-1234
Michelle Cannon 213-555-2345
Andre Common 714-555-3456
Marie Durand 619-555-4567
Jean Durand 408-555-5678
William Johnson 408-555-6789

Phone List

Records being browsed

Field Name Field Type Formula/Entry Options

First Name Text
Last Name Text
Address1 Text
Address 2 Text
City Text
State Text
Postal Code Number
Phone Text

Name Phone
Juanita Alvarez 408-555-1234

Phone List

Current record

Script

Table and field definitions

Blank record

You can print data based on the current layout or print information about the 
structure of the database

Relationships graph

Name Phone

Phone List
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1 how fields set with sliding options close up blank space 

1 records arranged in columns if the Layout Setup is defined to print in 
columns

1 the tab panel in the front if the page contains tab controls

To preview data on a layout, you follow the same preliminary steps that you 
perform when you print, including specifying a printer and printing options 
and verifying that the found set contains the records you want to preview (see 
steps 1 through 4 in the next section, “Printing records”). Then, switch to 
Preview mode.

Printing records
You can print information from your database, or you can print a blank record 
in order to print a blank “form.” 

To print records:

1. If you have more than one printer, specify which one you want to use.

2. Confirm printing options by choosing File menu > Print Setup (Windows) or 
File menu > Page Setup (Mac OS), then click OK.

If you’re in Preview mode, you can also click Print Setup (Windows) or 
Page Setup (Mac OS) in the status toolbar.

For information about printer options, refer to your printer and system 
documentation.

3. Switch to the layout you want to use. 

4. Make sure the found set is the way you want it by:

1 using Find mode and commands on the Records menu to change the 
found set 

1 sorting the records 

5. Switch to Preview mode to see exactly how your paper copy will look. 

Some items, like sliding objects, records arranged in columns, and variable 
information like page numbers, appear correctly only in Preview mode. If 
a record contains tab controls, only the tab panel that is in the front is 
printed.
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6. Choose File menu > Print.

7. In the Print dialog box, for Print, choose an option (Windows) or choose 
FileMaker from the pop-up menu (Mac OS). 

To print Choose

All records (or only records in the found set) Records being browsed

Only the record currently selected in Browse mode Current record

A blank record using the current layout (use this 
option to print a blank “form”)

Blank record, showing fields, then 
choose a formatting option 

Select to update 
linked OLE objects 

before printing

Choose the 
data to print

Click to change the page orientation (vertical or 
horizontal), scaling, and other printing options

Print dialog box (Windows)
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8. Select the print range, number of copies and other printing settings, then 
click OK (Windows) or Print (Mac OS).

Printing labels and envelopes
You can create layouts for formatting and printing data onto mailing labels and 
envelopes. The process for printing envelopes is similar to that for printing 
labels.

You use the New Layout/Report assistant to create a Labels layout that 
includes data from the fields you choose, arranged to print on many types of 
label stock (for example, Avery 4014). FileMaker Pro provides the dimensions 
of numerous standard label types and their codes. If the label type you want 
isn't available, you can specify custom label dimensions.

Labels layouts use merge fields, which are placeholder fields for displaying 
and printing only; you can’t enter data into merge fields. Merge fields expand 
and contract to fit the data in the field as needed, closing up space if the field is 
empty.

Choose the data to print

Print dialog box (Mac OS)

Choose FileMaker from the list
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There are three general steps for creating and printing labels:

1. Create a Labels layout.

2. Set up the merge fields.

3. Print the labels.

Tip   If you need help as you use the New Layout/Report assistant, click the Help 
button in each panel.

Creating a Labels layout
1. Open the file that contains the data you want to print on labels.

2. Find the records containing the data you want to print on labels.

3. Switch to Layout mode.

4. Click New Layout/Report in the status toolbar, or choose Layouts menu > 
New Layout/Report.

5. In the New Layout/Report assistant, for Layout Name, type a name for the 
layout.

To have the layout name appear in menus used for choosing layouts, select 
Include in layout menus.

6. For Select a layout type, click Labels (for data that reads top to bottom 
horizontally). Or click Vertical Labels (for data that reads right to left 
vertically). Then click Next.

For an Envelope layout, click Envelope, and skip to “Choosing and 
formatting the merge fields.”
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7. Specify the measurements of your mailing labels.

1 To choose a predefined measurement based on common label types, for 
the Use label measurements for list, choose the code that matches your 
labels. (You see this information on the package your labels came in.) 
FileMaker Pro creates a Labels layout that uses the exact dimensions of 
label stock code you choose.

1 To specify a custom measurement, choose Use custom measurements, 
and enter values for Labels across the page, Width, and Height. Measure 
the unused margins on the label stock. Then select Fixed page margins 
and enter values for Top, Bottom, Left, and Right.

8. Click Next.

Choosing and formatting the merge fields
1. In the next panel, for the Available fields list, double-click the first field 

whose data you want on the labels.

<<field name>> appears in the Label Contents area. Angle brackets indicate 
this is a merge field, and field data will display in and print on the labels.

To include fields from related tables, choose the table from Available fields.

2. Continue selecting the fields you want on the labels.

Include all punctuation, blank spaces, and line breaks (to place a merge 
field on the next line) that you want to print on the labels. 

3. Click Next.

Previewing and printing labels
1. In the next panel:

1 To see how the data will appear on the labels before printing them, 
select View in Preview mode, and click Finish.

1 To edit the labels, select View in Layout mode, and click Finish.

2. To print labels from Browse, Layout, or Preview modes, load the labels into 
your printer according to the instructions that came with your labels and 
your printer. Then choose File menu > Print, choose the printer and any 
additional options, and click Print.
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Keep these points in mind:

1 To choose options for how you want labels printed on the page, choose 
Layouts menu > Layout Setup, and click the Printing tab. Then choose the 
number of columns (labels) across and the direction in which you want the 
labels printed, and set custom page margins, if needed.

1 You may need to adjust your printer settings to print the labels correctly. 
Choose File menu > Print Setup (Windows) or Page Setup (Mac OS).

1 Some labels might not have the same number of printed lines as others. 
This happens because if there is no data in a field, FileMaker Pro closes up 
the blank space.

For more information about creating a layout for labels or envelopes, choosing 
printing and layout setup options, and additional considerations when you 
create a Labels or Envelope layout, see FileMaker Pro Help.

Printing scripts
You can print a list of all script steps for one or more scripts in a file.

1. Choose Scripts menu > Manage Scripts, or choose File menu > Manage > 
Scripts.

2. In the Manage Scripts dialog box, select the script or scripts you want to 
print.

To select more than one contiguous script in the list, Shift-click the scripts. 
To select more than one non-contiguous script, Ctrl+click (Windows) or 2-
click (Mac OS) the scripts.

3. Click  at the bottom of the dialog box.

4. Click OK (Windows) or Print (Mac OS).

The selected script steps and options are printed.
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Printing table and field information
To print table or field information:

1. Choose File menu > Manage > Database, then click the Tables or Fields tab.

2. Select the table(s) or field(s) you want to print.

To select more than one contiguous table or field in the list, Shift-click the 
tables or fields. To select more than one non-contiguous table or field, 
Ctrl+click (Windows) or 2-click (Mac OS) the tables or fields.

3. Click Print.

4. Click OK (Windows) or Print (Mac OS).

The field names, field types, and formulas or data entry options are printed 
for each selected table.

Printing the relationships graph
You can print a graphical representation of your database by printing the 
relationships graph.

1. Choose File menu > Manage > Database, then click the Relationships tab.

2. Click  to display page breaks in the relationships graph. 

3. Click    to display the Print Setup (Windows) or Page Setup (Mac OS) 
dialog boxes.

4. Click Print.

5. In the Printing Options dialog box, choose an option.

1 Choose Print graph on multiple pages to print the graph on more than one 
page. 

1 Choose Print graph on one page to resize the graph to fit on one page.

6. Click Continue.

7. Click OK (Windows) or Print (Mac OS).

For more information about previewing and printing databases, see Help.
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Automating tasks with scripts
Scripts can do simple tasks like setting print orientation or complex tasks like 
preparing a customized mailing to clients. Scripts can incorporate conditional 
decisions (if-else statements) and perform repetitive tasks (loop statements).

You use the Manage Scripts feature in FileMaker Pro to build scripts by 
selecting from a list of FileMaker Pro script steps, specifying options, and 
arranging the steps in the correct order to perform the task.

Use scripts to combine and automate tasks like:

1 switching to another layout or mode

1 finding, sorting, and printing records

1 importing data from the same source

FileMaker Pro makes it easy for you to manage scripts. You can display a 
default script to use as a template when writing your own scripts. You can open 
several scripts at once to compare them. You can copy and paste entire scripts 
between files. You can copy and paste script steps from one script to another 
script in the same file or to a script in a different file. You can assign scripts to 
groups to make it easy to find scripts of a specific type (for example, copy an 
entire group of scripts to another file or delete an entire group of scripts). And 
you can design scripts to run when a particular event occurs (such as when 
users enter a field, press a key, or add a new record to the database).

Procedures for creating and managing scripts and a reference to all 
FileMaker Pro script steps (organized alphabetically or by category) are 
available in Help.

Backing up database files
Routine backups are imperative for any document stored on a computer. It is 
easier to restore a backed up database than it is to recreate it. How often you 
should back up depends on the amount of data you are adding to your 
databases, and how difficult it would be to recreate your files if they become 
corrupt. 

For very important files, it’s a good idea to routinely store backups at an off-
site location. 
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For file back-up recommendations, see “Backing up databases and other 
important files” on page 199. For an example of a backup script, see Help.

Setting preferences
You can customize the appearance and behavior of FileMaker Pro to suit the way 
you work by changing standard settings called preferences. Preferences affect the 
behavior of the application and are not specific to any file. 

Settings in the File Options dialog box affect the current file’s default layout, 
opening and closing scripts, login information, and spelling.

To set application preferences:

1. Windows: Choose Edit menu > Preferences.

Mac OS: Choose FileMaker Pro menu > Preferences.

2. In the Preferences dialog box, click a tab, then set the options you want to 
use.

To set file preferences:

1. Choose File menu > File Options.

2. In the File Options dialog box, click a tab, then set the options you want to 
use.

For more information about setting application and file preferences, see Help. 
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Chapter 3
Creating databases

This chapter explains the basics of how to:

1 plan a database

1 define and modify fields

1 define tables

1 create layouts

1 work with fields, objects, and parts on a layout

Note  See Help for detailed, comprehensive information and step-by-step 
procedures about using FileMaker Pro.

Planning a database 
A well-designed database promotes consistent data entry and retrieval, and 
reduces the existence of duplicate data among the database tables. Relational 
database tables work together to ensure that the correct data is available when 
you need it. It’s a good idea to plan a database on paper first. 

Follow these general steps to plan a database:

1. Determine the purpose for your database, or the problem you want to solve. 
For example, “to keep a list of my customers,” “to manage my inventory,” 
or “to grade my students.”

If other people will use the database, be sure to talk with them about the 
data they will need.

2. Consider the information you will store in your database. Typically, 
information falls into broad categories. Accurately identifying these 
categories is critical to designing an efficient database, because you will 
store different types and amounts of data in each category. For example, a 
database intended to track sales has categories such as “products,” 
“invoices,” and “customers.” A database that records student grades has 
categories such as “students,” “classes,” and “assignments.”



72  |  Creating databases

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 72  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
3. Once you’ve determined the broad categories, consider how these 
categories are related. This can be done by writing simple sentences that 
describe how the categories interact, such as, “teachers teach classes,” 
“students are assigned to classes,” and “students complete assignments.” 
Each of these pairs suggests a relationship between the data in one category 
and the data in the other category.

4. Once you’ve identified your categories of information, you are ready to 
organize your database.

In database terminology, these categories of information are referred to as 
tables. Tables are used to group data containing a common element or 
purpose. For example, you might use one table to store names and 
addresses, while you use another table to store transaction details, such as 
date of sale, item number, unit price, and so on.

Typically, databases are organized in one of three ways:

1 A single table in a single file. Use a single table if you need to track data 
in one category only, such as names and addresses.

1 Multiple tables in a single file. Use multiple tables if your data is more 
complex, such as students, classes, and grades.

1 Multiple tables in multiple files. Use multiple files if you need to share 
the same data among several different database solutions. For example, 
you can store your tax rates or shipping information in a separate file if 
you plan to use that information in more than one solution.

Note   Use relationships to share data between tables in the same file or with 
tables in external files. Other database elements, such as scripts and access 
privileges, are stored at the file level; therefore, some complex solutions will 
benefit from using multiple files.
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5. Determine the database tables and the data they will include, and, in turn, 
which fields you will need.

Tip   To make it easy to search and sort records, create separate fields for first 
and last name, titles, (like Mr. or Dr.), and items in addresses (city, state or 
province, country, and postal code). Separating your data into multiple fields at 
the time of data entry can make it easier to generate future reports. For example, 
using separate fields to capture transaction details such as the date, item 
number, quantity, and unit price of each transaction makes it easier to compile 
summary and subsummary reports at the end of a week, month, or year.

6. Decide which fields will contain common data among the tables.

For example, a database for a travel agency might include these tables: a 
Clients table, which stores client information; a Routes table, which stores 
route information; and a Tours table, which stores the tours and their 
current prices.

A Clients table might have fields for a client identification number, and the 
client’s name, address and phone number. A Routes table might have fields 
for a route identification number, the departure city, and the destination city. 
A Tours table might have fields for a tour identification number and tour 
name.

Client ID

Street

Postal Code

Client Name

City

Tour ID

Clients table
Routes table

Tour Name

Tours table

Phone

Route ID

Destination

Origin
Tour ID

Route ID

Destination

Tour Name

Origin
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7. Determine the match fields for each table, and circle each one in your plan.

For more information, see “About match fields for relationships” on 
page 137.

For example, in the Clients table you might want to assign each client a 
unique, identifying number. You wouldn’t enter a client identification 
number into the table unless you had a new client to add, so the existence of 
a client number determines the existence of a record.

Client ID

Street

Postal Code

Client Name

City

Tour ID

Clients table
Routes table

Tour Name

Tours table

Phone

Route ID

Destination

Origin
Tour ID

Route ID

Destination

Tour Name

Origin
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8. For each table, decide which fields will store data, and which ones will be 
used from other (related) tables. 

Each table has only one subject, and all fields in a table describe only that 
subject. 

For example, the fields in one record of the Clients table together store all 
the information about one client. 

Based on a table’s subject, you can see where it makes sense to store the 
data and where to use data from a related table. Other than match fields, all 
fields should appear only once in your database. Cross out occurrences of 
fields that don’t pertain to the table’s subject. 

Client ID

Street

Postal Code

Client Name

City

Tour ID

Clients table
Routes table

Tour Name

Tours table

Phone

Route ID

Destination

Origin
Tour ID

Route ID

Destination

Tour Name

Origin
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9. Determine the relationships between the tables. In your plan, draw a line 
from each match field in a table to the corresponding match field in the 
related table.

What establishes a relationship between tables is that their match fields 
contain matching data. 

Relationships also make it possible to group your data to resolve complex 
queries. For example, relationships can be used to determine current 
inventory levels, sales projections, and other tasks where it is necessary to 
query data across multiple tables. For more information about 
relationships, see chapter 4, “Working with related tables and files.”

10. Determine whether you need to share your database with other users, and 
how they will access the file.

For more information about sharing databases, see “Sharing databases on a 
network” on page 156.

Client ID

Street

Postal Code

Client Name

City

Tour ID

Clients table

Routes table

Tour Name

Tours table

Phone

Route ID

Destination

Origin

Tour ID

Route ID

Destination

Tour Name

Origin
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11. Consider who will use the database and whether you want to restrict access 
to it. When you create the database, assign access privileges as needed.

For more information about accounts and privilege sets, see chapter 6, 
“Protecting databases with accounts and privilege sets.”

12. Decide what layouts you need, and plan a separate layout for each  task.

For example, create separate layouts for printing labels or envelopes.

For more information about creating layouts, see “Creating layouts and 
reports” on page 98.

13. Create a form such as the one shown below to list the files and tables you 
need and the fields for each table. Also list the forms and reports you will 
generate from each table.

14. Create your database. 

Sample Database Design Form

Project Name

Purpose of this database

Filename for this database

Table name

Field name Field type Comments

Layouts

Table name

Field name Field type Comments

Name Purpose                                  Screen    Print      Web
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Creating a FileMaker Pro file
You can create a file from a FileMaker Pro Starter Solution, or template—a 
predefined database file that you can modify to suit your needs. Or, you can 
create a file without using a template. 

Tip   You can also create a file by making a copy of an existing FileMaker Pro file. 
See “Saving files” on page 26. 

If you didn’t install the FileMaker Pro Starter Solutions, you can perform a 
custom installation to install all the Starter Solutions on your computer or 
download individual Starter Solutions from the FileMaker website. For more 
information, see Help. 

1. In FileMaker Pro, choose File menu > New Database.

Create an empty 
database or use a 

Starter Solution

To use a Starter 
Solution, select a 
solution category

Then select a solution
FileMaker Pro Quick Start Screen
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2. In the FileMaker Quick Start Screen, do one of the following:

3. In the dialog box that appears, type a name for the file and choose a 
different folder, if needed.

Windows: For Save as type, select FileMaker Files. If you don’t type a 
filename extension, FileMaker Pro adds .fp7 to the filename. (To view 
filename extensions in Windows, see the Windows operating system Help.)

4. Click Save.

1 If you are creating a file using a Starter Solution, the file opens ready for 
you to enter data. You can modify fields and layouts in Starter Solutions. 
For more information, see the remaining sections in this chapter.

1 If you are creating an empty database, the Manage Database dialog box 
appears. FileMaker Pro automatically creates the first table and the first 
layout. The table and the layout are given the same name as the file. To 
define fields, see the next section.

For more information about creating FileMaker Pro files, see Help.

To Do this

Create a file using a 
Starter Solution

Click Create a database using a Starter Solution, select All Solutions 
or a specific solution category in the list on the left, then double-
click the name of a solution on the right.

Notes

1 If the FileMaker Quick Start Screen doesn’t appear, Show 
FileMaker Quick Start Screen isn’t selected in the General tab of 
the Preferences dialog box.

1 If the FileMaker Quick Start Screen appears but there are no 
FileMaker Pro Starter Solutions displayed in it, the Starter 
Solutions weren’t installed.

Create a file without 
using a Starter Solution

Click Create empty database, then click OK. 

Open an existing file See “Opening files” on page 22.
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Defining database fields
To define a new field, you give it a name and select a field type. Then you select 
options that determine how the field interprets, enters, calculates, stores, and 
displays data. These characteristics make up the field definition. See “Setting 
options for fields” on page 92 for information on setting these options.

See “Formatting field data on a layout” on page 121 for information about 
setting options for field formats, which control how data appears on a layout.

The following sections describe how to define fields using the Fields tab in the 
Manage Database dialog box.

This field stores only numbers

This field calculates a value based on 
another value in the record 
(“Discount” is 10% of “Unit Price”)

This field stores multiple values

ET14Product ID

JacketProduct Name

ClothingCategory

BlueColors

$52.50Unit Price

$5.25Discount

Black

These fields store text

Field names 
and definitions 

Type a name for a 
new field

Select a 
field type

Click after you type a field 
name and select a field type

Choose the way fields are listed in the dialog box

Click to sort by 
field name or type
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About naming fields
Follow these guidelines when naming fields:

1 Field names must be unique. They can contain up to 100 characters. 

1 Use descriptive names that clearly identify the contents of the field. Avoid 
abbreviations, acronyms, or other terms that may cause confusion.

1 Don’t use any of the following symbols or words in the field name:

1 , (comma) + – * / ^ & = ≠ > < ≥ ≤ ( ) [ ] } " ; (semicolon) : (colon) :: 
(relational indicator) $ (variable indicator)

1 AND, OR, XOR, NOT, or the name of any FileMaker Pro function 

1 Don’t begin a field name to be used in a calculation formula with a space, 
period (.), or number.

1 Use _ (underscore) in place of a space to avoid restrictions in ODBC (Open 
Database Connectivity) or JDBC (Java Database Connectivity), exporting, 
web publishing, and other operations.

1 If you’re exchanging data with another application, check the field naming 
restrictions in the file formats supported by the other application. 

1 If you’re using ODBC or JDBC to share FileMaker Pro data, avoid using 
SQL keywords in field names. 
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About choosing a field type
When you define a field, you select a field type based on the kind of 
information the field will contain. The field type determines what kind of data 
can be entered and what kinds of operations FileMaker Pro can perform with 
the data. FileMaker Pro uses the field type to interpret the data for tasks like 
sorting records and performing calculations.

Select this  
field type

 
If the field data will be

Text Up to approximately 1 billion letters, symbols, and/or numbers used as 
text per field repetition, limited by available RAM and disk space. Indexes 
nominally based on the first 100 characters of each word or value. Text 
fields may contain carriage returns.

Number Values up to 800 digits or other characters, and the negative values of the 
same range. Number fields can also contain Boolean values (0 or 1), to 
indicate, for example, true, false, yes, and no. Number fields can’t contain 
carriage returns.

Date Dates only. Uses the Gregorian calendar with a range of 1/1/0001...12/31/
4000. Month, day, and year order is based on system settings when the file 
is created.

Time Times only. A time field can contain the hours, minutes, and seconds 
portion of a time. A time field can contain a negative time duration, for 
example,-08:40:00.

Timestamp Dates and times to reference a fixed point in calendar time. For example, 
10/25/2010 2:39:46 AM

Container 1 Graphics, movies, photos, bitmaps, sounds of up to 4 GB per field

1 Documents, including Microsoft Word or Excel files, PDF files, and so 
on

1 Multimedia file types supported by QuickTime 7.5

1 Software

Calculation The result of a calculation formula that uses field values from the current 
record or related records. The formula can use values of all field types. 
The result can be one of these types of data: text, number, date, time, 
timestamp, or container.

Summary A value that’s produced by summarizing field values from more than one 
record in the same table. 
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Keep these points in mind:

1 Any field type except summary can store a global value. For more 
information, see “About storage and indexing options” on page 96.

1 Be sure to use a date field (instead of a text or number field) to store dates. To 
avoid confusion when using dates, always use four-digit years. 

1 Use text fields instead of number fields to store postal codes, phone 
numbers, and other values with leading zeroes or characters like hyphens 
or parentheses.

1 Although you can’t find or sort records based on a container field, you can 
define a text field to describe or identify the contents of the container. Then, 
you can find or sort records based on the data in that text field.

1 To change the way data is displayed in text, number, date, time, and 
timestamp fields, see “Formatting field data on a layout” on page 121.

Summary fields 
produce results from 
values in multiple 
records

Agent Item Qty Amount

David Michaels ET3 1 $29.95
David Michaels ET4 1 $32.25
David Michaels ET1 2 $73.90
David Michaels ET5 3 $98.85

Total $234.95

Sophie Tang ET6 2 $64.50
Sophie Tang ET7 5 $12.50
Sophie Tang ET2 2 $25.00
Sophie Tang

Total $102.00

Grand Total $336.95

Sales Report

Calculation fields produce results from values in the 
current record or related records
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Defining text, number, date, time, timestamp, or container fields
1. With the database open, choose File menu > Manage > Database.

2. In the Manage Database dialog box, click the Fields tab.

3. If your file contains more than one table, select the appropriate table from 
the Table list.

You see tables from the current file and any external FileMaker Pro files or 
external ODBC data sources that this file references.

4. For the Field Name box, type a name for the field.

See “About naming fields” on page 81.

5. For Type, select a field type. 

See “About choosing a field type” on page 82.

You can enter a description of the field in the Comment box.

6. Click Create.
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7. To define options for the field, click Options.

For more information about field options, see Help.

8. Continue to define fields, or click OK.

Defining calculation fields
1. With the database open, choose File menu > Manage > Database.

2. In the Manage Database dialog box, click the Fields tab. 

3. If your file contains more than one table, select the appropriate table from 
the Table list.

To Do this in the Options for Field dialog box

Automatically enter values 
into the field

Click the Auto-Enter tab, select the options, then click OK. See 
“Defining automatic data entry” on page 92.

Make sure data is entered 
into the field correctly

Click the Validation tab, select the options, then click OK. See 
“Defining field validation” on page 94.

Important   To avoid confusion when using dates in 
FileMaker Pro, set field validation options to make sure dates are 
always entered with four-digit years.

Make the field repeating Click the Storage tab, then select Maximum number of 
repetitions. Type the number of repetitions (up to 1000), then 
click OK. For more information, see Help.

Select options for indexing 
the field

Click the Storage tab, select the options, then click OK.

Make the field use one 
value for all records in the 
file

Click the Storage tab, select Use global storage, then click OK. 

Create a link between the 
“parent” data field and the 
Furigana “child” field, so 
that when you input Kanji 
characters into the 
“parent” field, the 
corresponding Kana 
reading appears in the 
Furigana “child” field.

Click the Furigana tab, select Use Furigana Field, the Furigana 
field, and the Kana reading input format, then click OK. 

Note   This option is available if your operating system is 
configured to support Japanese text entry.
Available for text fields only.
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4. For Field Name, type a name for the field.

See “About naming fields” on page 81.

5. For Type, select Calculation. 

You can enter a description of the field in the Comment box.

6. Click Create.

You see the Specify Calculation dialog box.

7. If necessary, for Evaluate this calculation from the context of, choose a table 
from the list.

Setting the context for a calculation is only necessary when you’re creating a 
calculation field in a source table that has two or more occurrences in the 
relationships graph. The source table is the table defined in the Tables tab of the 
Manage Database dialog box. The choice you make may affect the calculation 
results, particularly if your calculation will include fields in related tables. 

8. Build a formula for your calculation.

Click where you want the item to appear in the formula box, then do the 
following. You can also type the formula into the box.

To add a  Do this

Reference to a field In the field list, double-click a field name.

To display field names from another table, choose a table from 
the table list.

Mathematical or text 
operator

In the keypad in the dialog box, click an operator. (Quotation 
marks and parentheses are copied to the formula as a pair, with 
the insertion point blinking in the middle).

Comparison or logical 
operator, or an exponent

 For Operators, choose an operator from the list.



Defining database fields  |  87

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 87  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
Procedures for working with formulas and a reference to all FileMaker Pro 
functions (organized alphabetically or by category) are available in Help.

9. Select calculation options for the field.

Constant value Type the value. A constant can be text, number, date, or time. 
Use date constants with the functions Date and GetAsDate, 
time constants with the functions Time and GetAsTime, and 
timestamp constants with the functions Timestamp and 
GetAsTimestamp.

Text constants can be up to 29998 characters long.

Function In the functions list, double-click a function (a predefined, 
named formula that performs a specific calculation and returns 
a single, specific value). In the formula box, replace the 
placeholder parameter with a value or expression.

To add a  Do this

Choose field 
references 

Formula box

Select comparison and 
logical operators

Select 
functions

Choose a 
formula 

result type

Choose 
indexing and 
storage options 

Make the calculated 
field repeating

Choose a table 
from the list

Calculate only if at least one 
field in the formula has a value

Select mathematical and 
text operators

Choose the 
way functions 
are listed in 
the dialog box

Choose the table from which the 
calculation will be evaluated

Click to display 
online Help on 

defining 
calculations
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10. To select indexing and global storage options for the field, click Storage 
Options, select options in the Storage Options dialog box, then click OK.

11. Click OK to close the Specify Calculation dialog box.

12. Continue to define fields, or click OK.

Note  If your FileMaker Pro file accesses data from external ODBC data sources, 
you can add supplemental fields to specify calculations using external data. 

For more information about defining calculation fields, the use of context in 
calculations, or supplemental fields, see Help.

Defining summary fields
Use summary fields to calculate values such as subtotals, averages, and grand 
totals across multiple records. For example, a summary field can display in a 
report the grand total of all sales in the month of May. 

Tip   Use the New Layout/Report assistant to quickly create a report with grouped 
data (data in a summary field). See “Creating layouts and reports” on page 98.

The value in a summary field can change depending on where you place the 
field on a layout, how many records are in the found set, whether the records 
are sorted, and which mode you’re using.

To Do this

Set the field type of 
the result

Choose a data type for Calculation result is <value>. Choose the 
correct type for the result you want. See “About choosing a field 
type” on page 82. 

Make a calculated 
field repeating

Select Number of repetitions, then type the number of repetitions.

Perform the 
calculation only 
when all referenced 
fields have a value 
(so you don’t display 
zero as a result)

Select Do not evaluate if all referenced fields are empty.

When enabled, FileMaker Pro does not evaluate a calculation if all 
fields used by the calculation are empty. This typically improves 
performance. Clear this option if you always want FileMaker Pro to 
calculate a result, even if a referenced field is empty or has never 
been modified.
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If you’re modifying a layout that contains a summary field, you must know 
about layout parts to get the results you want (see “Working with parts on a 
layout” on page 128). 

1. With the database open, choose File menu > Manage > Database.

In Layout mode, click Manage in the status toolbar, then choose 
Datatabase.

2. In the Manage Database dialog box, click the Fields tab. 

3. If your file contains more than one table, select the appropriate table from 
the Table list.

4. For the Field Name box, type a name for the field.

See “About naming fields” on page 81.

5. For Type, select Summary, then click Create.

6. In the Options for Summary Field dialog box, select a summary type, then 
select the name of the field you want to group by.

Select this type  
of summary

To summarize values in a field in the found set of 
records by

Total of Calculating the total of values in the field

Average of Calculating the average of values in the field

Count of Counting the number of records that contain a value for the field. 
For example, if a field contains 100 values (one value for each 
record), the result of the count is 100.

Minimum Finding the lowest number, or the earliest date, time, or timestamp 
for a field

Maximum Finding the highest number, or the latest date, time, or timestamp for 
a field

Standard Deviation of Finding how widely the values in a field differ from each other. This 
option calculates the standard deviation from the mean of the values 
in a field. (The formula is n-1 weighted, following the normal 
standard deviation.)

Fraction of Total of Calculating the ratio of the value in the field to the total of all the 
values in that field. For example, find what fraction of total sales can 
be attributed to each salesperson.
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7. Select an option, if applicable, for the summary type.

Options change according to the summary type you select in the previous 
step.

For this summary 
type Select To

Total of Running total Show the cumulative total for the 
current and all previous records. To 
restart the running total for each 
sorted group, also select Restart 
summary for each sorted group. 
Then, from the fields list, select the 
field that the sort will be restarted 
from.

Average of Weighted average. In the list 
of fields that appears, select 
the field that contains the 
weight factor

Determine the average in one field 
based on a value in another field 
that’s used as a weight factor

Count of Running count Show the cumulative count of the 
current and all previous records. To 
restart the running count for each 
sorted group, also select Restart 
summary for each sorted group. Then, 
from the fields list, select the field 
that the sort will be restarted from.

Choose a 
summary type Choose the 

field you want 
to group by

Select an 
option for the 

summary type

Select an option for summarizing repetitionsRestart the 
total or count



Using supplemental fields  |  91

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 91  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
8. Select an option, if applicable, for summarizing a repeating field.

9. Click OK.

10. Continue to define fields, or click OK. 

Note  If your FileMaker Pro file accesses data from external ODBC data sources, 
you can add supplemental fields to specify summary fields for external data. 

For more information about defining fields, see Help. 

Using supplemental fields
If your FileMaker Pro file accesses data from external ODBC data sources, you 
can use supplemental fields to display unstored calculation and summary 
results using ODBC data. Because you can’t use FileMaker Pro to change the 
schema of an external ODBC database, supplemental fields are the only fields 
you can add to external tables.

For information about how to access and work with SQL data interactively, see 
“Working with external data sources” on page 170. For information about 
using supplemental fields, see Help.

Standard Deviation of by population Calculate population standard 
deviation, where the formula is n-
weighted

Fraction of Total of Subtotaled. In the list of 
fields that appears, select a 
field to group by. (When 
you return to Browse mode, 
sort by this field to calculate 
the value correctly.)

Calculate a fraction of the total 
based only on a group of records

Select To

All together Calculate a single summary value for all repetitions in the field

Individually Calculate a summary value for each repetition

For this summary 
type Select To
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Setting options for fields
You can set field options when you define a field, or at a later time. You can set 
options for:

1 entering default data into a field

1 checking data against validation requirements

1 making a repeating field

1 creating an index

1 storing a global value

1 Furigana fields (Japanese language fields only)

Some field options help ensure the accuracy and consistency of your data. For 
example, if you type Frnc instead of France into the Country field, you won’t 
find that record when you later search for all customers from France. To be sure 
that all country names are entered correctly, you can define a value list 
containing the names, then select the Member of value list validation option for 
the Country field. When you enter data into the field, the data must match a 
value in the list.

For more information on value lists, see “Setting up checkbox sets and other 
controls on a layout” on page 118.

To set options for summary fields, see “Defining summary fields” on page 88.

Defining automatic data entry
To automatically enter a default value into a field for each record:

1. With the database open, choose File menu > Manage > Database.

2. In the Manage Database dialog box, click the Fields tab.

3. If your file contains more than one table, select the appropriate table from 
the Table list.

4. Double-click a field in the fields list.
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5. In the Options for Field dialog box, click the Auto-Enter tab and select 
options. (The available options depend on the field type.)

To Do this

Enter a date, time, 
timestamp, user name, or 
account name when the 
record is created or 
modified

Select Creation or Modification, then choose an option from the 
list.

Assign a sequential 
number to the field in each 
record

Select Serial number. Select On creation to assign the number 
when a record is created. Select On commit to assign the 
number when the record is committed. For next value, type a 
starting value (for example, 1001), then type the number to 
increment by.

Enter the value from the 
previously accessed record

Select Value from last visited record.

Enter data you specify Select Data, then type up to 255 characters. 

Enter the result of a 
calculation in the field

Select Calculated value, define the formula in the Specify 
Calculation dialog box, then click OK. For more information 
about the Specify Calculation dialog box, see “Defining 
calculation fields” on page 85.

Select Do not replace existing value of field (if any) to prevent 
overwriting data already present.

Enter a value that’s copied 
from a field in the same or 
a different table or file

Select Looked-up value, define the lookup, then click OK. See 
“Creating lookups” on page 151.

Prevent users from 
changing an automatically 
entered value

Select Prohibit modification of value during data entry. 

Turn off automatically 
entered data

Clear all selected checkboxes.
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6. Click OK to close the Options for Field dialog box, or click another tab to 
set additional field options.

Defining field validation
You can select field validation options to ensure that data is entered into the field 
correctly. FileMaker Pro displays a message if you enter data incorrectly.

Important  To avoid confusion when using dates in FileMaker Pro, set date field 
validation options to make sure dates are always entered with four-digit years.

1. With the database open, choose File menu > Manage > Database.

2. In the Manage Database dialog box, click the Fields tab.

3. If your file contains more than one table, select the appropriate table from 
the Table list.

4. Double-click a field in the fields list.

5. In the Options for Field dialog box, click the Validation tab.

6. Specify how FileMaker Pro handles an invalid entry.

For Validation options for this field, select Always for ongoing field validation, 
or Only during data entry to limit validation to instances when data is being 
entered. Deselect Allow user to override during data entry if you want to 
prevent users from entering invalid data.

Select options for 
entering default 
data in the field

Click Auto-Enter 
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7. Select validation options for the field. 

To require that the entered value Select 

Contains only numbers Strict data type, then choose Numeric Only from 
the list

Is a date containing numeric values for the 
month and day, and four digits for the year 
(for example, 5/12/2010)

Strict data type, then choose 4-Digit Year Date 
from the list

Is a time containing numeric values for 
hours and minutes between 00:00 and 
23:59 (seconds are optional)

Strict data type, then choose Time of Day from 
the list

Is not blank Not empty

Does not duplicate a value found in this 
field in other records

Unique value

Matches another value in the same field in 
any other record

Existing value

Matches a value in a specified value list Member of value list, then choose an existing 
value list or define a new one 

Is within a specific range of letters, 
numbers, dates, or times

In range, then type the beginning and ending 
values

Matches the result of a calculation Validated by calculation, then enter a calculation 
in the Specify Calculation dialog box. Select or 
clear Validate only if field has been modified. 
Then click OK.

The result must be Boolean—true or false. The 
result is true when the result is any number 
except zero; any other result (zero, no data, or 
non-numeric data) is false.

For more information about the Specify 
Calculation dialog box, see “Defining 
calculation fields” on page 85.

Does not exceed the specified number of 
characters

Maximum number of characters, then type the 
maximum number of characters allowed
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8. To display a custom message when the data doesn’t meet the validation 
requirements, select Display custom message if validation fails, then type up to 
255 characters.

9. Click OK to close the Options for Field dialog box, or click another tab to 
set additional field options.

For more information, see Help.

About storage and indexing options
FileMaker Pro provides options for indexing fields and for storing the results 
of calculations. You can:

1 Create an index, which is a list of the values stored in a field. An index greatly 
speeds searches, but takes up space on your disk. You can index text, number, 
date, time, and timestamp fields. You can also index calculation fields if the results 
are text, numbers, dates, times, or timestamps.

Select validation 
options for the field

Click Validation 
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1 Store the result of a calculation field in your database, or you can tell 
FileMaker Pro to perform the calculation only when needed (unstored). 
Storing the result is faster but takes up more space on the disk. You can 
specify storage options for text, number, date, time, timestamp, and 
calculation fields.

1 Set any field (except summary fields) to share one value across all records 
in a file if you select Use global storage in the Storage tab of the Options for 
Field dialog box. Fields defined with global storage are also referred to as 
global fields.

.

For more information about setting field options, see Help.

Defining database tables 
Use database tables to organize and group your data by a common 
characteristic or principle. Your database can contain as many tables as you 
need to organize your data.

In addition to storing data, FileMaker Pro uses tables to describe relationships 
in the relationships graph, and establish the context for layouts and some 
calculations. In FileMaker Pro, context is the starting point from which 
calculations and scripts are begun and from which a relationship is evaluated 
in the relationships graph. 

When you create a new file, FileMaker Pro automatically creates the first table 
and the first layout. The table and the layout are given the same name as the file. 

Click Storage

Select the storage 
option for the field
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You create additional tables in the Manage Database dialog box.

1. With the database open, choose File menu > Manage > Database.

2. In the Manage Database dialog box, click the Tables tab.
. 

3. In the Table Name box, type a name for the table, then click Create.

The table can be renamed or deleted. Tables you add to a file are 
automatically displayed in the relationships graph.

4. Continue to define tables, or click the Fields tab to define fields.

For information about relationships, tables, and the relationships graph, see 
chapter 4, “Working with related tables and files.”

Creating layouts and reports
FileMaker Pro layouts determine how information is organized for viewing, 
printing, reporting, finding, and entering data. Layouts don’t store your data—
they just display it. Layouts are sometimes called reports, especially when 
printed. 

You can create as many layouts as you need for a file (for example, layouts for 
entering data, reporting summaries, or printing mailing labels). You can 
change a layout’s design without affecting the data or other layouts for the file. 
Layouts can include certain fields and exclude others.When you change the 
data in a field (in Browse mode), the changes are reflected in the same field for 
the same record on all the layouts in the file.

Type a name 
for the table
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When you create a database file, FileMaker Pro automatically creates a 
Standard Form layout for the initial table, and for each newly added table that 
contains fields. 

Tab controls are a useful way of organizing data. For example, in a personnel 
database, you could create tab panels for the employee’s photo, job description, 
and financial information. To create a tab control, in Layout mode, choose 
Insert menu > Tab Control or click the Tab Control tool. For more information, 
see Help.

Fields: use for entering and 
displaying data

Layout pop-up menu

Mode pop-up menu

Parts: use headers, footers, the 
body, and summaries to divide a 
layout into special purpose areas

Buttons: use to automate frequent tasks

Layout text: use for 
titles, column 
headings, field 
labels, instructions, 
and form letters

Tab Control tool
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You create additional layouts by switching to Layout mode and using the New 
Layout/Report assistant, a wizard that guides you through creating the layout 
according to options you choose. In addition to Standard Form, there are four 
other types of layouts and one view (Table View). Use these different types for 
various purposes, like displaying a data entry screen or printing a totaled sales 
report or mailing labels. You can customize each layout by using the design 
tools that are available in Layout mode.

Important  FileMaker Pro considers the selected printer, and print or page setup 
information when it calculates margins and other measurements on the layout. 
Printer and print settings depend on the printer and system software you’re using. 
Refer to your printer and system documentation for more information. 

Note  You must create the fields to include on a layout before you begin the New 
Layout/Report assistant. See “Defining database fields” on page 80.

Click to move to another tab panel

Tab control
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To create a layout:

1. Switch to Layout mode.

2. If you intend to print the new layout in landscape orientation or on a special 
paper size, choose File menu > Print Setup (Windows) or File menu > 
Page Setup (Mac OS), confirm the orientation and paper settings, then click 
OK.

Modified Print Setup and Page Setup settings affect all other layouts in the 
current file, so you may need to change these settings later to print other 
layouts properly.

3. Choose Layouts menu > New Layout/Report.

You see the New Layout/Report assistant, a series of panels, that assist you 
with creating the type of layout you choose in the first panel. 

4. If the file has multiple tables, select the table from which you want records 
displayed in this layout and give the layout a name.

5. Follow the onscreen instructions to create the type of layout you chose in 
the first panel.

For a description of each of the layout types you can create with the 
assistant, see the next section, “About layout types.”

6. When you have completed the series of panels, click Finish.

You can use the new layout right away, or further customize it using the tools 
and commands in Layout mode. For more information, see “Working with 
objects on a layout” on page 109 and “Working with fields on a layout” on 
page 115.
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About layout types
The following sections describe each of the layouts that you can create with the 
New Layout/Report assistant.

Standard form
A Standard Form layout is a good choice for data entry or onscreen browsing. 
It contains the fields you select, each on a separate line, in the order you 
specify, with field labels to the left of the fields. In Browse mode, you see one 
record, or form, at a time (unless you switched from Form View).

Columnar list/report
Use a Columnar List/Report layout when you want to view or print multiple 
records in rows (a list of records). You can define many variations of a 
Columnar List/Report with the New Layout/Report assistant. You can create a 
layout with simple rows and columns of data or a complex report with data 
grouped by specified values with subtotals and grand totals.

A Columnar List/Report layout contains the fields you select, in the order you 
specify from left to right across the page, with field names as column headings.

Field labels Fields you defined, in 
the order they appear 
in the Clients table in 
the Manage Database 
dialog box
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In the New Layout/Report assistant, you can choose to:

1 Limit the number of fields across the layout to the width of the page 
(defined by the page margins, page orientation, and printer). Fields wrap to 
multiple lines.

1 Group records by sorting. You can then subtotal, or subsummarize, data in 
the groups (for example, group sales data by region, then group subtotal 
sales for each region).

1 Add header and footer parts with static text (like your company’s name), 
dynamic text (like the page number or current date), or a graphic (like your 
company logo).

1 Save information in a script to re-run the report (for example, switch to the 
report layout, sort the data, and pause to let you preview the report).

You can modify any of these options after you complete the assistant. 

Simple columnar report layout

Columnar report with grouped data
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Table View
Table View is not a type of layout; it’s a view of your data in a spreadsheet-like 
grid format where you can quickly rearrange fields in Browse mode. For 
example, you can quickly reorder, resize, or sort columns (fields) with just a 
mouse click (if those options are set). Table View is one of three views 
available for any layout in FileMaker Pro. For more information, see “Viewing 
records” on page 29.

As with a Columnar List/Report layout, Table View contains the fields you 
select, in the order you specify from left to right, with field names as column 
headings.

Note  Table View is similar to a simple Columnar List/Report layout, but there are 
differences. Table View is a more flexible arrangement of the data because it can 
be enabled or disabled in Browse mode. It’s useful when you want to let users make 
simple changes to how data is displayed in Browse mode, or when you want to 
provide a familiar, spreadsheet-like appearance to your data.
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Labels 
Use a Labels layout to arrange fields you select to print on one of the predefined 
standard label sizes. (FileMaker Pro includes the dimensions of a large number 
of standard label types.) If the label type you want isn’t available, you can 
specify custom label dimensions. 

With the Vertical Labels layout, Asian and full-width characters are rotated so 
that labels can be used vertically. For information about vertical writing, see 
“Formatting fields and text for vertical writing” on page 127.

 

For more information about creating a Labels layout and printing labels, see 
“Printing labels and envelopes” on page 63.
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Envelope
Use an Envelope layout to print the fields you select, arranged to print on a 
standard “Number 10” business envelope.

For more information about creating an Envelope layout and printing on 
envelopes, see “Printing labels and envelopes” on page 63.

Blank layout
Use a Blank layout as the starting point for a layout that you create entirely 
from scratch, for example, a complex data entry screen. You add the fields and 
other objects you want on the layout in Layout mode.

For more information about creating layouts and reports, see Help.

Setting up a layout to print records in columns
You can set up a layout to print (or preview) records in columns, for example, 
for a directory of names and addresses. This is in contrast to a Columnar List/
Report layout, which arranges fields in columns.

When you set up records to print in columns, all the field values (and labels, if 
specified) for one record are printed together in a block (much like on a label), 
then all the values for the next record are printed together, and so on. You only 
see multiple columns in Layout and Preview modes and when you print (not in 
Browse mode or Find mode). 
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You can choose to arrange columns across the page or down the page.

To set up columns in a layout:

1. Choose a printer and print or page setup options.

FileMaker Pro considers the selected printer, and print or page setup 
information when it calculates margins and other measurements on the 
layout.

2. In Layout mode, create a layout or choose a layout from the Layout pop-up 
menu.

It’s easiest to start with a Blank layout or a layout with no objects in the 
body part.

3. Choose Layouts menu > Layout Setup.

Down first
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4. In the Layout Setup dialog box, click the Printing tab, select Print in <value> 
columns, select options for the columns, then click OK.

5. On the layout, you see vertical lines indicating columns. 

6. Place or arrange fields and other layout objects so they are contained within 
the sample column on the left.

Use merge fields or fields or objects with sliding enabled to fit more data 
into the width of a column. With either of these two features, fields can 
extend into the gray area of the second column, and blank space in fields is 
eliminated when you view or print data. 

To Do this

Specify the number of columns For Print in <value> columns, type a number between 1 and 
99.

Arrange records to flow across 
the page first (left to right a row 
at a time)

Select Across first. 

Use this option for reports like labels, to use the fewest 
number of rows and preserve label stock.

Arrange records to flow down 
the page first (top to bottom a 
column at a time)

Select Down first.

Use this option for reports like directories, where you 
read from top to bottom, column by column.

Manually resize column 
widths by dragging 

Sample column
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To change the width of columns:

The initial width of each column is calculated based on the paper size, 
orientation, and any margins you have set. To change the width of columns, do 
one of the following:

If you change the number of columns, FileMaker Pro adjusts the width of the 
columns to fit within the width of the paper size you have defined, not 
including fixed margins. You may need to readjust fields to fit within the 
sample column.

For more information about setting up a layout to print records, see Help.

Working with objects on a layout
An object is a discrete element—a field, text, a graphic object (such as an oval 
or imported picture), a button, a portal (for displaying rows of related records), 
a tab control, or a web viewer—that you can select, move, resize, delete, copy, 
format, and otherwise change. Place objects on a layout to enhance its design. 

To Do this

Interactively 
adjust the width 
of the columns

Drag the right column boundary (the vertical dashed line at the right edge 
of the sample column). If you widen the column, you see a medium-gray 
area that indicates a “gutter” area that won’t print.

Precisely 
measure and 
adjust the width 
of the columns

Choose View menu > Object Info. Position the pointer over the right 
column boundary and hold down the mouse button (be careful not to 
drag the column width). The column width is the second-to-last field 

 in the Info palette.
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For each type of object you work with, you use specific tools from the status 
toolbar.

Note  If you don’t see the status toolbar at the top of the document window, the 
status toolbar might be hidden. Make sure you’re in Layout mode, then click the 
status toolbar control button   at the bottom-left corner of the document window 
(or choose View menu > Status Toolbar).

Using the Info palette with objects
You can use the Info palette to precisely position or size layout objects or you 
can set objects to automatically resize or move horizontally or vertically when 
the FileMaker Pro window is resized. Horizontal settings also apply to Preview 
mode and printing when the page size is wider than the size of the layout being 
viewed or printed. 

When layout objects are set to resize, they maintain a constant distance from 
the object to which they are anchored. This allows objects to move, expand, or 
contract when the FileMaker Pro window is resized.

Anchor points are either the layout margin or the container margin in which an 
object resides. By default, objects are anchored on both the top and left side of 
the layout or page.

Align palette

Status toolbar in Layout mode

Arrange palette
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The Info palette floats above document windows, so you can leave it open as 
you work.

Precisely positioning or sizing objects
To precisely position and size objects with the Info palette:

1. In Layout mode, choose View menu > Object Info.

2. Select one or more objects on the layout. 

The Info palette fields are updated to show the exact location of the selected 
objects in the layout.

Tip   You can change the unit of measure used in the Info palette and graphic rulers 
by clicking the unit label for any field in the Info palette or by clicking the unit label 
in the top left corner where the graphic rulers meet.

Enter a name for 
the object (optional)

Enter position settings for the 
selected object

Anchor the object to the top, 
bottom, left, or right side of the 
window (in Browse or Find mode) 
or the left or right (Preview mode 
or when printing)

Click to change the unit of 
measure in the Info palette and 
graphic rulers (if visible)
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3. In the Info palette, type a new value in one of the following fields.

If you can't type a value, that field doesn't make sense for the selected object 
(for example, a horizontal line doesn't have a height), or the selection is 
locked.

4. Press Enter, Return, or Tab, or close or click outside the Info palette to 
apply the change.

Note  To precisely position an object while dragging it, note the values in the Info 
palette. The values dynamically update to reflect the position as you move an object 
around the layout.

Allowing objects to resize or move on the layout
When layout objects are set to resize, they maintain a constant distance from 
the object to which they are anchored. This allows objects to move, expand, or 
contract when the FileMaker Pro window is resized.

Anchor points are either the layout margin or the container margin in which an 
object resides. By default, objects are anchored on both the top and left side of 
the layout or page.

Field Indicates

Object Name The name of the selected object (optional). You can assign names to 
objects and grouped objects. Some script steps and functions use these 
names to specify which object to act upon. For more information, see 
Help.

The distance from the left edge of the selection to the left edge of the 
layout

The distance from the top of the selection to the top of the layout

The distance from the right edge of the selection to the left edge of the 
layout

The distance from the bottom of the selection to the top of the layout

The object's width

The object's height
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To allow objects to resize or move when the FileMaker Pro window is resized:

1. In Layout mode, choose View menu > Object Info.

2. Select one or more objects on the layout. 

3. In the Info palette, select the  that indicates the side of the object that 
you want anchored to the layout or container. 

For example, to allow an object to maintain its horizontal position on the 
layout and expand the right when the window is made wider, leave the 
default left and top anchors selected and select the right anchor.

Auto-resize setting changes take effect as soon as you specify anchor 
selections.

Objects located in containers on layouts (such as fields located in tab panels or 
portals) do not inherit resize settings from their container. For example, if you 
want fields on a tab panel to resize with the tab panel, you must specify resize 
settings for the tab panel and fields located in it. If the FileMaker Pro window 
is made smaller than the size of the original layout, objects set to resize are not 
reduced beyond their original size.

Important  Multiple objects positioned side-by-side or stacked vertically and 
anchored to both left and right margins or both top and bottom margins move or 
resize relative to the window or container margin, not each other. Therefore, 
adjacent objects will not maintain a relative distance from one another and may 
overlap when the window is resized.

For more information about setting objects to resize, see Help.

Select the right 
anchor
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Selecting objects
To work with an object on a layout, select it in Layout mode. You see small 
black squares, or handles, at the corners of the selected object.

To select an object, click the selection tool  in the status toolbar. The 
pointer becomes an arrow pointer. Then do one of the following:

Note  If an object’s selection handles are gray instead of black, the object is locked.

To select In Layout mode, do this

One object With the arrow pointer, click the object. (If the object is transparent, 
click its border.)

Several objects at 
once

Drag the arrow pointer to make a selection box that completely 
surrounds the objects. (If you press Ctrl (Windows) or 2 (Mac OS) 
while dragging, the selection box does not have to completely 
surround the objects.) 

Or, press Shift as you click each object individually. 

All objects on the 
layout

Choose Edit menu > Select All.

All objects of the 
same type (for 
example, all text 
objects or all 
rectangles) 

Choose View menu > Arrange Palette to show the Arrange palette. 
Select an object, then click the Select Objects by Type button in the 
Arrange palette.

Or, click the tool for the type of object to select, then choose Edit 
menu > Select All. (This method does not work for buttons, fields, 
and portals.)

All fields With the arrow pointer, click a field, press Shift (Windows) or 
Option (Mac OS), and choose Edit menu > Select All (Windows) or 
Select Same (Mac OS). 

Or, select a field, then click the Select Objects by Type button in the 
Arrange palette.

A portal With the arrow pointer, click the border of the portal, or any other 
area within the portal that doesn’t contain a field or object.

Handles appear at the 
corners of a selected object
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For more information about working with objects on a layout, see Help.

Working with fields on a layout
After you create a layout, you can place fields on it, remove fields you don’t 
want displayed, determine control settings for data entered in fields, and 
determine the format in which you want data displayed. 

Fields on a layout are objects, which you can select, move, resize, and reshape. 
In Layout mode, each field displays its field name, formatted with its attributes 
for font, size, style, alignment, line spacing, and color. All fields except 
container fields display text baselines to indicate where the data appears in 
Browse mode and to help you align fields with each other.

Tab controls, tab 
panels, and objects in 
tab panels

See Help for information on creating and working with tab controls.

Deselect selected 
objects

Click a blank area of the layout or any tool in the status toolbar. 

Or, press Shift and click selected objects.

To select In Layout mode, do this

Fields display 
field names Text baselineField label
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Keep these points in mind:

1 A field that doesn’t appear on a layout still exists in the database, and its 
data can be used in calculations and summaries.

1 To set the default formatting, appearance, and behavior of a field, choose 
options with no fields selected. FileMaker Pro applies these defaults to all 
fields added later. See “Formatting field data on a layout” on page 121, 
“Allowing or preventing entry into fields” on page 127, and Help. You can 
also specify options individually for each field. 

Note  Options that are set in the Field/Control Setup dialog box cannot be defined 
as defaults.

Placing and removing fields on a layout
You can place a field anywhere on any layout, as many times as you want. (You 
can place only fields that you’ve defined. See “Defining database fields” on 
page 80.)

You get different results by placing the same field in different locations on the 
layout. For example:

1 Add the same summary field to a subsummary part to calculate totals for 
each group of sorted records, and to a grand summary part to get totals for 
all the records in a table.

1 Add a field to the header or footer part to repeat data from the first record 
or the last record on the page as a header or footer. (For example, add a Last 
Name field to the header in a directory.)

1 Add the same related field directly on a layout to see the field’s value in the 
first related record, or inside a portal to see values from more than one 
related record. (A portal is a layout object that displays records from related 
tables.)

To place a field on a layout: 

1. In Layout mode, choose the layout you want to work on from the Layout 
pop-up menu.
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2. Click the Field tool. (Or choose Insert menu > Field.) Then position the 
cursor where you want the field on the layout.

Holding down the mouse button, draw the field on the layout. You see a 
border and text baselines to help you align the field with other objects on 
the layout. Release the mouse button when the field is where you want it. 

 

Alternatively, if you want to display field data in a drop-down list, pop-up 
menu, checkbox set, radio button set, or drop-down calendar, use the Field/
Control tool (or choose Insert menu > Field/Control). See the next section, 
“Setting up checkbox sets and other controls on a layout,” for more 
information.

Note  If you’re placing a related field in a portal, position it in the first row of the 
portal. Make sure each field in the portal is from the same related table from which 
the portal is set up to display records. 

3. In the Specify Field dialog box, select the field to place.

Field tool
The field’s border and baselines 
appear as you drag the fields onto 
the layout

Field/Control tool

Select the 
field to add

Select to use the field 
name as the field label 

To place a field from 
another table, 

choose the table
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To choose a field in another table, choose the table from the table list above 
the list of fields. Then select a field from the fields list. Or choose Manage 
Database in the table list to create a relationship or table (see “Creating 
relationships” on page 145). 

4. To include the field name as text on the layout, select Create label.

5. Click OK.

You see the field name in the field on the layout unless you have chosen to 
display sample data from the current record (by choosing View menu > 
Show > Sample Data). Fields from related tables appear as ::Field Name 
(preceded by two colons).

To replace a field with another, in Layout mode, double-click the field, then 
select another field name in the Specify Field dialog box and click OK. 

To remove a field from a layout, in Layout mode, click the field to select it, then 
press Backspace or Delete, or choose Edit menu > Clear. Removing a field from 
a layout does not delete the field or its data from your database. 

Setting up checkbox sets and other controls on a layout
You can format fields to display as drop-down lists, pop-up menus, 
checkboxes, radio buttons, and drop-down calendars. You can also format 
fields to auto-complete by suggesting possible matches as the user types data 
in the field. All of these options aid in data entry.

To set up a field to display a pop-up menu, checkbox set, or other control:

1. In Layout mode, double-click the field (or select the field and choose Format 
menu > Field/Control > Setup).

1 If the field isn’t already on the layout, click the Field/Control tool and 
drag the crosshair pointer to add a field object to the layout. Then, in the 
Field/Control Setup dialog box, specify the field you want in the Display 
data from area.

1 If the field hasn’t been defined yet, choose File menu > Manage 
Database to define a new field.
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2. In the Control Style area of the Field/Control Setup dialog box, for Display 
as, choose:

1 Edit Box

1 Drop-down List

1 Pop-up Menu

1 Checkbox Set

1 Radio Button Set

1 Drop-down Calendar

For example, use a radio button set to display a value list of frequently used 
text, number, date, or time values. During data entry, users can choose from 
the defined values rather than type the values.

When you choose different control styles, the dialog box changes to display 
different options.

Choose the 
control 

style for 
your field

Choose the 
data to 
display

Value list attached to Country field

Choose from a list of values 
during data entry

 Country
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3. Choose options for the control style.

For example, for Display values from, choose an existing value list or choose 
Manage Value Lists.

4. To set up fields to suggest possible matches as the user types data in the 
field, select Auto-complete using value list. or Auto-complete using previously 
entered values. 

Note   Auto-complete only works with text fields.

5. Click OK.

For more information on defining value lists and using auto-complete, see 
Help.

Deciding where to place related fields 
You can place related fields directly on layouts or in portals.

1 Directly on layouts: Place related fields directly on a layout to display data 
from the first related record, even when there are more than one related 
records that matches the criteria of the relationship. (The first related record 
that’s displayed is determined by whether the relationship specifies a sort 
order. For more information, see “Creating relationships” on page 145.) 

1 In portals: Place related fields within a portal on a layout to display data 
from all related records that match the criteria of the relationship. For 
examples of when to place related fields in portals, see Help.

Note  Before placing related fields on a layout, you should understand the concepts 
presented in chapter 4, “Working with related tables and files.”

About merge fields
Use merge fields to combine field data and text in documents like form letters, 
labels, envelopes, or contracts. You create merge fields in text blocks, which 
allows you to use static text and field data together.
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Merge fields shrink or expand to fit the amount of text in the field for each 
record. For example:

1 When the merge field <<First Name>> is between the text Dear and a 
colon, (as in Dear <<First Name>>:), FileMaker Pro displays Dear Charles: in 
Browse mode or Preview mode if the First Name field contains Charles.

1 When a merge field is on a line by itself (such as an empty Address Line 2 
field in a mailing label), FileMaker Pro removes the blank line from the text 
block. 

FileMaker Pro uses merge fields to create Labels and Envelope layouts. 

Formatting field data on a layout
Use FileMaker Pro field formats to control how data appears on a layout. The 
formats you specify don’t change the data as it’s stored in the database, and you 
can specify different formats each time you place a field on a layout (whether 
it’s on the same layout or a different layout). For example, if you enter –5123 
into a number field, you can format it in one place to display as –$5,123.00 and 
in another place as <5123>.

FileMaker Pro applies field formatting in the following precedence: 

1 If you don’t specify formats, FileMaker Pro displays numbers, dates, and 
times based on the system formats set in the Regional and Language 
Options control panel (Windows) or the International pane in the System 
Preferences (Mac OS) when the file was created. 

1 In FileMaker Pro, you can specify display formats for text, number, date, 
time, timestamp, or container fields with no objects selected. FileMaker Pro 
applies these default formats to fields you place on layouts later. For 
number, date, time, and timestamp fields, these display formats override the 
system formats. 
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Specifying text formats for fields
In Layout mode, you can specify a set of text character attributes for each field. 
All the characters in that instance of the field (including all repetitions of 
repeating fields) share the same font, size, style, color, line spacing, tab, and 
paragraph settings. 

Note  You can also format characters in text fields in Browse mode (for example, 
italicize or underline a word for emphasis). Unlike text formatting specified in 
Layout mode, this formatting is stored with the data, and you see it in any layout 
that displays that field. 

1. In Layout mode, select one or more fields, then choose Format menu > Text. 

Or, to set text formats for fields you place later, start with no fields selected.

2. In the Text Format dialog box, select the formats you want to use.

You see examples of the options you choose in the Sample area.

Specifying formats for fields containing numbers
You can control how FileMaker Pro displays the values in number fields, 
calculation fields with numeric results, and summary fields.

1. In Layout mode, select one or more fields that display numeric values.

2. Choose Format menu > Number.

3. In the Number Format dialog box, select the formats you want to use. 

You see examples of the options you choose in the Sample area.

Choose text 
attributes 

Select one or 
more styles



Working with fields on a layout  |  123

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 123  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
4. Click OK. 

Specifying formats for date fields
You can control how FileMaker Pro displays the values in date fields, and 
calculation fields with date results. 

Note  To avoid confusion when using dates in fields, FileMaker recommends that 
you always format date fields to display four-digit years.

1. In Layout mode, select one or more date fields or calculation fields with a 
date result.

2. Choose Format menu > Date.

3. In the Date Format dialog box, select the formats you want to use.

You see examples of the options you choose in the Sample area.

Set options 
for negative 
values

Specify font, style, 
size, line spacing, 
alignment, and color

Choose options 
for Boolean or 

decimal 
numbers and 

currency

Set options for 
displaying 

different 
Japanese 

numeral types

Define the symbols for 
thousands, decimal, and 
Kanji separators
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4. Click OK. 

Specifying formats for time fields
You can control how FileMaker Pro displays time values in fields.

1. In Layout mode, select one or more time fields, or calculation fields with a 
time result.

2. Choose Format menu > Time.

3. In the Time Format dialog box, select the formats you want to use.

You see examples of the options you choose in the Sample area. 

4. Click OK. 

If you want to format the seconds component to display fractional seconds, 
continue with the next step.

5. Choose Format menu > Number.

Set font, style, size, 
color, line spacing, 

and alignment

Choose 
options for 
day, month, 
date, year, 
and 
separator 
characters

Choose to display 
numbers as 

entered, in a 
predetermined 
format, or in a 

format you specify

Choose options for 
displaying 

Japanese dates
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6. In the Number Format dialog box, select the formats you want to use.

Only two options affect the display of the seconds component: Fixed 
number of decimal digits and Decimal separator. The remaining options have 
no effect.

7. Click OK.
 

8. Click OK. 

Specifying formats for timestamp fields
You can control how FileMaker Pro displays timestamp values in fields. You 
format a timestamp field by separately formatting its three components: date, 
time (excluding the seconds portion), and seconds (including fractional 
seconds).

1. In Layout mode, select one or more timestamp fields, or calculation fields 
with a timestamp result.

2. To format the date component, choose Format menu > Date.

3. In the Date Format dialog box, select the formats you want to use and click 
OK.

4. To format the time component (except the seconds portion), choose Format 
menu > Time.

Set font, style, size, color, 
line spacing, and alignment

Choose to display times as 
entered, in a predetermined 

format, or in a format you 
specify

Choose options for 
displaying Japanese times
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5. In the Time Format dialog box, select the formats you want to use and click 
OK.

6. To format the seconds and fractional seconds component, choose Format 
menu > Number.

7. In the Number Format dialog box, select the formats you want to use and 
click OK. 

Only two options affect the display of the seconds component: Fixed 
number of decimal digits and Decimal separator. The remaining options have 
no effect.

You see examples of the options you choose in the Sample area. 

Specifying formats for container fields
You can control how FileMaker Pro displays images and file icons in container 
fields.

Note  The following instructions also apply to formatting graphic objects that you 
insert onto a layout.

1. In Layout mode, select one or more container fields or inserted graphics.

2. Choose Format menu > Graphic.

3. In the Graphic Format dialog box, select the formats you want to use.

You see examples of the options you choose in the Sample area. File icons 
do not scale.

  

4. Click OK.

Choose how to 
align the graphic 
vertically

Choose how to fit the 
graphic in the frame

Choose how to align the 
graphic horizontally
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Formatting fields and text for vertical writing
If your operating system is configured to support Japanese text entry, you can 
format field objects and text objects that display Japanese text in vertical 
writing format. In vertical writing, characters are displayed and read from top 
to bottom, with successive columns displayed vertically from right to left. This 
is useful when printing addresses on labels. 

When you select one or more fields, then choose Format menu > Orientation > 
Sideways (Asian text only), the characters are rotated 90 degrees counter-
clockwise within the field. The field itself is not rotated. To rotate the selected 
fields, choose Arrange menu > Rotate.

Depending on how you want the text to print, you may want to change the page 
orientation of the layout. To do so, choose File menu > Print Setup (Windows) 
or Page Setup (Mac OS), and change the page orientation to Landscape or 
Portrait. 

Allowing or preventing entry into fields
You can allow or prevent entry into a field. For example, you can restrict entry 
into a field containing a serialized number, so the field can’t be modified. You 
can set separate Browse mode and Find mode data entry options, which would 
allow you to permit finding serialized numbers even though they can’t be 
entered. 

If you allow entry into a field, you can also control whether the entire contents 
of the field is selected when you click or tab into the field in Browse mode or 
Find mode. Otherwise, FileMaker Pro places the insertion point after the last 
character in the field.

1. In Layout mode, select one or more fields.

2. Choose Format menu > Field/Control > Behavior.
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3. In the Field Behavior dialog box, select the options you want to use.

4. Click OK. 

For more information about working with fields on a layout, see Help.

Working with parts on a layout
FileMaker Pro layouts are divided into layout parts, sections of the layout that 
determine how data in a field is treated and displayed. By using parts, you can 
control how FileMaker Pro prints data, for example:

1 once for each record

1 only at the top of each page

1 only before or after groups of sorted records (for example, to include a 
subtotal for each group of records)

Each layout must have at least one part. Layout parts can contain fields, portals, 
buttons, text, and other objects. In Layout mode, dotted horizontal lines mark 
the division between layout parts, and the part label appears at the left end of 
the bottom dividing line.

To Do this

Prevent entry into a field in Browse 
mode, in Find mode, or in both modes

For Allow field to be entered, clear In Browse mode, 
In Find mode, or both options.

Select the entire field’s contents when 
the field is entered

Select entire contents of field on entry. (Allow field to 
be entered must also be selected.)

Specify a text input mode for a field 
that uses a Japanese input method.

Note   This option is available if your 
operating system is configured to 
support Japanese text entry. 

Select Set input method to, then select an input 
mode from the list. 

Control how you move to the next field 
using the keyboard

Select Tab key, Return key, Enter key, or any 
combination of the options.
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The New Layout/Report assistant automatically creates the appropriate layout 
parts depending on the choices you make. You can add, change, or delete 
layout parts after you finish the assistant as needed. (See “Creating layouts and 
reports” on page 98.)

Body 
Header 

Subsummary 
Trailing 

Grand 
Summary

Footer 
Sales Report

A subsummary below the body
summarizes data for each group of 

records sorted on the break field 
(Agent Name)

Trailing grand summary 

Footer 

Agent Name Product ID Qty Amount

David Michaels ET3 1 $29.95
David Michaels ET4 1 $32.25
David Michaels ET1 2 $73.90
David Michaels ET5 3 $98.85

Total $234.95

Sophie Tang ET6 2 $64.50
Sophie Tang ET7 5 $12.50
Sophie Tang ET2 2 $25.00

Total $102.00

Grand Total $336.95

EveryWhere Travel Confidential       June 2009
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About layout part types 
The following table describes layout part types.

To include summary data on a layout (for example, subtotals, grand totals, 
averages, counts, and so on), you place summary fields in summary layout 
parts (see “Defining summary fields” on page 88). Summary parts include 
grand summary and subsummary parts. 

1 A grand summary part usually contains one or more summary fields that 
display summary information (like totals) about all records being browsed.

1 A subsummary part usually contains one or more summary fields that 
display “subsummary” information (like subtotals) for a subset of records. 
The records are grouped (sorted) by values in another field, the break field. 
Whenever the value of the break field changes, the report “breaks” and 
FileMaker Pro inserts the subsummary part. Subsummary parts appear in 
Table View and List View when sorted by break fields, and update 
dynamically whenever data in the file is changed.

For more information about working with layout parts, see Help.

Layout 
part Description

Title header Appears only once at the top of the first screen or page and replaces the 
normal header (if one is specified). In reports, can be used to print a separate 
title page. You can have only one title header in a layout.

Header Appears at the top of every screen or page (unless you add a title header, 
which supersedes the header on the first page). Use for titles or column 
headings (in columnar reports). You can have only one header in a layout.

Body Each object you put in the body, including fields, text objects, and graphics, 
appears once for each record in the found set. You can have only one body 
in a layout.

Footer Appears at the bottom of every screen or page (unless you add a title footer). 
You can have only one footer in a layout.

Title footer Appears only once at the bottom of the first screen or page and replaces the 
normal footer (if one is specified). You can have only one title footer in a 
layout.
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Chapter 4
Working with related 

tables and files

This chapter explains the basics of how to:

1 plan a relational database

1 create and edit relationships

1 create and edit lookups

FileMaker Pro uses related tables as the basis for relational databases and 
lookups. Relational databases allow you to work with data from other tables 
dynamically, so that you can change data in one place and your changes are 
reflected in all places where the related data appears. Lookups let you copy and 
paste data from one table to another; once looked-up data has been inserted, it 
does not change unless you edit it or tell FileMaker Pro to look it up again.

Use relational databases to:

1 See and work with data from another (or the current) table in its most up-
to-date state. For example, display data in related fields when you need 
current data from a related table, such as the current price of an item. As 
data changes in the related records, you see those changes in the current 
table.

1 Set up and manage data efficiently and with flexibility. Instead of creating 
many database tables or files with duplicate values, you store single 
occurrences of values and use relationships to make those values available. 
You can then make changes to data in only one place, which eliminates data 
duplication and promotes data accuracy. 

1 Save disk space, because data is stored in only one place.
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Use lookups to:

1 Copy data from a related table and keep it as copied, even when the related 
data changes. For example, use a lookup to copy the price of an item at the 
time of purchase into an Invoices table. Even if the price in the related table 
changes, the price in the Invoices table stays the same.

FileMaker Pro can also access data stored in other FileMaker Pro files and 
external ODBC data sources, which allows you to combine data stored in your 
FileMaker Pro file with data from these external sources. You can work with 
data in SQL databases that share information through ODBC. You can also use 
supplemental fields in FileMaker Pro to perform calculation and summary 
operations on data stored in ODBC data sources. For more information about 
using FileMaker Pro with external data sources, see “Working with external 
data sources” on page 170.

Note  See Help for detailed, comprehensive information and step-by-step 
procedures about using FileMaker Pro. 

About relationships
A relationship is a powerful method for organizing your data. Using a 
relationship, you can join data in one or more tables based on common field 
values, different field values, or a comparison of values in two or more fields.

After you create a relationship, you can do either of the following to display 
the data from the related table:

1 Design a relational database, which is one or more tables that, when used 
together, contain all the data you need for your work. Each occurrence of 
data is stored in only one table at a time, but can be accessed and displayed 
from any related table. You can change any occurrence of your related data, 
and the changes appear in all places where that related data is used.

1 Define a lookup to copy data from a related table into a field in the target 
table. The copied data is now stored in two places, just as if it were copied 
and pasted into a target field. Looked up data is current at the time it is 
copied, but once copied it remains static unless it is re-looked up or the 
lookup is triggered again.
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For example, a database for a travel agency might have these tables: a Tours 
table, which stores the products (tours) and their current prices; a Clients table, 
which stores client information; an Invoices table, which keeps a record of each 
invoice; and a LineItems tables, which stores sales data for each line of the 
invoice, including the tour being sold and the price at which it is sold. Because 
invoices are a mix of dynamic and static data, you use both relational databases 
and lookups to display your data. Records from the LineItems table are 
displayed dynamically, in a portal on the Invoices layout, but the actual sales 
price of each line item is entered using a lookup, so the invoice totals remain 
historically accurate, even if prices change at some future date.

Lookups copy data from the related table into the current table

R20Client ID

NY-ParisRoute

R20Client ID

NY-ParisRoute

In relational databases, data from the related table is only 
displayed in the current table, not copied

R20Client ID

NY-ParisRoute

R20Client ID

NY-ParisRoute

Current table Related table

Current table Related table
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You create a relational database by defining a relationship between two fields, 
called match fields. These fields can be in different tables or they can be in the 
same table (a self-join). You are able to access related data when the value in 
the match field(s) on one side of the relationship compares successfully with a 
value in the match field(s) on the other side of the relationship, according to the 
criteria you establish in the relationship.

After you have created a relationship, you can use fields from the related table 
just as you would use any fields in the current table: to display data on a layout, 
as part of a calculation formula, in a script, as a match field for another 
relationship, and so on. You can work with the data in the related fields in all 
modes (if you have access privileges) when you work with records in the 
current table.

When you display related data in a portal, values from all related records are 
displayed. When the related field isn’t in a portal, the value from the first 
related record is displayed.

Invoices table

A-200-61Invoice No

16-Oct-2010Date

C100Client ID

Tour
ID Tour Name
T10

Cost $
NY-Roma 550.00

T20 Roma-Istan 700.00

WilliamsName

1,250.00TotalClients table

C100Client ID

WilliamsClient Name

408-555-3456Phone

Tour ID Tour Name
T10 NY-Roma
T20 Roma-Istan

Tours table

T10Tour ID

NY-RomaTour Name

Route
ID Origin
R200

Destination
NY Paris

R42 Paris Roma

Records from the 
LineItems table 

displayed in a portal
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For more information about relationships, see Help.

Relational database terminology
Before you begin working with relational databases and lookups, you should 
understand the following terms. These terms are explained in the sections that 
follow. 

Term Description

Current table For relational databases, the table that you are currently working in.

For lookups, the table that the data is copied to.

External table A table outside of the current file, in another file.

Lookup target 
field (for lookups 
only) 

The field in a table that you want data copied to during a lookup.

Lookup source 
field (for lookups 
only) 

The field in the related table that contains the data you want copied 
during a lookup.

Match field A field in the current table and a field in a related table that each 
contains values used to access matching records. (A match field is 
sometimes called a key field.) For each relationship, you select one or 
more match fields in each table.

For relational databases, values in match fields must match each other 
in some way for a relationship to be established between the files. See 
“About match fields for relationships” on page 137.

For lookups, values in match fields do not have to be equal to match.

Portal A layout object that displays records from related tables. Portals display 
data from related fields in rows, one record in each row. 

Related field A field in one table that is related to a field in another table (or to a 
different field within the same table). If a relationship has been created 
between two tables (even through another table), data in fields in one 
table can be accessed from the other table.

Related record A record in the related table whose match field (according to the 
relationship used) contains a value that matches the value in the match 
field of another table.
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About the relationships graph
When you work with tables in the relationships graph, you organize your view 
of your data. Tables shown in the relationships graph can be located in the 
current FileMaker Pro file, in an external FileMaker Pro file, or in an external 
ODBC data source.

Related table For relational databases, the table that contains the data you want to 
access and work with in the current table.

For lookups, the table that contains the data to copy.

A table can be related to itself. This is called a self-join.

Relational 
operators

In the relationships graph, the symbols that define the match criteria 
between one or more pairs of fields in two tables. These include: equal 
(=), not equal (≠), greater than (>), greater than or equal to (≥), less than 
(<), less than or equal to (≤), and all rows, or cartesian product (X).

Relationship Relationships provide access to data from one table to another. 
Relationships can join one record in one table to one record in another 
table, one record to many other records, or all records in one table to all 
records in another table, depending on the criteria you specify when you 
create the relationship in the relationships graph. (A relationship is 
sometimes called a link or a join expression.)

Relationships 
graph

In the Relationships tab of the Manage Database dialog box, you can 
see the occurrences of tables both in the current file and from any 
external, related database files. In this relationships graph, you join 
tables and change relationships between fields in different tables.

When you create a new table, a visual representation, or occurrence, of 
the table appears in the relationships graph. You can specify multiple 
occurrences (with unique names) of the same table in order to work 
with complex relationships in the graph.

Source file The file from which you add a table to the relationships graph.

Source table The table upon which one or more tables in the relationships graph are 
based. The source table is the table defined in the Tables tab of the 
Manage Database dialog box.

Term Description
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Each table occurrence in the relationships graph represents a separate view into 
your data. When you join two tables, you are leveraging the two existing views 
to create a third view. As you add tables to your relationships, each successive 
table represents an additional set of criteria that must be met before related data 
can be accessed in that relationship.

You can create a relationship between any two tables in the relationships graph, 
but the relationship must not create a cycle, or closed loop between tables. That 
is, each series of relationships must have a starting table and an ending table, 
and those tables must be different tables.

Because each relationship represents an additional set of criteria, you must be 
aware of your context within the relationships graph. Context is the point in the 
graph from which a relationship is evaluated. Because the graph is never a 
cycle, each point along the graph offers a different perspective into your data.

Because FileMaker Pro does not permit you to create cycles within the 
relationships graph, any attempt to create a cycle causes FileMaker Pro to 
generate a new, uniquely named table occurrence. A new occurrence functions 
like any other occurrence in the graph and allows you to continue with your 
new relationship.

For more information about the relationships graph, see Help.

About match fields for relationships
When you create a relationship between tables, you choose one or more fields 
in each table as match fields. Match fields usually have common values. In a 
typical relationship, a record in one table will be related to records in another 
table that share a common match field value. 

For example, a Customers table and an Invoices table can each use the field 
Client ID to uniquely identify each customer and purchase. If the two tables are 
related using Client ID as the match field, a record in the Customers table can 
display a portal showing each invoice with a matching Client ID, and in the 
Invoices table, each invoice with the same Client ID can display consistent 
customer data.

The match fields used in a relationship can have different names. Match fields 
can be any field type except container or summary. 
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Types of relationships
When you join two tables using a relationship, you establish criteria that 
FileMaker Pro uses to display or access related records.

Your criteria can be simple, such as matching a field in Table A with a field in 
Table B, or more complex. A more complex relationship definition will usually 
return a narrower set of related records. Examples of complex relationships 
include using multiple match fields on one or both sides of the relationship, 
comparing match fields using non-equal relational operators, or using 
calculated match fields.

Single-criteria relationships
In a single-criteria relationship, data in one field is matched to data in another 
field.

For example, a record in either table is related to any record in the other table 
when the values in the Client ID field in the Clients table and the Client ID field 
in the Phone Numbers table are the same.

Use a single-criteria relationship when you want to relate two tables based on 
a single common value, such as a serial number or an ID number. For example, 
a clients database has two tables: Clients, which stores names and addresses, 
and Phone Numbers, which stores phone numbers and types of phone 
numbers, such as work, home, fax, and so on. The data is split between two 
tables because a single client can have multiple phone numbers.

Match field Match field
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The tables have the following fields:

The Client ID field is the match field in the relationship between the two tables. 
In the Clients table, the Client ID field is set to automatically enter a serial 
number, giving each record in the Clients table a unique ID number. In the 
Phone Numbers table, the Client ID is just a simple number field.

Because the relationship is defined to allow the creation of related records in 
the Phone Numbers table, the Client ID number from a Clients record will be 
automatically inserted in the Client ID field in the Phone Numbers table in each 
new related record. This allows many records in the Phone Numbers table to 
be related to a single record in the Clients table. 

Users will be able to enter a phone number in an empty portal row, and 
FileMaker Pro will automatically create a related record for that phone number.

Table Field name Comment

Clients Client ID Number field, auto-enter serial number. 
Match field for the Clients table

First Name Text field

Last Name Text field

Address1 Text field

Address2 Text field

City Text field

State Text field

Phone Numbers Phone Number Text field

Phone Number Type Text field

Client ID Number field. Match field for the 
Phone Numbers table
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Multi-criteria relationships
In a multi-criteria relationship, you increase the number of match fields, which 
increases the criteria that FileMaker Pro evaluates before successfully joining 
related records. In a multi-criteria relationship, FileMaker Pro compares the 
values from each match field on each side of the relationship in the order in 
which the fields appear. This is known as an AND comparison; to match 
successfully, every match field must find a corresponding value in the other 
table.

Use a multi-criteria relationship when you want to relate two tables based on 
more than one common value, such as a client ID and a date. 

In this relationship, both Client ID and Rental Date are match fields to the 
Rental Line Items table. A record in the Clients table with a Client ID value of 
1000 and a Rental Date value of 10/10/2010 will only match those records in 
the Rental Line Items table where both fields Client ID and Rental Date have 
values of 1000 and 10/10/2010, respectively. If Client ID fields in both tables 
have matching values, but Rental Date fields in both tables do not, no related 
records are returned by the relationship.

For example, a travel equipment rental database has three tables: Equipment, a 
static table that stores equipment rental inventory; Clients, which stores client 
names and addresses; and Rental Line Items, which stores a record of each 
equipment rental, including the equipment ID, the client ID, and the rental 
date. The purpose of this database is to track equipment rentals and display all 
rentals by a selected client on a selected date.

Match fieldsMatch fields
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Although the database uses three tables, the multi-criteria relationship is 
between the Clients and Rental Line Items tables. These tables have the 
following fields:

Because the relationship is defined to allow the creation of related records in 
the Rental Line Items table, users will be able to enter rental information in an 
empty portal row, and FileMaker Pro will automatically create a related record 
for that rental.

Table Field name Comment

Clients Client ID Number field, auto-enter serial number. One of 
the match fields to the Rental Line Items table

Rental Date Date field. The other match field to the Rental 
Line Items table

Rental Line Items Client ID Number field. One of the match fields to the 
Clients table

Rental Date Date field. The other match field to the Clients 
table

Equipment ID Number field

Select to allow creation of related 
records in Rental Line Items table
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Relationships using comparative operators
In a comparative relationship, you use one or more of the following operators 
to compare match field values in the two related tables. The relationship returns 
related records when the comparison evaluates successfully, according to the 
criteria you establish. 

In this example, the Tour Date fields in the Tours table and the Clients table are 
match fields. If a record in the Tours table has a Tour Date value of 12/11/2010, 
all the records in the Clients table with a Tour Date value of 12/10/2010 or 
earlier are related to it. In the Clients table, if a record has a Tour Date value of 
12/11/2010, all records in the Tours table with Tour Date values of 12/12/2010 
or later are related to it.

Relational 
operator Matches these records

= Values in match fields are equal

≠ Values in match fields are unequal

< Values in the left match field are less than values in the right match field

≤ Values in the left match field are less than or equal to values in the right match 
field

> Values in the left match field are greater than values in the right match field

≥ Values in the left match field are greater than or equal to values in the right match 
field

x All records in the left table are matched to all records in the right table, regardless 
of the values in the match fields

Greater than relational operator

Match field Match field
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Relationships that return a range of records
A relationship that returns a range of records is similar to a multi-criteria 
relationship, except that you use comparative operators to find records that are 
greater than one of your criteria and less than your other criteria. This type of 
relationship is commonly used to return records that fall between a range of 
dates or serial numbers.

For example, from within Table E you want to view all the records in Table F 
that have Date Field F values that are greater than Starting Date E values and 
less than Ending Date E.

This relationship returns those records from Table F that have a Date Field F value 
that is later than Starting Date E and earlier than Ending Date E.

Indicates that several 
different relational operators 
are used in this relationship

Match fields Match field

This relationship uses the greater than 
and less than relational operators
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For example:

Another example:

Self-joining relationships
A self-join is a relationship in which both match fields are defined in the same 
table. Define a self-join to create relationships between records in the same table. 
Use a self-join in a portal on a layout of the current table to display a subset of 
data that is in the current table, such as all the employees of each manager.

When you define a self-joining relationship in the relationships graph, FileMaker 
Pro generates a second occurrence of the table upon which you are basing the 
self-join. FileMaker Pro does this to prevent the relationships graph from 
forming a cycle, which would make it impossible to evaluate the relationship.

This relationship returns related records in Table G when the value in Text 
Field G1 is the same as the value in Text Field G2.

For more information about the types of relationships, see Help. 

 
If fields

 
Contain values

These related records are returned 
from Table F

Starting Date E 11/01/2010 11/14/2010 
11/27/2010

Ending Date E 12/01/2010

 
If fields

 
Contain values

These related records are returned 
from Table F

Starting Date E 12/01/2010 12/02/2010 
12/15/2010 
12/17/2010 
12/26/2010

Ending Date E 01/01/2011

Self-joining relationship

Match field Match field
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Planning a relational database
For information about planning a relational database, see “Planning a 
database” on page 71.

Working with the relationships graph
Use the relationships graph to create, change, and view the relationships in 
your database file. The relationships graph lets you duplicate tables and 
relationships, resize and align tables, and add text notes. You can highlight 
tables that are connected to the selected table via a 1-away relationship, and 
you can highlight tables that have the same source table as the currently 
selected table. For more information, see Help.

By default, the relationships graph displays all of the tables in your current 
database file. You can add tables from other FileMaker Pro files or external 
ODBC data sources, add more than one occurrence of the same table to the 
graph, or remove tables from the graph using the buttons at the bottom of the 
graph.

Note  When the table is from an external ODBC data source, the name of the table 
is typeset in italics in the relationships graph. To display information about the 
external data source, move the pointer over the arrow to the left of the table name.

Creating relationships
To create a relationship:

1. With the database open, choose File menu > Manage > Database. 

2. In the Manage Database dialog box, click the Relationships tab.

3. In the relationships graph, locate the two tables you will be using for this 
relationship. 

They can appear anywhere on the graph but they must be present on the 
graph in order to create the relationship. For self-joining relationships, 
locate the single table; FileMaker Pro will create the second table 
occurrence for you.
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4. Click a field in one of the tables and drag to the corresponding match field 
in the other table.

Or, you can click  to open the Edit Relationship dialog box and create 
a relationship. 

5. Repeat step 4 for each match field you intend to use in this relationship.

For more information about match fields, see “About match fields for 
relationships” on page 137.

6. Click OK to save your changes and close the relationships graph.
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Changing relationships
After you have created a relationship, you can add or change match fields, 
change relational operators, and set options for creating, deleting, and sorting 
related records.

To change a relationship:

1. With the database open, choose File menu > Manage > Database. 

2. In the Manage Database dialog box, click the Relationships tab. 

3. In the relationships graph, locate the relationship to edit, and double-click 
the indicator line between the related tables to open the Edit Relationship 
dialog box.

Or, you can select the relationship in the graph and click  to open the Edit 
Relationship dialog box.

4. Edit tables and match fields for the relationship. 

To Do this

Change a match field Select the new match field and click Change.

Add a match field Select the new match field and click Add.

Select options for the tables 
in the relationship

Select the 
relational 
operator
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5. Select options for the relationship.

6. Click OK.

For more information about creating and editing relationships, see Help.

Change the relational 
operator

Select a new relational operator from the list and click Change.

See “Relationships using comparative operators” on page 142.

Duplicate a pair of 
relationship criteria 

Select the paired criteria from the list in the lower part of the 
dialog box and click Duplicate.

Delete a pair of 
relationship criteria

Select the paired criteria from the list in the lower part of the 
dialog box and click Delete. 

To Select

Add a related record (to the 
related table) whenever you 
enter data into a related field in a 
record of the current table. (See 
“Adding and duplicating 
records” on page 35.) 

Allow creation of related records in this table via this 
relationship. 

When this option is selected, entering data in a related 
field that has no corresponding related record creates a 
related record based on the match field in the current 
table.

Delete matching records (in the 
related table) whenever you 
delete a matching record in the 
current table. (See “Deleting 
records” on page 37.) 

Delete related records in this table when a record is deleted 
in the other table. 

This option deletes related records even when you’re 
browsing a layout that doesn’t display the related 
records.

Sort related records. Sort records. Then, in the left list in the Sort Records 
dialog box, double-click the fields to sort. To change the 
order in which fields are sorted, drag fields in the right 
list into the order you want. Select other options, then 
click OK. 

Selecting this option does not affect the sort order in the 
related file.

To Do this
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Summarizing data in portals
You can summarize data that’s in a related field displayed in a portal. The portal 
can contain records from a related table or from the same table (a self-join). 

To summarize data in portals:

1. Create a calculation field in the table in which you want the total to be 
displayed. 

2. For the calculation field, define a formula that includes an aggregate 
function for the type of summary calculation you want to perform. 

For example, if you are in the Invoices table and want to define a calculation 
to total the related values in the Price field of the LineItems table, use the 
formula:

Sum(Line Items::Price)

3. Place the calculation field on a layout of the table in which it is defined.

See “Placing and removing fields on a layout” on page 116.

For more information about summarizing data in portals, see Help. 

About lookups
A lookup copies data from another table into a field in the current table. After 
data is copied, it becomes part of the current table (and remains in the table 
from which it was copied). Data copied to the current table does not change 
automatically when the data in the other table changes, unless the data in the 
match field of the current table changes.

To establish a connection between tables for a lookup, you create a 
relationship. Then you define a lookup to copy data from a field in the related 
table into a field in the current table.

When you type a value in the match field of the current table, FileMaker Pro 
uses the relationship to access the first record in the related table whose match 
field contains a matching value. Next, it copies the value from the lookup 
source field into the lookup target field, where the value is stored. 
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After a value is copied into the lookup target field, you can edit, replace, or 
delete it like any other value (because the lookup value belongs to the current 
table). You can also update data in the current table to match data that changes 
in the related table.

Creating lookups
To create a lookup:

1. Create a relationship for the lookup between the match field of the current 
table and the match field of the related table. See “Creating relationships” 
on page 145.

2. With the database open, choose File menu > Manage > Database. 

3. In the Manage Database dialog box, click the Fields tab. 

4. If your database contains more than one table, select the appropriate table 
from the Table list.

5. Select a text, number, date, time, timestamp, or container field from the list 
of existing fields, or define a new one.

6. Click Options (or double-click the field name). 

7. In the Options for Field dialog box, click the Auto-Enter tab, then select 
Looked-up value. 

C235Client ID

Name

42.83.91.04Phone

ParisCity

C100Client ID

Name

555-3849Phone

VancouverCity

Current table

C200Client ID

SmithName

Records in related table

Relationship

Lookup target field Lookup source field

C200Client ID

SmithName

555-1234Phone

New YorkCity
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8. In the Lookup for Field dialog box, choose the table the lookup will start 
with, and the table from which the value will be copied. 

9. Select the field from which the lookup value will be copied.

10. Select options for the lookup.

11. Click OK.

12. Repeat steps 5-11 for each additional field for which you want to define a 
lookup.

Select To specify

Starting with table The table the lookup will use as its starting point in the 
relationships graph

Lookup from related table The related table from which the related data will be looked up

To Do this

Specify an action when values in 
the match fields do not match 
exactly 

For If no exact match, then, select an option to copy no 
value, copy the next lower or next higher value that’s in 
the lookup source field, or enter a fixed value to be used 
instead

Prevent null (empty) data in the 
lookup source field from being 
copied to the lookup target field 

Select Don’t copy contents if empty. (Clear this option to 
allow empty data to be copied.)

Select an option 
for non-equal 
data in match 
fields

Select the 
lookup 

source field

Select the 
lookup’s starting 
point 

When selected, prevents null data from being copied

Choose the 
related table for 
the lookup
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Editing lookups
To edit a lookup:

1. With the database open, choose File menu > Manage > Database. 

2. Click the Fields tab. 

3. If your database contains more than one table, select the appropriate table 
from the Table list.

4. Double-click the lookup target field. 

5. In the Options for Field dialog box, click the Auto-Enter tab. 

6. Be sure Looked-up value is selected and click Specify.

To stop or suspend using a lookup, clear Looked-up value.

7. Make your changes.

8. Click OK.

For more information about creating and editing lookups, see Help.
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Chapter 5
Sharing and exchanging data

This chapter explains the basics of how you can share FileMaker Pro 
databases:

1 FileMaker Network Sharing: You can share FileMaker Pro databases on 
your network, which allows multiple FileMaker Pro users to access and use 
the same database file simultaneously.

1 Importing and exporting data: You can exchange information between 
FileMaker Pro and other applications by importing and exporting data. For 
example, you can import data that is in another database or spreadsheet 
program, or export address data in order to create personalized form letters 
with a word processing program.

1 Accessing data from external data sources: You can access information 
stored in other FileMaker Pro files and external SQL databases that use 
ODBC technology to share data. This allows you to work with information 
stored in external databases and combine external data with information 
stored in your file. When you access data from an ODBC database, you can 
use supplemental fields in your FileMaker Pro file to perform calculations 
and summary operations on the data without changing the schema of the 
external file.

1 Instant Web Publishing: You can quickly and easily publish 
FileMaker Pro layouts as web pages, which allows anyone with a web 
browser on your intranet (or the internet) to access your FileMaker Pro 
databases.

Note  See Help for detailed, comprehensive information and step-by-step 
procedures about using FileMaker Pro. See the FileMaker Instant Web 
Publishing Guide for information about publishing databases on the web.
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Sharing databases on a network
If your computer is connected to a network, you and other Windows and 
Mac OS FileMaker Pro users can use the same database file simultaneously. 

FileMaker Pro Network Sharing supports the sharing of files with up to 
9 concurrent users (not including the host and Instant Web Publishing 
connections). If you need to share files with more than 9 concurrent users on a 
network, FileMaker recommends the use of FileMaker Server, which provides 
greater networking performance in addition to its increased capacity.

Important  Your FileMaker Pro licensing agreement requires that you pay for a 
license for each separate computer on which the FileMaker Pro application is 
installed or run. The software license may not be shared or used concurrently on 
different computers. Please read the software license for complete terms and 
conditions.

The first person to open a shared file is the host. Any user who opens a shared 
file after the host is a client.

Once a shared file is open, the host and clients have access to the same 
information, and all changes to the file appear in each user’s window. 

The host opens the file

Clients open connections to the shared file
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Modifications to the data made by any user are saved in the shared file. The 
shared file is saved on the disk where the file resides.

Sort orders, find requests, import and export field orders, and print setups are 
specific to each user.

Enabling file sharing and hosting files
Because many FileMaker Pro commands are processed on the host machine, 
you will see better performance if you host your shared files from the fastest 
available computer. The file you’re hosting must be on the hard disk of your 
computer. Remotely hosting a file stored on another computer or server is not 
supported, as it might compromise data integrity and will result in poor 
performance. 

To turn on network file sharing for all open files: 

1. Open the FileMaker Pro file(s) you want to share.

Note   To enable or change a file’s sharing status, you must open it with an 
account that has the appropriate access privilege set. For more information, see 
“Accounts, privilege sets, and extended privileges” on page 176.

2. Choose File menu > Sharing > FileMaker Network.
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3. In the FileMaker Network Settings dialog box, for Network Sharing, click 
On.

In the TCP/IP Address box, you see the TCP/IP address of your system.

4. Select the file(s) to be hosted from the list of Currently open files.

5. Set the level of network access for the file(s). 

To Select

Provide access to all FileMaker Pro 
users on your network 

All users.

Limit network access to users based on 
their privilege set

Specify users by privilege set, then click Specify.

In the Specify users by privilege set dialog box, 
select the privilege sets you want to have network 
access.

Prevent any access via FileMaker 
networking 

No users.

Click to enable network sharing

Select level of network access 
for the selected file(s)
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6. Click OK. 

The open files are now hosted.

Important  You must keep your shared file(s) open to make them available to 
clients. 

Note  In order for files to be shared on read-only CDs, you must enable sharing 
before copying the file to the CD.

Opening shared files as a client
FileMaker Pro databases shared via TCP/IP can be opened remotely using the 
list of local hosts, the IP address of the host machine, or the DNS name of the 
host machine (if one has been defined). 

To open a shared file as a client:

1. Choose File menu > Open Remote

2. In the Open Remote File dialog box, select View for a list of hosts.

3. To see the available files from a host, select the host. In the Available Files 
list, select the file you want to open. 

Tip   To narrow the list of available files, type a few characters in the Filter text 
box. Only filenames containing the characters you type are displayed in the list.

Or, for Network File Path, type the network path; for example:

For IPv4: fmnet:/<host IP address>/<filename>

For IPv6: fmnet:/[<host IPv6 address>]/<filename>

Choose To display

Favorite Hosts Hosts you previously added as favorites

Local Hosts FileMaker Pro hosts on your TCP/IP subnet

Hosts Listed by LDAP FileMaker Pro hosts available through the specified LDAP server
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4. Click Open.

You might be required to enter an account name, password, and domain 
name (Windows only), depending on how file sharing is configured on the 
host. 

If the network is very busy, the file might not be listed. To check the 
network for a longer period of time, hold down the Ctrl key (Windows) or 
Option key (Mac OS) as you click an item. 

For information about marking remote files as favorites and accessing 
favorite files, see Help.

Limitations on changes to shared files
Although it is possible for multiple users to make changes in the same shared 
file at the same time, there are limits to the types of simultaneous changes that 
are permitted. The following table describes the types of changes you can and 
cannot make to shared files.

Database change Limitation

Data in layouts and 
records

Two people can’t edit the same record at the same time.

Data in records from 
external ODBC data 
sources

Two people can edit the same record at the same time.

If two users edit the same record simultaneously, FileMaker Pro posts an 
alert when either user attempts to commit changes. The alert provides a 
user with a choice, allowing changes to be committed (overwriting any 
changes the other user might have made), returning to the record without 
committing changes, or reverting the record to the state it was when the 
editing session began.

Layouts and layout 
elements

Two people can’t modify the same layout at the same time.

Value lists Two people can’t modify or define the same value list at the same 
time.

One person can edit a value list while another person is using it in 
Browse mode or Find mode.

Scripts Two people can’t modify or define the same script at the same time.

One person can edit a script while another person is using it.
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Opening shared databases remotely using a URL
The FileMaker Pro installer registers FMP7 as an internet protocol. This 
enables you to open a shared database using a URL.

Clients can use a browser to access shared databases by entering the URL of 
the shared file on the host machine in a browser’s address area. 

To identify the URL for the shared database on the host machine and send it to 
a client user:

1. In the shared file on the host machine, choose File menu > Send Link.

FileMaker Pro opens an email message in your default email application 
that contains the URL for the current database, plus client connection 
requirements.

2. Address the email message to the client user, then send the message. 

Tables, fields, 
relationships 
(database schema)

Two people can’t modify any of these elements at one time.

Data sources Two people can’t modify or define the same data source at the same 
time. 

One person can edit a data source reference while another person is 
using the external file.

Accounts and 
privileges

Two people can’t modify or define accounts and privileges at the 
same time.

One person can create or modify an account and privileges while 
another person is using it. 

Database change Limitation
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To open a shared database on a client machine using a URL, do one of the 
following:

1 If you received an email message containing the URL of the host 
machine, click the link indicating the location of the hosted database. If 
your email application does not support active links, launch a web 
browser on the intended client machine, copy the URL from the email 
message into your browser’s address area, then press Enter (Windows) 
or Return (Mac OS).

1 If you received the URL of the shared database by some other means, 
launch a web browser on the intended client machine, enter the URL of the 
host machine into the browser’s address area using the following format, 
then press Enter (Windows) or Return (Mac OS).

[<][URL:]FMP7://[[account:password@]netaddress]/databasename[>]

Optional parameters are indicated by square brackets ("[  ]"). Because URLs 
can’t contain spaces, any spaces in database names are encoded as plus signs 
("+"). 

Examples
FMP7://My+Addresses.fp7 
FMP7://192.168.10.0/My+Addresses.fp7 
FMP7://User1:Password1@12.345.678.900/Filename.fp7

Closing a hosted file
Before a shared file can be closed by a host, all clients must close the file. 
FileMaker Pro allows you to prompt networked clients to close the shared file 
when you do one of the following: close the file, change the sharing conditions 
for the file, exit FileMaker Pro, or perform a task that requires all clients to 
close the file. If a client does not respond to your request to close a shared file 
within 30 seconds, FileMaker Pro will attempt to close the shared file on the 
client’s machine.

To close a hosted file:

1. On the computer hosting the file, choose File menu > Close.
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2. If any clients have the shared file open, you see a dialog box listing those 
clients. Click Ask to send a message to these clients requesting that they 
close the file.

3. Clients see a dialog box requesting that they close the file. 

For more information about sharing files over a network, see Help. 

Importing and exporting data
You can exchange information between FileMaker Pro and other applications 
by importing and exporting data. You can: 

1 import data into an existing FileMaker Pro file, either into a new table or 
into an existing table

1 convert data from other applications to new FileMaker Pro files

1 export data for use in other applications

Saving and sending data in other formats
You can save FileMaker Pro data as a Microsoft Excel or Excel 2007/2008 
worksheet or a PDF file, allowing you to give your record data to users who 
don’t have FileMaker Pro.

FileMaker Pro lets you email the Excel worksheet or PDF file when you save 
it. You can also create scripts to save records as Excel or PDF.

If FileMaker Pro

Clients click Cancel Waits for those clients to close the file

Clients click Close Now Closes the shared file on the client’s computer

Clients do nothing Attempts to close the file after 30 seconds, if it can be closed 
safely
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In order to save files as Excel, you need the Allow Exporting Access privilege. 
To save files as PDF, you need the Allow Printing Access privilege.

Note  The saved file will only include fields that are on the layout when you 
perform the save. If you want to include other fields (for example, fields on tab 
panels that are not in front), use the Export Records command instead of Save/
Send Records As.

Sending email messages based on record data
You can use FileMaker Pro to send one, or multiple, messages to one or more 
recipients. Generated email is sent using your default email application or 
directly through SMTP (Simple Mail Transfer Protocol, a set of criteria for 
sending and receiving email). You can enter values, or use values from fields 
or calculations. You can also create scripts to send email. 

For more information, see Help.

Supported import/export file formats
Every application stores its data files in its own file type or file format. Most 
applications can also exchange information in certain other formats. 

FileMaker Pro can import and/or export files in these formats, followed by 
their filename extensions: Microsoft Excel (.xls, .xlsx), tab-separated text (.tab, 
.txt), comma-separated values (.csv, .txt) , FileMaker Pro 7 (.fp7), Merge 
(.mer), HTML table (.htm), and XML (.xml). If you’re exchanging data with 
another program, check the documentation that came with that program to 
determine a common intermediary file format that both FileMaker Pro and the 
other program support. 

Most file formats support data conversion only and do not import or export 
formatting such as font, size, style, and color.

For information about file formats and the versions FileMaker Pro can import 
and/or export, or about importing from sources such as XML, a digital camera 
(Mac OS), or Bento (Mac OS), see Help.
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ODBC and JDBC
You can exchange FileMaker Pro data with ODBC- and JDBC- compliant 
applications. For example, you can chart FileMaker Pro data in Microsoft 
Excel. 

Methods of importing data into an existing file 
When you import data into an existing file, you can:

1 add new records to an existing table

1 create a new table from imported data

1 update existing records in an existing table

1 update matching records in an existing table

Important  The import options that update existing records and update matching 
records both overwrite existing data during the import process and cannot be 
undone. To safeguard your data, choose File menu > Save a Copy As to make a 
backup of the file before you perform an import that updates records.

The file you import records from is the source. The file you import records to 
is the target. 

What do you want to do? How do you do it? See

Use FileMaker Pro as a data 
source/share FileMaker Pro data

1 SQL queries

1 JDBC

FileMaker ODBC 
and JDBC Guide

Use FileMaker Pro as an ODBC 
client/access ODBC data

Interactively via the 
relationships graph

“Working with 
external data sources” 
on page 170 and 
FileMaker Pro Help

1 One-time, static via ODBC 
import (or File menu > 
Open)

1 Import Records script step 

1 Execute SQL script step

FileMaker Pro Help
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About adding records 
When you add records, you import all records from the source file to the target 
file or table. A new record is created in the target file for each importable record 
in the source file.

About updating existing records 
With this option, you replace data in your file with data from the source file. 
For each field you import into, data from the first importable record (or row of 
data) in the source file overwrites fields in the first record in the target file. Data 
from the second importable record (or row of data) in the source file overwrites 
fields in the second record in the target file, and so on. When you replace data, 
FileMaker Pro doesn’t examine or compare the data in the files. 

You can choose whether to replace or not replace data on a field-by-field basis.

Records in the target file are replaced with the same number of records from 
the source file. If there are more importable records in the source file, data from 
the extra records in the source file will not be imported unless you also choose 
Add remaining data as new records. If there are more records in the target file, 
data in the extra records in the target file will not be replaced.

About updating matching records 
You can update matching records and fields in your target file with data from 
another file. For example, you might have a copy of a database on your desktop 
computer and another copy on your laptop computer. You can update the file 
in your office with the changes you make on the road.

You determine which records in the source file update which records in the 
target file by choosing one or more match fields in each file. If data in the match 
field(s) of a record in the target file matches data in the match field(s) of a 
record in the source file, the record in the target file will be updated with data 
from the source file.

Match fields must uniquely identify each entity in your database. For example, 
in a database of people, you could use one match field such as Employee 
Number, or multiple match fields such as Last Name, First Name, and Phone 
Number. Using Last Name alone might identify more than one person, so it isn’t 
a good match field to use by itself. 
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You also specify the fields you want to import. The contents of all fields you 
select to import, in all matching records, will overwrite data in the target file, 
even if the field in the source file is blank.

When the target file contains a found set, only the found records are updated. 
(If the source file is another FileMaker Pro file, you can also import only from 
a found set.)

The following example shows how a record in a target file appears before and 
after being updated by a matching record in a source file.

About the importing process
The basic steps for importing records are:

1. Make a backup copy of the target file you’re importing into.

2. If the source file is a FileMaker Pro file, perform a find so that the found set 
in the current window contains only the records you want to import.

3. Open the target file, and if it has multiple tables, select a layout that shows 
records from the table you want to import data into.

4. If you’re updating existing or matching records, make sure the found set in 
the target file contains only the records you want to change or update.

–>

=

–
–>
–>
–>
–

–>
–

= indicates a match field 
–> indicates to import the field 
– indicates to not import the field

123-456-7890

Source file

John
Q
Smith
456 New Rd.
Newtown
USA

123-456-7890

Target file

John

Smith
123 Main St.
Anytown
USA
3/3/1960
408-555-6789

123-456-7890

After updating

John
Q
Smith
456 New Rd.
Newtown
USA
3/3/1960

Before updating matching records

Target file
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5. Choose File menu > Import Records > File, and choose the name of the file 
that contains the data you want to import (the source file).

6. In the Import Field Mapping dialog box, if necessary, select a table from the 
Source list.

7. Accept the table shown in the Target drop-down list, or select New Table to 
create a table with the same schema as the source table.

8. Select the type of import to perform. See “Methods of importing data into 
an existing file” on page 165.

9. Map the fields in the source file to the fields in the target file. 

Converting a data file to a new FileMaker Pro file
You can convert a data file from another application into a new FileMaker Pro 
file. The converted file will contain:

1 The data from the file or source you convert 

1 Two layouts for displaying the data

1 Converted field names if they are available in the file or source you convert. 
Otherwise, field names are generic: f1, f2, f3, and so on.

Fields in the 
source file

Fields in the 
target file

Arrows show that data will 
import into the fields at right

Select an import action

Select a table 
to import from

= indicates match fields 

Import to 
Current Table 
or New Table
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1 Converted field types if they are available in the file or source you convert. 
Otherwise, all fields are text fields.

To import data into a new file:

1. In the source application, save the data you want to import in a file type that 
FileMaker Pro supports. See “Supported import/export file formats” on 
page 164.

2. Choose File menu > Open.

3. In the Open File dialog box, for Files of type (Windows) or Show (Mac OS), 
specify the type of file, choose the file to convert, then click Open.

4. If you see the First Row Option dialog box, choose whether the first row of 
data contains field names or the first record of data, then click OK.

5. If you’re converting a Microsoft Excel spreadsheet and the Specify Excel 
Data dialog box appears, choose a worksheet or named range from the 
workbook file, then click OK.

6. In the Create a New File Named dialog box, type a name for the new file, 
choose a location, then click Save.

FileMaker Pro converts the data to a FileMaker Pro file and displays the 
file.

For more information about importing data, see Help. 

About the exporting process
You can export FileMaker Pro data to a new file, then open it in another 
application.

The basic steps for exporting records are:

1. Open the FileMaker Pro file and display a layout that shows the records you 
want to export.

2. Find and sort the records to export. See “Finding records” on page 40 and 
“Sorting records” on page 58.

3. Choose File menu > Export Records.

4. In the Export Records to File dialog box, type a name and choose a location 
for the exported file, and choose a file type.
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5. In the Specify Field Order for Export dialog box, select how you want 
FileMaker Pro to export the data.

6. If necessary, choose the character set you want the exported file to use. 

7. Select whether or not to apply the current layout’s formatting to the 
exported data. 

For more information about exporting data, see Help. 

Working with external data sources
You can define data sources in a FileMaker Pro file to access data from:

1 other FileMaker Pro files

1 SQL databases that use ODBC technology for sharing information

When you define data sources in FileMaker Pro files, current data from 
external databases is displayed in your files. You can use FileMaker Pro to add, 
edit, delete, search, and sort data in the external files.

To export Choose

A field on the current 
layout

Current Layout (LayoutName) from the table list, then double-click 
a field in the list

A field in the current 
layout’s table

Current Table (TableName) from the table list, then double-click a 
field in the list

Select fields 
from this list

Select whether 
or not to apply 

formatting 

FileMaker Pro exports these fieldsTo export related fields, 
select the related table 

from the list
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The following procedures provide an overview of how to access data in 
external FileMaker Pro files or external ODBC data sources. For detailed 
information on accessing external data sources, see Help.

Working with external FileMaker Pro files
To set up a file to access data from another FileMaker Pro file: 

1 Add tables from other FileMaker Pro data sources to the relationships 
graph in the current FileMaker Pro file.

1 Add fields to layouts to display data from the other FileMaker Pro file. 

Working with ODBC data sources
To set up a file to access data in supported ODBC data sources:

1 Install and configure an ODBC driver for the external data sources you 
want to access. 

1 On the computer that hosts the current FileMaker Pro file, define a system 
Data Source Name (DSN) for each ODBC data source you want to access.

1 Set options for the ODBC data sources you want to access (for example, 
whether users are prompted for a user name and password).

1 Add one or more tables from the ODBC data source to the relationships 
graph in the current FileMaker Pro file.

1 Add fields to layouts in the FileMaker Pro file to display external data.

1 Optionally, add supplemental fields to external tables and layouts to display 
calculation and summary results based on data stored in external ODBC 
data sources.
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Publishing databases on the web
With FileMaker Pro, you can use Instant Web Publishing to publish your 
databases in a web browser, allowing users to find, browse, and modify data in 
the database.

Using Instant Web Publishing with FileMaker Pro accounts and privilege sets, 
you can make your web databases secure. 

Note  FileMaker Pro Instant Web Publishing supports the sharing of files with up 
to 5 concurrent users. Use FileMaker Server Advanced if you need to share files 
with more than 5 concurrent web users.

To work with a published FileMaker Pro database, users need:

1 web browser software 

1 access to the internet or an intranet. Access to the internet requires an 
internet service provider (ISP); FileMaker does not provide an account for 
you

1 a host computer with continuous access to the internet or intranet via TCP/
IP

1 the Internet Protocol (IP) address of the computer that hosts your database 
files

You can publish your databases as web pages within a local network or 
intranet, or to users on the web. You don’t have to change your database or use 
additional software.

Note  Web viewers, which calculate a URL based on field data and display a web 
page directly in a FileMaker Pro layout, work in files shared via Instant Web 
Publishing. However, there are some design issues you should consider before 
including web viewers in published files. For more information, see the FileMaker 
Instant Web Publishing Guide. Choose Help menu > Product Documentation > 
FileMaker Instant Web Publishing Guide.
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Shared FileMaker Pro database in web browser
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Chapter 6
Protecting databases with 
accounts and privilege sets

This chapter describes the basics of how to use accounts and privilege sets to 
restrict what users can see and do in a FileMaker Pro file. You’ll learn about:

1 planning security for a file

1 viewing and creating user accounts and passwords

1 viewing and creating privilege sets

1 viewing extended privileges

Note  See Help for detailed, comprehensive information and step-by-step 
procedures about using FileMaker Pro.

Although your operating system includes file security features, you should use 
FileMaker Pro access privileges as the fundamental way to control access to 
and protect the security of your database files.

For information about how security settings in older databases convert to the 
current version of FileMaker Pro, see “Converting databases from 
FileMaker Pro 6 and earlier” on page 193 and see FileMaker Pro Help.

Protecting databases
You can limit what users can see and do in a database file. You can restrict:

1 Data access. Make particular records or fields from individual tables view-
only, or hide them completely.

1 Layout access. Prevent users from modifying layouts in Layout mode.

1 Access to value lists and scripts. Prevent users from accessing and 
modifying value lists and scripts, and from running scripts. 

1 Access to file sharing. Individually enable file sharing via the FileMaker 
Network, Web Publishing, and ODBC and JDBC.
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1 Outputting data. Prevent users from printing or exporting data.

1 Menu access. Make only a limited set of menu commands available.

You restrict what users do in a file by requiring them to enter an account name 
and password when they attempt to open a file. The account name and 
password they enter determines which privilege set will be used and the 
privilege set limits what they can do in a file. For more information about 
accounts and privilege sets, see the following section.

You can define privileges in a shared file while clients are using it. Any 
privilege changes that affect a current client do not take effect until the client 
closes and reopens the file.

The privileges that you set up apply to a single file only and all database tables 
within that file. If your database solution consists of multiple files that you want 
to protect, you may want to combine all of these files into one multi-table file. 
Then you can define privileges in only a single file to manage access to the 
entire database solution. If you don’t want to combine the files into one file, 
then you should define privileges in each file that contains items you want to 
protect.

Important  If you create a relationship in one file that references a table in another 
file, you cannot manage access privileges for the related table in the first file. The 
privileges defined in the other file control access to that table.

Accounts, privilege sets, and extended privileges
Accounts authenticate users who are attempting to open a protected file. Each 
account specifies an account name and usually a password. Any user that 
cannot specify valid account information won’t be able to open a protected file.

Each database file contains two predefined accounts: Admin and Guest. For 
more information, see “About the predefined accounts” on page 179.
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You may want to create an account for every individual who accesses a file, or 
you may want to create a small number of accounts that are shared among 
many individuals, such as a “Marketing” account and a “Sales” account.

1 Create accounts for individuals when it is necessary to verify the identities 
of particular users and you want to manage access at an individual level.

1 Create shared accounts when you want fewer accounts to maintain and you 
are less concerned about managing individual access to the database file.

If you host files on FileMaker Server, you can create External Server accounts 
that obtain authentication information from an authentication server such as an 
Apple OpenDirectory or Windows Domain. For more information, see 
“Creating accounts that authenticate via an external server” on page 188.

A privilege set specifies a level of access to a database file. Each database file 
contains three predefined privilege sets for common types of access levels: Full 
Access, Data Entry Only, and Read-Only Access. When you create a privilege 
set, there are many options available that you can use to limit database access, 
such as which layouts are viewable, which menus are available, and whether 
printing is permitted. Privilege sets can also restrict access to records or fields 
from particular tables within a file. Each account is assigned a privilege set, 
which determines the level of access when someone opens a file using that 
account.

You can create as many privilege sets as you need to define the types of access 
you want to permit to a file. For more information about privilege sets, see 
“About the predefined privilege sets” on page 180.

Extended privileges determine the data sharing options that are permitted by a 
privilege set, such as whether a privilege set permits users to open a shared file 
or view a database in a web browser.
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The following table lists the default extended privileges that are available. 
(FileMaker as well as third-party developers may define additional extended 
privileges to manage access for other software products designed to work with 
FileMaker Pro or FileMaker Server.)

When a user attempts to open or access a protected file using one of the above 
methods, the user will be prompted to provide account information. If the 
privilege set for the account does not permit the type of extended privilege 
access the user is requesting, the user will get an error indicating that they 
cannot access the file.

All extended privileges for a file are disabled by default, even in the Full 
Access privilege set.

Extended privilege Determines if a privilege permits

Access via FileMaker Network Opening a networked shared file (either a file 
hosted by FileMaker Pro or FileMaker Server)

Access via ODBC/JDBC Accessing a database file from another application 
via ODBC or JDBC

Access via Instant Web Publishing Accessing a database file from a web browser via 
Instant Web Publishing

Access via FileMaker Mobile Accessing a database file with FileMaker Mobile 
software

Access via XML Web Publishing Accessing a database file from a web browser or 
other application via XML web publishing 
(FileMaker Server only)

Access via XSLT Web Publishing Accessing a database file from a web browser or 
other application via XSLT web publishing 
(FileMaker Server only)

Access via PHP Web Publishing Accessing a database file from a web browser or 
other application via PHP web publishing 
(FileMaker Server only)
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Enabling extended privileges only makes it allowable for certain privilege sets to 
access shared data. To actually access the shared data, you must also set up sharing 
for the type of access that you want. For more information on sharing data, see 
chapter 5, “Sharing and exchanging data.” For more information on extended 
privileges, see “Viewing extended privileges” on page 191.

About the predefined accounts
Each database file contains two predefined accounts: Admin and Guest.

Admin account
The Admin account is assigned the Full Access privilege set, which permits 
access to everything in a file. The Admin account is not assigned a password. 
In files for which privileges are not set up, the file options are set up to 
automatically log in to the file using the Admin account.

The Admin account is fully editable. You can rename it, assign it a password, 
or make the account inactive. You can even delete the Admin account; 
however, you must assign the Full Access privilege set to at least one other 
active account.

Important  Don’t forget the account name and password that is assigned to the Full 
Access privilege set. If necessary, write it down and store it in a secure place. If you 
lose or forget this account name and password, you may not be able to access the 
file.

Guest account
The Guest account permits users to open a file without specifying any account 
information. The Guest account is not assigned a password. By default, the 
Guest account is assigned the Read-Only Access privilege set, but you can 
assign any privilege set you want to the Guest account.

Initially, the Guest account is inactive, which disables the guest option in the 
password dialog box and prohibits users from opening files as a guest. You can 
enable the Guest account to permit guest access.

The Guest account is not fully editable. You cannot delete the Guest account, 
change the Guest account name, or assign it a password.
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About the predefined privilege sets
Every new database file contains three predefined privilege sets.

1 Full Access: permits accessing and changing everything in the file

1 Data Entry Only: permits viewing and entering of data only

1 Read-Only Access: permits viewing but not changing data

You cannot change or delete these predefined privilege sets, except to enable 
or disable extended privileges for them. You can either use them as is, or 
duplicate them and then modify the duplicate copies.

The following table summarizes the properties of these privilege sets.

Privilege Sets

Privilege Full Access Data Entry Only
Read-Only 
Access

Records (in all tables) create, edit, delete create, edit, delete view only

Layouts all modifiable view only view only

Value lists all modifiable view only view only

Scripts all modifiable and 
executable

all executable only all executable only

Extended Privileges all off all off all off

Allow printing on on on

Allow exporting on on on

Manage extended privileges on off off

Override data validation 
warnings

on off off

Disconnect user from 
FileMaker Server when idle

off on on

Allow password 
modification

on on on

Password change number of 
days

off off off
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You must have Allow Printing privileges to save records as a PDF file. You 
must have Allow Exporting privileges to export records as a Microsoft Excel 
or Excel 2007/2008 worksheet. For more information about saving records as 
PDF or Excel files, see “Saving and sending data in other formats” on 
page 163.

Note  The Full Access privilege set is the only one that permits access to the 
Manage Database and Manage External Data Sources dialog boxes in order to 
modify fields, tables, relationships, and data sources. It is also the only privilege set 
that permits changing accounts and privileges. Because you cannot enable these 
privileges in any other privilege set, any user that wants to make database definition 
changes or privileges changes must open the file with an account that is assigned 
the Full Access privilege set.

At least one active, FileMaker authenticated account in each file must be 
assigned the Full Access privilege set. An error message will appear if you edit 
accounts so that no active account is assigned the Full Access privilege set.

Planning security for a file
A new FileMaker Pro file is initially unprotected. Whenever the file opens, it 
automatically logs in the user with the Admin account, which is assigned the 
Full Access privilege set.

1 If you simply want to keep someone else from opening a database file on 
your computer, you can password-protect the file. For more information, 
see “Password-protecting a file” on page 183.

Minimum password length off off off

Available menu commands all all all

Privilege Sets

Privilege Full Access Data Entry Only
Read-Only 
Access
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1 If you need to share a database file with others and provide varying levels 
of file access to different users, you need to plan the security for the file. 
Consider listing the types of users and their privileges: 

* You can provide limited access to some features, for example deleting 
records, by using record-by-record privileges. For more information on record-
by-record privileges, see FileMaker Pro Help.

To plan the security for a shared file: 

1. Determine the privilege sets that you need for the file.

Make a list of the areas of the file that you want to protect, such as particular 
tables, fields, records, layouts, value lists, and scripts. Plan the number of 
privilege sets you need to enforce the varying levels of file access that you 
require.

2. Determine whether you need individual accounts for each user, or group 
accounts that multiple users can share.

3. Decide if you want to enable the Guest account, which permits users to 
open the file without specifying account information.

4. Create the privilege sets that you need in the file.

Managers Marketing Sales HR Legal Guests

View records Yes Yes Yes Yes Yes Yes

Create records Yes Yes Yes Yes No No

Edit records Yes Yes Yes Yes No No

Delete records Yes Limited* Limited* Yes No No

Modify scripts Yes Limited* No Yes No No

Execute 
scripts

Yes Yes Yes Yes Yes No

Modify value 
lists

Yes No No No No No

Menus

All Editing  
only

Editing 
only

All Minimum Minimum
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5. Determine if you need to enable any extended privileges for certain 
privilege sets.

Don’t enable extended privileges unless they’re needed.

6. Create the accounts you need in the file, and assign the appropriate 
privilege set to each account.

For more information, see the next section. If you’re using the Guest 
account, assign a privilege set to it as well. Otherwise, disable the Guest 
account.

7. Open the file using different accounts and test each privilege set that you 
created. Make sure the restrictions work the way you want, and make any 
needed corrections to your privilege sets.

Password-protecting a file
If you have a non-shared database file on your computer and you want to 
prevent others from opening it, you can password-protect the file.

After password-protecting a file, you will be prompted to enter an account 
name and password every time you open the file. Anyone who does not know 
this account information will not be able to open the file.

To password-protect a file:

1. Make the following changes to the accounts in the file:

1 Edit the Admin account so that it has a different account name, a 
password, and uses the Full Access privilege set. 

1 Make sure the Guest account is inactive.

1 Delete any other accounts in the file or make them inactive.

2. If necessary, edit the Full Access privilege set to allow yourself any 
extended privileges you may want for yourself.

Don’t enable extended privileges unless they’re needed.
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Suggestions for creating secure passwords
1 Secure passwords are typically eight or more characters in length, and 

include at least one numeric character.

1 If the file is shared via web publishing, account names and passwords can 
only use characters included in the ISO Latin-1 character set (except 
colons). To avoid characters that may be interpreted incorrectly over the 
web, you may want to limit account names and passwords to alphabetic and 
numeric characters only.

For more information about protecting FileMaker Pro databases, see Help.

Creating accounts and privilege sets
Accounts specify account names and (usually) passwords for a file. When a 
user opens a file that contains accounts, a dialog box prompts the user to enter 
account information. When a user opens a file with a correct account name and 
password, the privilege set assigned to that account determines what the user 
can do in that file.

Privilege sets specify levels of access to a database, such as which layouts are 
viewable, which menus are available, and whether printing is permitted.

To create and manage accounts and privilege sets for a file, you need to open 
the file with an account that is assigned the Full Access privilege set. 

You can create and modify accounts and privilege sets in a shared file while 
clients are using it. (In FileMaker Pro 6 and earlier, all clients had to close the 
shared file before you could change passwords and groups.) The account 
changes you make take effect immediately. However, the changes do not 
disrupt any current clients. For example, if you change the password for an 
account that is in use by one or more clients, their FileMaker Pro usage is not 
interrupted. However, they will need to enter the new password the next time 
they open the file.

You can create as many accounts as you need. You can create individual 
accounts for each user, or a smaller number of accounts that users can share.
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Viewing accounts and privilege sets
The Manage Accounts & Privileges dialog box displays a list of all the 
accounts and privilege sets for a file.

To view the accounts and privilege sets for a file:

1. Open the database file.

2. Choose File menu > Manage > Accounts & Privileges.

You see the accounts defined for this file.

3. In the Manage Accounts & Privileges dialog box, click the Privilege Sets 
tab.

You see the privilege sets defined for this file.



186  |  Protecting databases with accounts and privilege sets

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 186  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ
Creating accounts
You can create accounts for every individual who accesses a file, or create 
fewer accounts that are shared among many individuals, such as a “Marketing” 
account and a “Sales” account. You must assign a privilege set to each new 
account. 

To create an account:

1. Choose File menu > Manage > Accounts & Privileges.

2. In the Accounts tab, click New.

3. In the Edit Account dialog box, for Account is authenticated via, choose 
FileMaker.
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For information about accounts managed by an external server, see “Creating 
accounts that authenticate via an external server” on page 188.

4. Enter an account name and password for the account.

Tip   If you plan to create accounts for individual users, you may want to base each 
account name on the User Name defined in the Preferences dialog box. This User 
Name is the default account name that appears in the dialog box that prompts a user 
for an account name and password. The user won’t have to re-type the account 
name if it matches the User Name.

5. To force the account users to choose a new password the first time they log 
in, choose User must change password on next login.

In most cases, an account that is shared by multiple users should not force 
a password change upon first login. Instead, you should specify a password 
and provide it to the users that need it. Also, the privilege set for a shared 
account should not permit password changes because one user could 
change the password and lock out all other users who share the account.
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6. For Account Status, choose whether you want the account to be active or 
inactive.

For example, you may want to keep the account inactive until you finish 
setting up its privilege set. Users cannot open a database using an inactive 
account name and password.

7. For Privilege Set, choose the privilege set you want to use with this account.

You can choose an existing privilege set, or choose New Privilege Set and 
create a new one. For more information, see “Creating privilege sets” on 
page 189.

8. For Description, enter a description of the account (optional).

9. Click OK.

10. In the Manage Accounts & Privileges dialog box, click OK. 

11. In the dialog box that appears, enter an account name and password that is 
assigned the Full Access privilege set, and click OK.

Creating accounts that authenticate via an external server
If you’re hosting FileMaker Pro database files with FileMaker Server and your 
organization uses centrally managed authentication for users and groups such 
as Apple OpenDirectory or a Windows Domain, you can set up accounts that 
authenticate users based on your authentication server. This allows you to use 
your existing authentication server to control access to databases without 
having to manage an independent list of accounts in each FileMaker Pro 
database file.

Note  Only database files hosted by FileMaker Server can authenticate users 
against an authentication server. Database files shared by FileMaker Pro won’t 
authenticate against an authentication server.

Important  When a database file contains one or more External Server accounts, 
make sure you use operating system security settings to limit direct access to the 
file. Otherwise, it might be possible for an unauthorized user to move the file to 
another system that replicates your authentication server environment and gain 
access to the file. For more information, see the FileMaker Server documentation.
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To create an account that authenticates via an external server:

1. Choose File menu > Manage > Accounts & Privileges.

2. In the Accounts tab, click New.

3. In the Edit Account dialog box, for Account is authenticated via, choose 
External Server.

4. For Group Name, enter the name of a group that is defined on an external 
authentication server.

5. For Account Status, choose whether you want the account to be active or 
inactive.

6. For Privilege Set, choose the privilege set you want to use with this account.

The privilege set assigned to the account determines what the externally 
authenticated group members can do in the database file. You can choose 
an existing privilege set, or choose New Privilege Set and create a new one. 
For more information, see the next section.

7. For Description, enter a description of the account (optional).

8. Click OK.

9. In the Manage Accounts & Privileges dialog box, click OK. 

10. In the dialog box that appears, enter an account name and password that is 
assigned the Full Access privilege set, and click OK.

Creating privilege sets
You can assign each privilege set to one or more accounts.

To create a privilege set:

1. Follow the steps above to display the privilege sets for a file. 

2. Click New.

The Edit Privilege Set dialog box appears. By default, each privilege set 
option is set to its most restrictive setting.
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3. Enter a name and optional description for the privilege set.

4. Define the privileges for the privilege set.

5. Click OK.

After you create the privilege sets that you want, you need to create or edit 
accounts so that they use the appropriate privilege sets. For more information, 
see “Creating accounts” on page 186.

For more information about creating accounts and privilege sets, see Help.

About enabling record-level access
You can set individual record access for each table. For example, the privilege 
set can limit the ability to:

1 View, edit, create, or delete all or certain records within each table.

1 Access or modify certain fields within each table.

You can only set record access privileges for tables defined in the current file. 
If the file contains relationships to tables in other files that you want to protect, 
you need to create accounts and privilege sets in the other files to protect those 
tables.

For more information about using the Edit Privilege Set dialog box, see Help.
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Viewing extended privileges
Extended privileges determine the data sharing options that are permitted by a 
privilege set for a file. For example, if the file is shared, the Access via 
FileMaker Network extended privilege determines if the privilege set allows 
opening the shared file as a client. The Access via Instant Web Publishing 
extended privilege determines whether the privilege set allows accessing the 
database from a web browser. 

There are six default extended privileges. For more information about them, 
see “Accounts, privilege sets, and extended privileges” on page 176.

You can view extended privileges in the Manage Accounts & Privileges dialog 
box, as well as enable each extended privilege for selected privilege sets. All 
of the extended privileges are disabled by default, even in the Full Access 
privilege set.

It may be necessary to delete an extended privilege that is no longer required.

To view the extended privileges:

1. Open the database file.

2. Choose File menu > Manage > Accounts & Privileges.

3. In the Manage Accounts & Privileges dialog box, click the Extended 
Privileges tab.

For more information about extended privileges, see Help.
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Chapter 7
Converting databases from 
FileMaker Pro 6 and earlier

Because FileMaker Pro 7, FileMaker Pro 8.x, FileMaker Pro 9, and 
FileMaker Pro 10 share the same file format, FileMaker Pro 10 can open 
FileMaker Pro 7, FileMaker Pro 8.x, and FileMaker Pro 9 files without 
converting them. You can even use FileMaker Pro 10 files with FileMaker Pro 
7, FileMaker Pro 8.x, or FileMaker Pro 9. However, new features might not 
work as expected when you open the file in a previous version.

For example:

1 Tab control: A layout containing tab panels will open, but the objects that 
were on the tab panels will appear on top of each other.

1 Importing data: FileMaker Pro files from pre-7.0 versions of FileMaker Pro 
need to be converted to the .fp7 format before importing.

1 Web viewers: If a file containing a web viewer is opened in a version of 
FileMaker Pro prior to version 8.5, the web viewer is not displayed in Layout 
mode. In FileMaker Pro 8, web viewers appear as empty images. In versions 
of FileMaker Pro prior to version 8, no image appears in place of the web 
viewer.

1 External data sources: If you open a file connected to an ODBC data source 
in a version of FileMaker Pro prior to version 9, the ODBC table in the 
relationships graph is labeled <File Missing>. The data source feature also 
causes some menu items to appear differently. For example, in custom menus 
(FileMaker Pro Advanced only), changes occur with regard to how menu 
items are organized and how new and changed menu items are represented.
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FileMaker recommends that, once you have created or opened a file in 
FileMaker Pro 10, you do not make database design or layout changes using 
an earlier version of FileMaker Pro, particularly to features that have changed 
in FileMaker Pro 10.

Note  See Help for detailed, comprehensive information and step-by-step 
procedures about using FileMaker Pro.

Conversion overview
If your database solution is fairly simple, you should be able to convert the 
files, review the Conversion.log file, test your converted files, and use them. For 
example, simple files that were built from the templates provided with your 
previous version of FileMaker Pro should convert accurately without a lot of 
manual corrections afterwards.

If you’re converting a multi-file relational database created with custom 
features such as custom scripts, or a database that’s business-critical, you 
should plan your conversion more carefully.

FileMaker Pro 10 can convert files created with versions 3.x, 4.x, 5.x, and 6.x. 
If you have files created using FileMaker Pro version 2.x or earlier, you must 
first convert them to one of the supported formats listed above. Then you can 
convert the files to FileMaker Pro 10. For more information, see “Converting 
FileMaker Pro 1.x and 2.x databases” in Help.

When you convert files, FileMaker Pro 10 preserves the contents of your 
original files and creates new, converted files in FileMaker Pro 10 format. The 
content of the original files are not modified, and you can open them in the 
previous version of FileMaker Pro that created them. The converted files can 
be opened only in FileMaker Pro 10, FileMaker Pro 9, FileMaker Pro 8.x, and 
FileMaker Pro 7.

You can convert a single file or convert multiple files at once:

1 Use the single-file conversion method for stand-alone database files that 
don’t display related data from other files. For more information, see Help.

1 Use the multiple-file conversion method to convert all the files in a 
relational database. For more information, see Help.
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Solving basic conversion problems
Here are some suggestions for correcting problems that could occur during 
conversion.

My file didn’t convert properly
1 If you are converting a copy of a file, make sure that the original file was closed 

before you copied it. Otherwise, the copy will not convert correctly. 

1 Check the Conversion.log file located in the folder with the database you are 
attempting to convert. For more information, see Help.

1 Try recovering the file first using a previous version of FileMaker Pro and then 
convert the file again. 

I received a consistency check or auto-repair message when I opened my original 
file using my previous version of FileMaker Pro
Try recovering the original file using your previous version of FileMaker Pro. Then 
open the recovered file using the same version of FileMaker Pro, close the file, and 
then try converting it with FileMaker Pro 10.

Converting passwords
During conversion, passwords are converted into accounts in 
FileMaker Pro 10. There are two common password conversion issues:

1 For each converted account, both the account name and the password in the 
converted file are initially set to the password from the original file, which 
makes all passwords visible to anyone who has Full Access privileges. For 
security reasons, you should either change each account name so that it no 
longer matches its password, or change each password so that it no longer 
matches its account name. (You could also set an option for each account 
to require a password change by the user upon the next login.)

1 Passwords are case-sensitive in FileMaker Pro 7, 8.x, 9, and 10. Make sure 
you enter your password exactly as it was created in a previous version of 
FileMaker Pro. If you are the owner of the original file or the database 
administrator, open the original file using a previous version of 
FileMaker Pro and look at the password in the Define Passwords dialog 
box. If you are not the owner of the file or the database administrator, 
consult your database administrator for password information.
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Chapter 8
Security measures

Be sure that your database files, host computers, workstations, and the 
networks that access them are safe from theft and corruption. This chapter 
covers the following five important security measures that you can implement 
to protect your data and equipment. You should:

1 Enhance physical security

1 Enhance operating system security

1 Establish network security

1 Back up databases and other important files

1 Install, run, and upgrade anti-virus software

For more information about securing FileMaker Pro files, see 
www.filemaker.com/support/security.

Enhancing physical security
Evaluate your computers to make sure they are physically secure:

1 The host computer should be a dedicated machine, anchored to a desk or 
immovable object with a lock. Secure the computer so that its hard drive 
cannot be removed. Restrict access to the computer by storing it in a locked 
room.

1 Secure the client workstations that access a database. Lock the computers 
down and restrict access by using a screensaver that requires a password.

1 Ensure the physical security of backup copies of files stored on portable 
media, such as tapes and CDs. 
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Enhancing operating system security
Use the security features of your operating system to restrict access to 
important data. The network administrator should provide access only to 
individuals authorized to administer and maintain the system or the FileMaker 
databases. In addition, they should:

1 Track system user IDs and passwords. 

1 Restrict access to the FileMaker Pro application and file directories, 
servers, and web pages.

1 Review remote access settings for file sharing and FTP. 

1 Restrict file upload or download access.

1 Make sure all users have the latest, most secure versions of operating 
system software.

1 To streamline processes, you can enable external authentication, which 
uses accounts that have been configured in the Windows Domain 
Authentication or in Apple Open Directory. For more information, see 
FileMaker Pro Help.

1 Do not put FileMaker Pro files on file servers to share them. Use the built-
in networking feature in FileMaker Pro and FileMaker Server. This 
prevents the files from being inappropriately copied or from introducing 
record locking and potential corruption issues when files are shared with 
inappropriate methods.

Establishing network security 
Databases shared on an intranet or the internet use the TCP/IP protocol. You 
may also use the TCP/IP protocol when you share databases peer-to-peer, or 
with FileMaker Server. Though TCP/IP is good for moving data and allowing 
clients to connect to your data, it was not designed with security as a primary 
objective. Unless you take precautions, it can provide uninvited access to your 
host computer, server software, databases, and perhaps to other client machines 
on your internal network. TCP/IP doesn't provide very much protection for 
data, so it is important to place barricades such as firewalls and SSL data 
encryption in the path of uninvited visitors.
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1 The most common barricade method used is the firewall, which separates 
your network into two distinct environments: a public environment that is 
“outside the firewall,” and a private environment that is “behind the 
firewall.” Users outside of the firewall will only have access to those TCP/
IP or hardware addresses that you expose. You can concentrate your 
security on those server machines that are exposed, while allowing 
machines behind the firewall to operate with fewer safeguards.

1 Using wireless networking devices, like the Apple AirPort and other 
802.11b networking cards and base stations, can pose security challenges. 
These devices can broadcast your network traffic beyond the walls of your 
building, so it is extremely important to encrypt your wireless networking 
signals. Always use the maximum level of signal encryption available.

Backing up databases and other important files
Develop plans for restoring data, including alternate sites and systems to run 
business-critical information services. A current backup can help you recover 
from a situation where someone loses the administrator account information for 
a file, or from a situation where user error (and sometimes bad database design) 
causes data to be deleted or modified inappropriately.

Keep these points in mind:

1 Host databases with FileMaker Server and create regularly-scheduled, 
automated backups.

Don’t use third-party backup software on hosted FileMaker Pro databases. 
First, use FileMaker Server to make a backup copy of your database, then 
run your third-party backup software on the copy. Backup software can 
damage open, hosted databases.
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For example, make local backups of files at 6:00 am, 9:00 am, 12:00 noon, 
3:00 pm, 6:00 pm, and 11:30 pm weekdays. At midnight, make an 
incremental backup of the entire system to the enterprise backup system. 
Finally, Friday night at midnight, perform a full system backup. Copy and 
store the backup tapes at a remote location. This way, if the server goes 
down for some reason other than catastrophic failure of multiple drives, the 
more recent backup of the data files can be used, meaning a maximum of 3 
hours of lost data. If there is a catastrophic drive failure, then the previous 
evening’s tape can be used, minimizing the loss to one day’s data. Of 
course, these procedures can be tailored to your situation and data value. 

1 Make sure backup copies aren’t damaged or inaccessible. Verify that they 
are functioning properly before you need them. Run diagnostic tools on 
your hard drive and your backup files regularly.

1 Ensure that you can restore an entire set of files from backup copies.

1 Regularly export the data to protect against file corruption.

1 Protect the backup media itself. Store backups in a separate and fire-proof 
location. 

1 Assign backup administrators who can retrieve files, in case the network 
administrator is unavailable. 

1 Plan for redundancy. If the power goes off, a universal power supply (UPS) 
should sustain power for at least 15 minutes, enabling you to safely close 
all files. If the power can’t be restored in a timely fashion, consider using a 
generator to supply power to servers. Also consider power sources for 
routers and firewalls. Will communication be a problem if your internet 
access is interrupted for 48 hours or longer? 

1 Consider how you will continue to provide services if an intruder takes 
down your database server and that server can’t be restored to its previous 
condition. 

1 Evaluate additional scenarios that could occur, and create a plan to respond 
to each one.

Also, network administrators should assess risks to data systems and business-
critical functions. For example, consider:

1 Theft of data or theft of proprietary intellectual property. 
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1 Disruption, theft, or damage to network infrastructure such as servers, 
networks, data storage, or data backup storage. Damage can be caused by 
password crackers or by other types of malicious sabotage and destruction. 
Most incidents originate from within the organization. 

1 Disruption or damage to the organization infrastructure such as building 
fires, environmental or biological hazards, floods, and so on. 

1 Disruption or damage to the public infrastructure, including electrical 
power, telecommunications (voice and data), transportation grids 
(roadways, buses, trains) caused by environmental conditions, or severe 
weather such as tornadoes or floods.

FileMaker Pro provides two mechanisms for handling databases that might be 
damaged: consistency checks and file recovery. Consistency checks occur 
automatically, if needed, when the file is opened. You can also choose to verify 
the consistency of a file that you suspect is damaged. You can also have 
FileMaker Pro attempt to recover a damaged file. For more information about 
checking consistency and recovering files, see Help.

Important  In the event of a server failure, such as an unexpected loss of power, 
hard drive failure, or software failure, use the backup files. Any system failure 
causing FileMaker Server to shut down inappropriately can result in corrupted files 
if cached data was not written to disk and the files were not closed properly. Even 
if the files re-open and go through a consistency check or recovery (initiated by 
either FileMaker Pro or you), corruption might be buried in the file. File recovery 
cannot guarantee that problems have been fixed.

Installing, running, and upgrading anti-virus software
Because most computers have internet access, they are vulnerable to viruses 
being transmitted through email attachments. Make sure all employees run 
anti-virus checking software regularly, and that they are aware of typical virus 
warning signs. Employees should scan all files before copying or downloading 
them to their computer, and they should never open unsolicited attachments, 
even if they’re from someone they know.

While anti-virus software is essential in protecting your systems and data, 
some caution should be observed in how they are used on computers that host 
FileMaker Pro databases. 
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Antivirus programs sometimes lock bytes within a file when they scan for 
viruses. These locks can cause the operating system to return an error when 
FileMaker Pro or FileMaker Server try to write data to the file, which 
sometimes causes the file to be flagged as damaged and closed.

This situation also applies to files that FileMaker Server uses as back-up 
targets. If the backup file is being scanned by anti-virus software when a 
scheduled backup occurs, the destination file might be locked. This causes the 
back-up process to fail, which may result in data loss. This same data loss issue 
applies when an open, non-shared FileMaker Pro database file is scanned by 
anti-virus software.

When running anti-virus software on computers that host FileMaker Pro 
databases, follow these recommendations:

1 Do not run virus protection software on open or hosted databases. First, 
close the databases, then run the virus protection software.

1 When you scan your computer for viruses, do not scan the Databases folder 
and subfolders or any folder that contains files that actively hosts files 
through FileMaker Server or FileMaker Pro. Instead, set your anti-virus 
software to scan your database back-up destination folder and make sure 
your anti-virus scan schedule does not coincide with your 
FileMaker Server back-up schedule. Wait until databases are completely 
backed up before scanning them.
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Symbols
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Access privileges. See Accounts; Privilege 
sets

Access via FileMaker Network   157, 191
Accounts

Admin account   179
defining   186
described   176
External Server account   177, 188
Guest account   179
passwords   183
predefined   179
viewing   185

Active record   32
Adding

See also  Defining; Placing
fields   80
new find requests   52
records   35
related records   36, 149
tables   97

Admin account   179, 181
Adobe PDFs

saving data as   163
AND searches   51
Anti-virus software, and database 

management   201
Apple OpenDirectory   188
Application preferences   69
Asian text

entry   85, 127, 128
printing   127
rotating   127

Attributes, text   122
Authentication   176

Apple OpenDirectory   188
via external server   188
Windows Domain   188
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Authorized users. See Accounts; Privilege 
sets

Auto Enter   92
Auto-complete   118
Automating tasks. See Scripts
Average for summary fields   89

B

Backups
and antivirus software   201
guidelines for   199
scripts for files   68

Blank layout
See also Layouts
described   106

Blank records, printing   62
Body, described   130
Boolean values

described   46, 82, 95
finding   46
formatting   123

Break fields   130
Browse mode

described   28
finding data in   42

Browser, web
opening URL   172

Browsing records   29
Buttons, including in tab order   38

C

Calculation fields
defining   85
described   82
formulas   85
stored and unstored results   96

Calculations
See also Calculation fields
formatting   122
related fields

field references to   86
summarizing data   150
Calendars
displaying in fields   118

Case-sensitive text, finding   45
Changing

data in fields   38
find requests   55
lookups   153
preferences   69
relationships   148

Characters
maximum in fields   38
not allowed in field names   81

Checkboxes, displaying fields as   119
Clients

described   156
limits, on the web   172
performing tasks   160
saving files   157

Clones   27
Closing windows and files   26
Columnar list/report layout

See also Layouts
described   102

Columns
changing width   109
in tables   31
printing records in   106

Combo boxes, displaying fields as   119
Comma-separated text format   164
Compacted copies of files   27
Comparison operators   86
Container fields

See also Fields
described   82
formatting   126

Control styles for fields   119
Copying

field definitions   27
files   26
records   35
related records   36
scripts   27

Count for summary fields   89
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Creating See Adding; Defining
Cross-platform, file sharing   24
Currency, formatting   122
Current

date, formatting   123
time, formatting   124

Custom menus, FileMaker Pro 
Advanced   12

D

Data
described   19
entering automatically   35, 92
exporting   163
importing   163
privileges for sharing   177
view as form, list, table   29

Data entry   38, 92–96
Data Entry Only privilege set, 

described   180
Data sources

described   170
fixing FileMaker references   24

Data types
See also Field types
and calculation results   88

Database locks. See Accounts; Privilege sets
Databases

creating   78
described   19
naming   79
planning   71
printing   61
publishing on web   172

Databases, relational. See Relational 
databases

Date fields
described   82
entering and editing values in   39
four-digit years   39, 95
Dates
See also  Date fields
displaying calendars   118
entering data   39
finding   46
finding today’s   46
formatting   123
four-digit years, verifying   95
invalid   46
typing in   39
validating   95

Decimal numbers   122
Defining

See also  Adding; Placing
accounts   186
calculation fields   85
databases   80
fields   80
lookups   151
passwords   184
privilege sets   189
summary fields   88
tables   97
value lists   119

Deleting
data   40
fields from a layout   118
find requests   55
related records   37, 149

Document preferences   69
Drag and drop, fields onto layout   116
Drop-down calendar   118
Drop-down lists, displaying fields as   119
Duplicate records, finding   51
Duplicating

files   27
records   35
related records   36

E

Electronic documentation   10
Elements. See Objects
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Email
sending from FileMaker Pro   164
sending through SMTP   164

Empty or non-empty fields   51
Encryption. See Accounts; Privilege sets
Entering data

automatically   92
Furigana   85
typing in fields   38

Envelope layout
See also Layouts
described   106

Envelopes, printing   63
Excel format

importing and exporting to   164
saving data as   163

Exchanging files
exporting   163, 169
importing   163
relational databases   131
with other applications   164

Exporting
See also Exchanging files
described   163
file formats   164
formatting   170

Extended columnar layout. See Columnar 
list/report layout

Extended privileges
described   176
viewing   191

External data sources   170
External Server account   177, 188

F

False result   46, 82, 95, 123
Favorite files   24
Field behavior   38, 127
Field content match   44
Field definitions

copying   27
creating   80
Field labels   118
Field names   81
Field rights. See Accounts; Privilege sets
Field tool   117
Field types

and calculation results   88
described   82

Field values
deleting   40
described   22
entering and editing   38
entering automatically   92
finding and replacing   56
prohibiting change   93

Field/Control tool   117
Fields

adding to a layout   116
defining   80
deleting from a layout   118
described   21
displaying   14, 98
empty or non-empty, finding   51
entry options   92, 118
formatting   121
formatting data   121
Furigana in   85
global   97
indexing   96
maximum characters in   38
merge   120
naming   80, 84
options   85
placing on a layout   116
removing from a layout   118
restricting data entry   127
selecting   38, 114
stored and unstored results   96
types   82
typing in   39
validation options   94

File formats, import/export   164
File options   69
File paths   159
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File references. See data sources
File sharing, enabling   157
FileMaker Mobile

privileges for   178, 189
FileMaker Pro

documentation information   9
file format   164
product overview   13
versions   193

FileMaker Pro Advanced   12
FileMaker Pro format   164
FileMaker Server   156, 172, 188

privileges for   178, 191
Filename extension, fp7   24
Files

accounts   176
backing up   68
cloning   27
closing   26
converting   193
copying   26
creating   78
described   21
duplicating   27
exporting to   169
opening   23
opening across platforms   24
planning   71
privilege sets   176
protecting   175
remote   23
saving   26
shared   182

on web   172
templates, described   78

Find mode, described   28
Find requests
See also Finding records
adding new   52
broadening criteria   52
deleting   55
described   40
editing   55
mixing find and omit   54
multiple   52, 53
narrowing criteria   51
operators in   41, 48
order of   54
repeating   55
reverting   55

Finding and replacing field values   56
Finding records

See also Find requests, Quick finds
adding new request   52
all records   42
Boolean numbers   46
described   40
duplicate records   51
empty or non-empty fields   51
exact values   45
excluding records   53
invalid values   46
logical AND searches   51
logical OR searches   52
multiple criteria   51
omitting records   54
order of requests   54
partial or variable text   43
quick finds in Browse mode   42
ranges of information   48
related fields and records   49
showing all records   42
symbols   44
today’s date   46

Footers, described   130
Form letters   120
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Formatting
calculations   122
dates   123
export data   170
graphics   126
import data   164
numbers   122
text   122
times   124
timestamps   125

Forms
See also Layouts
Standard form layout   102
viewing records as   29

Formulas, calculation fields   85
Found set

described   28, 40
switching with omitted set   56

fp7 filename extension   24
Fraction of Total for summary fields   89
Full Access privilege set, described   180
Functions   87
Furigana field option   85

G

Global storage options   97
Grand summaries, described   130
Graphics, formatting fields for   126
Groups. See Accounts; Privilege sets
Guest account   179

H

Headers, described   130
Hiding records   55
Host

database on web   172
described   156
FileMaker Server   156
performing tasks   160
saving files   157

HTML table format   164
I

Importing   163–170
adding new records   165, 166
described   163
file formats supported   164
into existing files   165
into new tables   165
source file or table   165, 168
target file   165
updating existing records   165
updating matching records   166

Indexing
fields   96
text field limitations   46

Info palette   110
Instant Web Publishing

described   155, 172
privileges for   189
sharing files   172

Intranet   172
See also Web

Invalid values, finding   46
IP addresses, limiting   172

J

JDBC
field name considerations   81
privileges for   178, 189

Join expressions. See Relationships
Join fields. See Match fields

K

Key fields. See Match fields

L

Labels
field   117, 118
vertical   105

Labels (mailing), printing   63
Labels layout, creating   63
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Layout bar   25, 29
Layout mode, described   28
Layout objects. See Objects
Layout parts

body   130
described   130
field labels   117
footer   130
grand summary   130
header   130
subsummary   130
title header and footer   130

Layout pop-up menu   25, 99
Layouts

adding fields   116
Blank   106
Columnar list/report   102
columns

changing width   109
setup   107

creating   99
described   14, 98
envelope   106
fields

displaying   14, 98
dragging onto layout   116
merge   108
placing   116
placing related   120
removing   118
selecting   114

form layout   102
form view   29
labels   105
Mode pop-up menu   28
printing   61
Standard form   102
tabbed panels on   99
Table view   100
tools   110
types   102
vertical labels   105
Limits
characters in fields   38
field names   81

Lists, viewing records as   29
Literal text searches   44
Locked objects   114
Locking, shared records   160
Logical

AND searches   51, 52
OR searches   51, 52

Lookups
changing   153
defining   151
described   132
lookup source field   135
lookup target field   135
stopping or suspending   153

M

Macros. See Scripts
Mail merge, using merge fields   120
Mailing labels   105
Manage Scripts   68
Margins, displaying in Preview mode   60
Match fields

See also Fields
described   135, 137
in import update   166

Matching records, updating   166
Mathematical operators   86
Maximum characters in fields   38
Maximum for summary fields   89
Merge fields   63, 120
Merge format   164
Microsoft Excel format   164

saving data as   163
Minimum for summary fields   89
Mode pop-up menu   28, 99
Moving

field to field   38
record to record   34

Multimedia files   82
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N

Naming
databases   79
fields   84
tables   98

Network guidelines   198
Networks

cross-platform   17, 156
FileMaker Server   156

New Layout/Report assistant, 
described   100

Non-shared files   183
Number fields

See also Fields
described   82
entering and editing values in   38
finding   46
formatting   122

Numbers, invalid   46

O

Objects, layout
described   109
locked   114
selecting   114
setting auto resize options   112

ODBC
overview   165
using FileMaker as client

described   170
supplemental fields   91

using FileMaker as data source
field name considerations   81
privileges for   178, 189

Omitting
fields during printing   121
records   53

related   49, 54
Opening

files   23
multiple windows   25
Operators
comparison   86
in find requests   41, 48
mathematical   86
relational   136, 142, 149

Operators list   41
Options, file   69
OR searches   52

P

Page breaks, viewing in Preview mode   60
Page margins, viewing in Preview mode   60
Page numbers   103

viewing in Preview mode   60
Page orientation for printing   62
Panels, tab panels on layouts   99
Parts. See Layout parts
Passwords

defining   184
protecting files with   183
related files, planning   77
troubleshooting   195

PDF documentation   10
PDFs

saving data as   163
Photos   82
Picture fields. See Container fields
Pie chart   41
Placing

fields on a layout   116
merge fields   120
related records   120

Planning
databases   71
file security   181
relational databases   71

Pointer tool. See Selection tool
Pointers to files. See Relationships
Pop-up menus, displaying fields as   119
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Portals
See also Relational databases
adding records   36
deleting records   37
described   135
omitting related records   54
placing related records   120
selecting   114
selecting records   33
summarizing data in   150

Preferences
application   69
described   69
file   69

Preview mode, described   28, 60
Previewing printing. See  Printing
Previewing columns   106
Primary keys. See Match fields
Print area, viewing   60
Printing

Asian text   127
blank records   62
described   59
envelopes   63
information about database   67
labels   63
previewing   60
records   61
records in columns   106
scripts   66
setting up   62

Privilege sets
Data Entry Only   180
defining   189
described   176
Full Access   180
predefined   180
Read-Only Access   180
viewing   185

Protecting files. See Accounts; Privilege sets
Publishing, databases on the web   172
Q

Quick finds   42
Quick Start Screen   23, 78
Quotation marks in searches   43, 44

R

Radio buttons, displaying fields as   119
Ranges of information, finding   48
Read-Only Access privilege set, 

described   180
Recent files   24
Record locking   160
Records

active   32
adding   35, 165
browsing

in a list   29
individual   29

copying   35
deleting related   37
described   22
displaying sorted related   149
duplicating   35
exporting   169
finding   40
hiding   55
locked   160
matching   166
moving to   34
omitting   53
printing in columns   106
selecting   32
sorting   45, 58

in table format   31
related records   149

viewing as forms, lists, or tables   29
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Related fields
See also Fields; Relational databases
calculations   86
described   135
on layouts   118
planning   75
summarizing data   150

Related files, restricting access   77
Related records

See also Records; Relational databases
adding   36, 149
copying   36
deleting   37, 149
described   135
displaying in portals   120
duplicating   36
finding and omitting   49
sorting   149
summarizing data   150

Related tables
described   136
planning   71

Relational databases
described   21, 131
match fields   135

planning   137
planning   71, 145
portals   135
related tables

described   136
planning   71

terminology   135
Relational operators   136, 142, 149
Relationships
See also Relational databases
changing   148
comparative   142
creating   145
described   136
multi-criteria   140
planning   76
returning range of records   143
self-joining   144
single-criteria   138
types   138

Relationships graph   136, 147
described   146

Repeating find requests   55
Reports

See also Columnar list/report layout; 
Layouts; Subsummaries

creating   99
previewing   60
records in columns   106
with grouped data

creating   102
printing   61

Restricting access. See Accounts; Privilege 
sets

Retrieving data from other files. See  
Exchanging files

Reverting find requests   55
Rights. See Accounts; Privilege sets

S

Saving
data automatically   26
files   26
shared files   157
to Excel and PDF formats   163

Scripts
copying   27
described   17, 68
performing   68
printing   66
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Searching. See Finding records
Secondary files. See Relational databases
Security, file   198

operating system guidelines   198
planning   181, 197

Selecting
fields   38, 114
objects   114
records   32

Selection tool   114
Self-joins   144

for summarizing data in portals   150
Server. See Host; FileMaker Server
Settings. See  Preferences
Shared files

See also Networks
accounts   182
clients   156
host   156
in workgroups   172
limitations   156
on web   172
opening   23
privilege sets   182
saving   157
setting up privileges for   177

Simple Mail Transfer Protocol (SMTP), 
sending email through   164

Single-page form layout. See Standard form 
layout

Slider   34
Sorting

records   45, 58
records in table format   31
related records   149

Sound files   82
Standard Deviation for summary fields   89
Standard form layout

See also Layouts
described   102

Starter Solutions. See Templates
Status toolbar   29, 110
Stopping lookups   153
Stored results   96
Strict data type   95
Strings, text. See Text, literal
Subforms. See Portals
Subsummaries

See also Reports; Summary fields
creating reports   102
parts, described   130
printing   60, 61

Subtotals. See Subsummaries; Summary 
fields

Summarizing data in related fields   150
Summary fields

Average for   89
Count for   89
defining   88
described   82, 88
Fraction of Total for   89
Maximum for   89
Minimum for   89
on layouts   130
options for   90
Standard Deviation for   89
Total for   89

Summary parts. See Subsummaries
Supplemental fields   91
Symbols

and field names   81
finding   44
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T

Tab controls
described   99
including in tab order   38

Tab order   38
Table view, described   104
Tables

defining   97
described   21
importing data into new   165
naming   98
table occurrences   137
viewing records as   29, 31

Tabs, inserting in fields   40
Tab-separated text format   164
Templates

creating files   78
described   78

Text
See also Fields
attributes   122
fields   82
finding   45
formatting   122
rotating Asian text   127
selecting   114

Text fields
described   82
entering and editing values in   38

Text notes, in relationships graph   147
Time fields

described   82
entering and editing values in   39

Times
finding   46
formatting   124
invalid   46

Timestamp fields
described   82
entering and editing values in   39
four-digit years   39

Timestamps, formatting   125
Title headers and footers, described   130
Today’s date, finding   46
Tools

Field tool   117
selection tool   114
status toolbar   29

Total for summary fields   89
True result   46, 82, 95, 123
Type-ahead feature   118

U

Unauthorized users. See Accounts; Privilege 
sets

Unstored results   96
Updating existing data during import   166
Upgrading files   193
URLs, opening   172

V

Validating field values   94
Value lists   92, 160

described   119
Values

See also  Field values
finding duplicates   51
finding exact   45

Variables
symbols for   81

Vertical writing   127
View as Form, described   29
View as List, described   29
View as Table, described   31
Viewing

accounts   185
extended privileges   191
page breaks and page numbers in 

Preview mode   60
print area   60
privilege sets   185
records as forms, lists, or tables   29

Virtual results   97
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W

Web
field name considerations   81
hosting databases on   172

Web viewer   14, 172
Wildcards in searches   43, 44
Windows

closing   26
opening multiple   25

Windows Domain   188
Workgroups, sharing files   172
World Wide Web. See Web

X

XML
importing and exporting to   164
privileges for   178, 189

XML format   164
XSLT

privileges for   178, 189

Y

Y2K, year validation   94, 95
Years

four-digit in Date fields   39, 95
four-digit in Timestamp fields   39



216  |  Index

φμπ10_υσερσ_γυιδε.βοοκ  Παγε 216  Μονδαψ, Αυγυστ 25, 2008  3:59 ΠΜ


	Chapter 1 Introducing FileMaker Pro
	About this guide
	Using FileMaker Pro documentation
	Where to find PDF documentation
	Online Help
	Templates, examples, and more information

	Suggested reading
	FileMaker Pro overview
	Creating simple or complex databases
	Using layouts to display, enter, and print data
	Finding, sorting, and replacing data
	Protecting databases with accounts and privilege sets
	Creating scripts to automate tasks
	Sharing and exchanging data
	Saving and sending data in other formats


	Chapter 2 Using databases
	About database fields and records
	Opening files
	Opening multiple windows per file
	Closing windows and files
	Saving files
	When FileMaker Pro saves a file

	About modes
	Using the status toolbar

	Viewing records
	Viewing records in table format
	Selecting the active record
	Moving through records

	Adding and duplicating records
	Adding and duplicating related records

	Deleting records
	Entering data
	Selecting a field
	Entering and changing data in fields

	Finding records
	Making a find request
	Performing quick finds based on data in one field
	Finding text and characters
	Finding numbers, dates, times, and timestamps
	Finding ranges of information
	Finding data in related fields
	Finding empty or non-empty fields
	Finding duplicate values
	Finding records that match multiple criteria
	Finding records except those matching criteria
	Saving find requests
	Deleting and reverting requests
	Viewing, repeating, or changing the last find
	Hiding records from a found set and viewing hidden records

	Finding and replacing data
	Sorting records
	Previewing and printing databases
	Previewing data on a layout
	Printing records
	Printing labels and envelopes
	Printing scripts
	Printing table and field information
	Printing the relationships graph

	Automating tasks with scripts
	Backing up database files
	Setting preferences

	Chapter 3 Creating databases
	Planning a database
	Creating a FileMaker Pro file
	Defining database fields
	About naming fields
	About choosing a field type
	Defining text, number, date, time, timestamp, or container fields
	Defining calculation fields
	Defining summary fields

	Using supplemental fields
	Setting options for fields
	Defining automatic data entry
	Defining field validation
	About storage and indexing options

	Defining database tables
	Creating layouts and reports
	About layout types

	Setting up a layout to print records in columns
	Working with objects on a layout
	Using the Info palette with objects
	Selecting objects

	Working with fields on a layout
	Placing and removing fields on a layout
	Setting up checkbox sets and other controls on a layout
	Deciding where to place related fields
	About merge fields
	Formatting field data on a layout
	Allowing or preventing entry into fields

	Working with parts on a layout
	About layout part types


	Chapter 4 Working with related tables and files
	About relationships
	Relational database terminology
	About the relationships graph
	About match fields for relationships
	Types of relationships

	Planning a relational database
	Working with the relationships graph
	Creating relationships
	Changing relationships

	Summarizing data in portals
	About lookups
	Creating lookups
	Editing lookups


	Chapter 5 Sharing and exchanging data
	Sharing databases on a network
	Enabling file sharing and hosting files
	Opening shared files as a client
	Opening shared databases remotely using a URL
	Closing a hosted file

	Importing and exporting data
	Saving and sending data in other formats
	Sending email messages based on record data
	Supported import/export file formats
	ODBC and JDBC
	Methods of importing data into an existing file
	About adding records
	About updating existing records
	About updating matching records
	About the importing process
	Converting a data file to a new FileMaker Pro file
	About the exporting process

	Working with external data sources
	Publishing databases on the web

	Chapter 6 Protecting databases with accounts and privilege sets
	Protecting databases
	Accounts, privilege sets, and extended privileges
	About the predefined accounts
	About the predefined privilege sets
	Planning security for a file
	Password-protecting a file

	Creating accounts and privilege sets
	Viewing accounts and privilege sets
	Creating accounts
	Creating accounts that authenticate via an external server
	Creating privilege sets
	About enabling record-level access

	Viewing extended privileges

	Chapter 7 Converting databases from FileMaker Pro 6 and earlier
	Conversion overview
	Solving basic conversion problems
	Converting passwords


	Chapter 8 Security measures
	Enhancing physical security
	Enhancing operating system security
	Establishing network security
	Backing up databases and other important files
	Installing, running, and upgrading anti-virus software

	Index

